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 GENERAL DESCRIPTION 

1.1 PURPOSE OF THIS GUIDE 

The purpose of this guidance manual is to instruct users on the process and timing used to develop a bridge 
model for Digital Delivery in accordance with the PennDOT Digital Delivery guidance documents using Bentley 
software. This method is referred to as a “model-centric workflow” throughout the document, which describes the 
use of a 3D model as the central repository of digital data that grows with the progression throughout project 
phases and is used as the basis for required content and deliverables. This manual walks the user through the 
typical phases and needs of the bridge model from preliminary to the final design. Though there are limitations in 
this current workflow noted throughout this guidance document, workarounds and alternative processes are 
provided to give users the tools to create and modify bridge models to comply with the modeling standards. It is 
important to note that these limitations and processes will continue to change rapidly for the foreseeable future 
due to software development, updates, and improvements. Also, it is not possible to cover every situation 
encountered in a typical PennDOT bridge project in this manual; therefore, the user will have to apply and extend 
the processes and workarounds included herein to complete the bridge models to the project-specific 
requirements. There will be additional components including 2D details, attached documents, and other items 
needed to supplement the 3D bridge models which are described in other modeling standard documents. This 
manual’s scope is limited to the actual 3D bridge model components, serving as the basis for the Digital Delivery 
of PennDOT bridges. 
 
The software programs specified herein, like all software, are tools. This manual aims to provide the user with 
guidance and the methodology in which these tools can be best applied for common PennDOT bridge projects. It 
is the engineers’ and technicians’ responsibility to accurately convey design intent while meeting the 
Department’s requirements for the project. 

1.2 PROFILE OF INTENDED USERS 

The intended users of this manual include bridge engineers and technicians, both internal within PennDOT and 
external consultants. Though it is recommended that the users first take an introductory Bentley OpenBridge 
Modeler (OBM) or OpenBridge Designer (OBD) training or go through the tutorials in the OBM Help materials, it is 
not required for use of this guidance document. It is also not limited to new or novice users. The workflows and 
processes shown provide progressive modeling techniques to create advanced models with a high Level of Detail 
and information. 
 
It is assumed that users have a general knowledge of common MicroStation commands/topics including drawing, 
referencing, dimensioning, etc., especially for some of the advanced topics and techniques in the workflow. 

1.3 ORGANIZATION OF MANUAL 

This guidance document generally follows the PennDOT Bridge LRFD program manual organization. This is done 
for several reasons. First, users who have worked on PennDOT projects are likely to have used these manuals, 
so there is a level of familiarity and comfort with this format. Second, the outline provides a logical format to walk 
through the use of software with beginning users, as well as to convey advanced information to more experienced 
users.  
 
Below are general descriptions of the chapters.  

• Chapters 1 and 2 provide general information and background of the software utilized and the workflows 
addressed 

• Chapter 3 details the specific workflow elements and procedures 

• Chapter 4 gives practical instructions on starting a new project, essentially serving as a “quick start” guide 

• Chapter 5 is the bulk of the manual providing detailed information on all the necessary inputs 
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• Chapter 6 provides advanced techniques or processes for more detailed modeling, categorized by inputs 
described in Chapter 5 

• Chapter 7 describes several different outputs and how they can be generated from the model-centric 
workflow 

• Chapter 8 includes examples of bridge models and selected model components used in training material 
to provide the user with samples highlighting this workflow (electronic files also delivered with this 
manual) 

• Chapter 9 provides guidance and direction on submitting software modification requests, as well as 
requests for changes or enhancements to this document 

• Appendix content includes exhibits of the workspace delivered templates, template variable values for 
typical situations, and additional resources for help, support, and more 

 
Users are encouraged to use the bookmarks with the Chapter and Section topics, as well as the search functions, 
to search for key terms or phrases. 

1.4 ADDITIONAL RESOURCES 

The structure and content of this manual seeks to provide the information required for users to follow the workflow 
for PennDOT bridge models with Bentley software. This guidance document does not intend to recreate content 
relevant to this workflow that is conveyed adequately in other resources and readily available to all users. The list 
of material in this category is sizable and continues to grow rapidly. The following information is provided to give 
users examples of helpful resources to supplement  this manual. Though links are provided, this content is often 
moved and website names can change, so it is important to verify the links and the content in these locations. 
 
This workflow utilizes software that is developed and maintained commercially by Bentley Systems and  multiple 
resources are provided by Bentley: 

• OBD Help: https://docs.bentley.com/livecontent/web/openbridge%20designer-v3/en/GUID-3339A995-
3E8E-4CDE-8D02-0958A7EC80D4.html 

• OBM Help: https://docs.bentley.com/LiveContent/web/OpenBridge%20Modeler%20Help-v15/en/GUID-
E9849062-68DE-4BA8-B734-CD5664469596.html 

• Link to OBM Tutorials (on Bentley Learn Server): 
https://docs.bentley.com/LiveContent/web/OpenBridge%20Modeler%20Help-v15/en/GUID-E9849062-
68DE-4BA8-B734-CD5664469596.html 

• OpenBridge YouTube Channel: https://www.youtube.com/c/BentleyBridgeAnalysis 
 
Additional State Highway Administration content: 

• Florida DOT – FDOTConnect Bridge Design and Modeling: 
https://www.fdot.gov/cadd/downloads/documentation/fdotconnecttraining/fdotobm/fdotconnect-bridge-
design-modeling 

• Connecticut State DOT:  https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-
eBook-Volume-011---OpenBridge-Modeler 

• Utah DOT – Structures Design Digital Delivery:   
https://digitaldelivery.udot.utah.gov/pages/structures-design 

 
Additional resources, including instructional videos, can be found on free open-source sites or paid training sites. 

1.5 DOCUMENT STYLE  

Style conventions are included in the table below. The standard format for the PennDOT bridge software manuals 
is followed when applicable for consistency. 
 

https://docs.bentley.com/livecontent/web/openbridge%20designer-v3/en/GUID-3339A995-3E8E-4CDE-8D02-0958A7EC80D4.html
https://docs.bentley.com/livecontent/web/openbridge%20designer-v3/en/GUID-3339A995-3E8E-4CDE-8D02-0958A7EC80D4.html
https://docs.bentley.com/LiveContent/web/OpenBridge%20Modeler%20Help-v15/en/GUID-E9849062-68DE-4BA8-B734-CD5664469596.html
https://docs.bentley.com/LiveContent/web/OpenBridge%20Modeler%20Help-v15/en/GUID-E9849062-68DE-4BA8-B734-CD5664469596.html
https://learn.bentley.com/app/Public/BrowseLearningPaths?aftkn=cea54965-a36c-4594-a69c-83843b67b8e9&productLineId=26141
https://learn.bentley.com/app/Public/BrowseLearningPaths?aftkn=cea54965-a36c-4594-a69c-83843b67b8e9&productLineId=26141
https://www.youtube.com/c/BentleyBridgeAnalysis
https://www.fdot.gov/cadd/downloads/documentation/fdotconnecttraining/fdotobm/fdotconnect-bridge-design-modeling
https://www.fdot.gov/cadd/downloads/documentation/fdotconnecttraining/fdotobm/fdotconnect-bridge-design-modeling
https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-eBook-Volume-011---OpenBridge-Modeler
https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-eBook-Volume-011---OpenBridge-Modeler
https://digitaldelivery.udot.utah.gov/pages/structures-design
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Input Description Example 

Menu names and 
commands 

Bold  
(Names separated  
with > symbol) 
 

• General form is Workspace (when applicable) > Tab > 

Panel > Command 

• File > Open 

• File > Settings > User > Preferences 

• OpenBridge Modeler (workspace) > Analysis and 
Reporting > Bridge Reporting > Quantities Report 

Dialog box actions Bold • Click the Apply button 

• In the Direction Mode list, select Skew 

Dialog box field names Italic • Key in Warwick Road in the Alignment Name field 

• In the Direction Mode list, select Skew. 

Key-ins Bold Key in Warwick Road in the Alignment Name field 

File names Italic Use the seed file: PennDOT_Bridge_NAD83_S_SF.dgn 

File paths Underline The seed files can be accessed at the following location: … 
Organization-Civil \ Bridge Design \ OpenBridge Modeler \ 
Seed folder 

New terms or emphasis Italic or Bold • The Decks Library contains templates that represent 

typical deck sections for proposed bridges 

• The user is not to utilize this tool 

Notes Symbol and 
underlined 

Note: It is important for users to consider the size of 

the bridge and how many bridges/units/files to break… 

Tips and Tricks Symbol and 
underlined 

Tips and Tricks: The Feature Definitions for the 

substructure (abutments and piers) and… 

Workarounds Symbol and 
underlined 

Workaround: After information is exported to LBC or 

LBS, users can work in these .obdx files separately… 

1.6 ABBREVIATIONS 

This section provides definitions of abbreviations that are commonly used throughout this document. 

 

2D - Two-dimensional content, typically drawings 

3D - Three-dimensional content, typically models 

AASHTO - American Association of State Highway and Transportation Officials 

Bentley - Bentley Systems, Incorporated 

BIM - Building Information Model 

DD - Digital Delivery 
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DM-4 - Pennsylvania Department of Transportation Design Manual Part 4: Structures, December 

2019 Edition. This publication can be ordered from: 

PennDOT Sales Store 

P.O. Box 2028 

Harrisburg, PA  17105-2028 

This publication can also be downloaded free of charge from PennDOT's website 

GUI - Graphical User Interface 

LBC - Bentley’s LEAP Bridge Concrete software 

LBS - Bentley’s LEAP Bridge Steel software 

LRFD Specifications  - AASHTO LRFD Bridge Design Specifications, 8th Edition, 2017, published by: 

American Association of State Highway and Transportation Officials 

444 North Capitol Street, N.W., Suite 249  

Washington, D.C.  20001 

OBD - Bentley’s OpenBridge Designer software 

OBM - Bentley’s OpenBridge Modeler software 

ORD - Bentley’s OpenRoads Designer software 

PennDOT - Pennsylvania Department of Transportation 

PS - Bentley’s ProStructures software 

WP - Work Point 

1.7 GLOSSARY OF TERMS 

A full list of terms that form the foundation for PennDOT’s Digital Delivery is provided in the Digital Delivery 
Guidelines. (https://www.penndot.gov/ProjectAndPrograms/3D2025/Pages/default.aspx) Several terms that 
directly relate to this manual are included below for convenience. 

1.7.1 Digital Delivery and Building Information Modeling Terms 

The following terminology is standardized language that is used throughout the construction industry, both vertical 
and horizontal, related to Building Information Modeling. 
 
Building Information Modeling (BIM) Use of 3D Models to coordinate different disciplines (e.g., structural and 
utilities) and to identify/resolve possible clashes between virtual elements prior to actual construction or 
fabrication. 
 
Clash Detection Use of 3D Models to coordinate different disciplines (e.g., structural and utilities) and to 
identify/resolve possible physical conflicts between virtual elements prior to actual construction or fabrication. 
 
Common Data Environment (CDE) A service that collects, stores, manages, and shares information through a 
managed process. 
 
Digital Delivery A modernized approach to project delivery processes and contract media that incorporates 
digital data. Simply stated, construction projects have the ability to be bid using 3D technology and no longer only 
be delivered in a traditional construction plan format. 
 
Digital Delivery Execution Plan (DDEP) A project management tool that documents the overall approach for 
developing, updating, reviewing, sharing, and using the digital design models. 

https://www.penndot.gov/ProjectAndPrograms/3D2025/Pages/default.aspx
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Discipline Model See also: Federated Model. A model or linked models related to a single discipline. The 
superstructure model, substructure model, and detailing models are linked together into a federated Structural 
Discipline Model. 
 
Federated Model See also: Discipline Model. A model that is compiled by integrating different discipline models 
together into one model through either linking, referencing, and/or importing. 
 
Industry Foundation Classes (IFC) See also: Open Data. A non-proprietary data schema and format to 
describe, exchange, and share the physical and functional information for the assets within a facility. IFC is the 
International Organization for Standardization standard for BIM and is being extended to roadway and bridge 
asset classes. 
 
Level of Detail See also: Level of Development. Often confused with Level of Development, Level of Detail 
describes only the amount of geometric detail in a model element, not the amount of engineering intent. Highly 
detailed model elements may be placed in a model as placeholders with no engineering intent. Though detail 
often increases in parallel with development, observing the detail of a model element is not an effective way to 
determine its development or appropriate uses. 
 
Level of Development (LOD) See also: Level of Information, Level of Visualization, Model Progression 
Specification. A qualitative designation that communicates the degree of engineering intent behind a 3D model 
element (or group of model elements) and defines the authorized uses for which the model element is sufficiently 
developed. Normally the LOD will increase through the design development process, as defined in the MPS. 
 
Level of Information (LOI) See also: Level of Development. A description of the completeness and quality of the 
non-graphical information attached to the model elements. 
 
Level of Visualization (LOV) See also: Level of Development. A qualitative designation that communicates the 
degree of visual enhancement given to the 3D model elements, to suit the needs of different target audiences. 
Generally, non-technical audiences need color-realistic geometry or even photo-realistic materials to be able to 
understand bridge models. 
 
Model Element See also: Level of Development, Level of Information, Model Element Author, Model Progression 
Specification. An entity within a model that represents a physical object or an abstract concept (e.g., alignment, 
north arrow). 
 
Model Element Author (MEA) See also Model Element. The individual, normally identified in a BIM Execution 
Plan and/or MPS, responsible for creating a specific model element or group of model elements. The MEA may 
work under the direct supervision of an EOR who assumes professional responsibility for the design represented 
in the model. 
 
Model Breakdown Structure (MBS) See also: Model Progression Specification. A list of model elements 
adhering to a set classification. A MBS is the basis for a Model Progression Specification. 
 
Model Progression Specification (MPS) See also: Model Breakdown Structure. A specification that defines how 
the LOD for individual model elements increases over the project milestones. The MPS will assign a specific, 
minimum LOD to each model element for each milestone. The LOD typically increases from milestone to 
milestone. 

1.7.2 Data-related Terms 

The following terminology is standardized language that is specific to the data contained in a digital model. 
 
Attribute Non-graphical data that is associated with a model element definition. 
 
Component A physical item or feature within a model. 
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Constraint See also: Parametric. A relationship between two or more elements in a model, which should be 
maintained in any modifications made to the base element. The slab geometry is a constraint for the rebar layout. 
 
Digital Twin Initially conceived for smart manufacturing, a digital twin is a digital representation of a physical 
asset that contains a 3D digital model of the physical asset, as well as non-graphical information about the asset, 
such as its properties, functions, evaluative properties, and other analytical attributes. 
 
Feature See also: Model Element. Anything that can be seen or located and is a physical part of the project. 
 
Graphical Data See also: Non-graphical Data, Spatial Data. Data conveyed using shape and arrangement and/or 
location in space. 
 
Layer See also: Level. A container within software for model elements or features. Some CADD, GIS, and PDF 
software products use the term "Layer" to describe the container, while other software products use the term 
"Level." Common software features include styling elements and controlling the visibility of elements using layer 
settings. 
 
Level See also: Layer. A container within software for model elements or features. Some CADD, GIS, and PDF 
software products use the term "Layer" to describe the container while other software products use the term 
"Level." Common software features include styling elements and controlling the visibility of elements using level 
settings. 
 
Links Hyperlinks that can be applied to geometry to allow a user to connect to and access a wide range of 
external files and formats. These links can be used to link to web addresses, networked folder locations, files 
and/or folders located in a CDE, or bookmarks within the file. 
 
Metadata See also: Model Progression Specification. Data used for the description and management of 
documents and other containers of information. Metadata is usually structured data embedded within the file. 
However, it could include an external document that describes pertinent information to others on the assumptions 
and basis for the 3D models, such as the geospatial metadata (grid/ground coordinate system definitions), 
intended uses of the 3D models, approximations and simplifications (e.g., removing minor curvature from analysis 
models). A MPS is important metadata that accompanies a Federated Model. 
 
Model A representation of a system that allows for investigation of the properties of the system. (EN ISO 29481-
1:2016). The roadway and bridge models were delivered in CADD files. 
 
Naming Convention A set of rules for naming components and features within a model. A naming convention 
may provide instructions for choosing the character sequence to be identifiers that denote variables, types, 
functions and other entities in source code and documentation. 
 
Non-graphical Data See also: Attribute, Feature. Anything that can be seen or located and is a physical part of 
your project. 
 
Parametric See also: Component, Constraint. Representing digital information for a model component by 
parameters. This is usually referring to geometric data, which can be linked to related components through 
internal logic. 
 
Property See also: Attribute. Non-graphical information that describes a model element. The Modulus of 
Elasticity is a property of a girder. 
 
Schema See also: Industry Foundation Classes. A formalized model for structuring information. 
 
Spatial Data See also: Geodatabase, Feature, Model Element. Anything that can be seen or located and is a 
physical part of your project. 
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1.7.3 Data Management Terms 

The following terminology is standardized language that is specific to the management of data and data 
exchanges within a digital model, between digital models, and between the digital model and associated systems 
and applications. 
 
Data Exchange See also: Information Exchange. The process of taking data structured under a source schema 
to transform and restructure into a target schema, so the target data are an accurate representation of the source 
data within specified requirements and minimal loss of content. 
 
Information Exchange See also: Data Exchange, Information Requirements. Packages of information passed 
from one party to another in a BIM process, or the act of passing such information, possibly as a contractual 
deliverable. Parties involved agree upon and understand what information content and format will be exchanged. 
 
Information Requirements See also: Information Exchange. A specification for what, when, how, and for whom 
information is to be produced. Information requirements could be documented in a PennDOT Publication, in a 
project Scope of Work, or in a BIM Execution Plan. 
 
Open Data See also: Open Specification. Data that is publicly available and free to use or reuse without 
restrictions. PennDOT's Open Data Portal provides access to all published GIS data that members of the public 
can map, style, chart, download, or share. 
 
Open Specification See also: Industry Foundation Classes, Proprietary Specification. A specification for data 
that is structured according to an open schema that is freely available and not controlled by any one particular 
vendor. Open specifications are intended to facilitate data exchange. 
 
Proprietary Specification See also: Open Specification. A specification for data that is structured according to a 
proprietary schema. Proprietary data can usually only be read and written by one vendor's software products.  

1.7.4 Use Cases 

The following entries define the industry standardized Use Cases, or potential situations in which a digital model 
may be used. 
 
3D Coordination The process in which information models are used to determine field conflicts via Clash 
Detection software or visual inspection. 3D coordination is accomplished by comparing proposed 3D geometry 
from discipline models aggregated into a federated model. 3D elements for all objects are required to perform 3D 
coordination. 
 
Analytical Design The process of capturing the existing and proposed alternatives in analytical models to design 
the proposed facility. 
 
Construction Documentation The process whereby a construction inspector documents the construction 
process. This includes, but is not limited to, daily diary records, materials testing results, pile driving reports, 
monthly payments, routine erosion prevention, and sediment control inspections, NEPA compliance, and the 
process of seeking remedies to work that was not in conformance with plans, quantities, and/or specification. 
 
Design Authoring The process in which 3D design software is used to develop information models based on 
specific roadway and structural criteria to convey design intent for construction. The core functions of design 
authoring include development and analysis of the design elements. 
 
Design Review The process in which an information model is used to review and provide feedback related to 
multiple design aspects. These aspects include evaluation of design alternatives and environmental constraints, 
review and validation of geometric design criteria, and completeness or quality of overall design. 
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Quantity Take-off Preparing the estimated construction quantities as determined by the Designer. Designers use 
QTO to determine Contract Item (Pay Item) quantities and multiply those quantities by reasonable rates (usually 
from historical bids) to produce an aggregate cost estimate. 
 
Existing Conditions Modeling See also: Design Authoring. The process to create a 3D model of existing 
conditions for a roadway and/or bridge project, including an existing ground surface and the demarcation of 
features, such as above and underground and utilities, structures, fences, and trees. It may also include the 
modeling of existing pavement structures. 
 
Reference Information Supplemental information provided to the contractor that is not contractually-binding and 
is used at the contractor's risk. The soils report was Reference Information provided with the bid package. 
 
Scoping Capture digital information about the asset inventory, condition, and other performance information (e.g., 
traffic, safety) and evaluate alternatives to determine the scope and estimated cost of the project. For bridge 
projects, conducting a "type, size, and location" (TS&L) study that includes preliminary structural design. 
 
Stakeholder Engagement See also: Visualization. A process that uses digital information to communicate the 
project to technical and non-technical stakeholders and document their input throughout project delivery.  
 
Visualization See also: Stakeholder Engagement. The process of creating visual representations of the project to 
communicate with technical and non-technical stakeholders throughout the project lifecycle. 

1.7.5 References 

The following entries provide references used to compile PennDOT’s Glossary of Terms. 
 
Brenner, J. et al., 2018. Development of 3D and 4D Bridge Models and Plans, Lansing: Michigan Department of 
Transportation. 
 
Commonwealth of Pennsylvania Department of Transportation Publication 408/2020 Specifications 
 
International Organization for Standardization, 2018. ISO 19650-1:2018. [Online] 
Available at: https://www.iso.org/standard/68078.html 
[Accessed 14 August 2019]. 
 
ISO 29481-2, Building information models — Information delivery manual — Part 1: Methodology and Format. 
Switzerland: ISO 2016. 
 
National Institute of Building Sciences, 2015. United States National Building Information Modeling Standard 
Version 3, Washington, DC: National Institute of Building Sciences. 
 
Utah Department of Transportation, 2020. Glossary of Terms. [Online] 
Available at: https://digitaldelivery.udot.utah.gov/pages/terms 
[Accessed 9 December 2020]. 
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 WORKFLOW DESCRIPTION 

2.1 GENERAL 

The current bridge modeling workflow provided in this manual utilizes several Bentley software programs, as well 
as other discipline data files created by other software. The required data is created, stored, read, modified, 
updated, and then transferred from one software to another in order to utilize the most up-to-date information and 
the best suited tools for the stated purpose. The workflow is created to follow a typical bridge project submission 
timeline from preliminary engineering to final design, utilizing models and data generated in previous phases to 
update and enhance the same model. Every effort is made to minimize data loss and re-work required through 
utilization of the parametric capabilities of the software to adapt to updates and changes quickly and efficiently as 
the design progresses. Though this is not always possible with the current limitations in the software, the 
framework is structured so updates in the software can be incorporated as they become available. 
 
Topics covered in this manual include: 

• Reference and import other discipline data for bridge design and modeling 

• Develop a “Base” bridge model with typical elements including deck, girder/beam, barrier, sidewalk, 
bearings, diaphragms/cross frames, abutment, wingwall, and pier 

• Update the model for a “Refined” bridge model with increased Level of Development for the bridge 
elements 

• Add reinforcement to concrete components in the bridge model 

• Generate output from the model including saved views, 2D drawing views, reports, and transfer to LEAP 
software for structural analysis 

 
These items are NOT covered in this manual: 

• Development of auxiliary components for bridge models not included above 

• Sheet development for a typical 2D plan set  

• ProStructures specific outputs including reinforcement schedules and other ProStructures exclusive tools 

• Development of models for high-level visualization in LumenRT or other software 

2.2 SOFTWARE DESCRIPTION 

There are several software programs covered in this manual. The primary software is OpenBridge Modeler as 
accessed through OpenBridge Designer.  
 
Program Title: OpenBridge Designer 

Version:  10.11.00.40 at time of manual creation 

Function: A unique application that combines modeling, analysis, and design into one 

comprehensive bridge product. The application utilizes the modeling capabilities 

of OpenBridge Modeler and the analysis and design features of LEAP Bridge 

Concrete, LEAP Bridge Steel, and RM Bridge to meet the design and construction 

needs of all types of bridges. (Bentley Systems, Inc., 2022) 

Authors: Bentley Systems, Inc. 
 
 
Program Title: OpenBridge Modeler 

Version:  10.11.00.310 

Function: Comprehensive bridge information modeling application built on OpenRoads 

technology, addressing the geometric layout, connection to analysis and design, 
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visualization, and documentation for any type and scale of bridge project (Bentley 

Systems, Inc., 2022) 

Authors: Bentley Systems, Inc. 

2.3 FUNCTIONS – OBD VS. OBM  

OpenBridge Modeler (OBM) is Bentley’s software for creating intelligent 3D Bridge Models (Bentley, 2021). This is 
the primary software used and referred to in this manual for creating a 3D bridge model. The OBM software can 
be accessed currently as a separate software or, as the workflow outlined in this manual follows, through 
Bentley’s OpenBridge Designer software (OBD). OBD consolidates multiple Bentley software programs including 
OpenBridge Modeler and Bentley structural analysis software, such as LEAP Bridge Concrete (LBC) and LEAP 
Bridge Steel (LBS), as well as software for other functions. The LBC and LBS analysis input and use are covered 
in a separate guidance document; however, the process for preparing and transferring OBM models is included, 
as it is a key function in the workflow.  
 

 

Figure 2.3-1  OBD Software and Available Add-on Software (Bentley Systems, Inc., 2022) 

 
Essentially, OBD is the glue that connects the applicable Bentley programs. Though there are limitations in the 
current workflow, as described in the manual, presumably, there will be enhanced functionality and software 
options in future releases. 

2.3.1 Workflow Options 

The user can utilize the full OBD workflow, which requires creating an OBD file before creating or incorporating 
OBM files within the OBD file. This allows the user some benefits with integrating other Bentley software 
programs such as LBS and LBC for analysis, as well as LumenRT for visualization, ProStructures for structure 
detailing, and others. See Sections 4.1 and 4.2 for more details. 
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If users have access to an OBM version, which is unconnected to OBD, they can also choose to use OBM 
separately without starting OBD first. If the user wants to utilize LBC or LBS with this approach, the data will need 
to be exported and a separate OBD file created before the data is imported. This option can be used to allow 
more concurrent users on a bridge model (one working in OBM and one working in OBD for the analysis). It could 
also potentially limit software licensing requirements for OBD. License requirements are different for every 
organization, are not controlled by PennDOT, and are subject to change.  
 
Either option, OBM with OBD or OBM separately, can be used currently. Users can also start with OBM 
separately, and later incorporate it into OBD. However, it is not possible to start from the OBM with OBD and then 
open the files with the separate version of OBM. It is recommended that users consider these options before 
starting a bridge model and choose one that best fits the project needs.  
 
Also, since the release of the 2021 R2 version of OBM, a ProStructures (PS) license can be accessed inside of 
OBM without physically opening the PS software separately. This brings up a new workflow within OBM in which 
the user has access to all the PS tools. The user must physically close this license when not using the PS-specific 
workflow in order to avoid incurring charges for use of the separate PS license. 
 

Note: These workflows are being updated frequently with new releases, so there may be updated 

functionality and/or constraints with these options not covered in this manual. The user should verify/test 

workflows at the beginning of the project to validate their use and functionality. 

2.3.2 Standalone vs. BIM Workflow 

The OBD workflow has two additional workflow options when creating files: the Standalone or the BIM workflows 
for creating projects and file groups in OBD. The OpenBridge Designer Help documentation provides a lengthy 
description of each, as well as the functionality and limitations of both. At this time, it is recommended to remain in 
the Standalone workflow for the PennDOT projects. However, a file/project can be moved back and forth 
between these options at any time.  
 

 

Figure 2.3-2  OpenBridge Designer – BIM Workflow 

https://docs.bentley.com/LiveContent/web/OpenBridge%20Designer-v3/en/GUID-3339A995-3E8E-4CDE-8D02-0958A7EC80D4.html
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Figure 2.3-3 OpenBridge Designer – Standalone Workflow 

2.4 BRIDGE TYPES COVERED (AND NOT COVERED) 

The bridge superstructure types covered in this manual include typical prestressed concrete and steel girder 
superstructure types.  
 
Prestressed girder sections can consist of: 

• I-beam 

• Bulb-tee beam 

• Type F or Type D NEXT beam 

• Adjacent plank beam 

• Spread or adjacent box beam with rectangular voids 
 
Steel girder sections can consist of: 

• Rolled sections 

• Welded plate I-girders 
 
The substructure types covered in this manual include cantilever and pile cap abutment types (integral), and 
multiple typical pier types, such as multi-column, hammerhead, and wall piers. The foundation types include piles, 
drilled shafts, and spread footings. 
 

Note: The OBM software can handle additional bridge/superstructure types including segmental concrete, 
welded steel box girders, and others; however, the specific content in this manual is limited to the above 
listed types. 
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2.5 ASSUMPTIONS AND LIMITATIONS  

2.5.1 OBM Tools 

There are limitations with the OBM tools for creating bridge elements with a high Level of Detail and Level of 
Information, especially with the substructure tools. The specific limitations for each are highlighted in Chapter 5  
Input Description, and 6  Advanced Input Description; workarounds are provided wherever possible. The user 
should not expect the OBM tools to provide final design detail and must realize that other techniques such as Solids 
Modeling and supplemental model attachments (2D details, etc.) will likely be required. However, the software is 
improving constantly, and updates are being added to enhance functionality and usability of these tools.  

2.5.2 Interoperability with Structural Analysis 

Currently, the interoperability and bi-directional flow of information from the OBM model to the analysis software is 
limited. Updating an OBM model directly from LBC and LBS is not practical at this time and is not recommended as 
a viable workflow. However, there is value in transferring geometric, material, and other properties from OBM to 
LBS and LBC as a starting point for the analysis. It is important to understand the assumptions and limitations 
associated with this export. The Transfer Report that is provided each time this transfer occurs is detailed and helps 
determine key information critical to updating the LBC and LBS run for an effective structural analysis. This list is 
constantly evolving as the software is updated and improved. The user is responsible for reading and understanding 
the list of assumptions and limitations.  

Assumptions and Limitations When Exporting to LEAP Bridge Concrete 

Assumptions and Limitations When Exporting to LEAP Bridge Steel 

More details and information on this transfer process are included in Section 7.3 Exporting to LEAP Structural 
Analysis Software. 

2.5.3 Assumptions and Limitations Guide 

Below is a table of situations that are commonly encountered in a typical PennDOT bridge design workflow which 
expose limitations and require specific assumptions. The second column provides where these specific items are 
covered in this manual. 
  

Table 1 Common Assumptions and Limitations Guide 

Assumptions and Limitations of Common Situations encountered in PennDOT Bridge Design 

Organization and Separation of Files Section: 3.2 Organization and Separation of Files 

Base and Refined Model Section: 3.3 Base and Refined versions of model elements 

Starting a New Project Section: 4.2 Starting a New Project 

Place Concrete Diaphragms Section: 5.12 Place Concrete Diaphragms 

Custom Abutments Section: 5.17 Place Custom Abutment  

Place Approach Slabs Section: 5.23 Place Approach Slabs 

Options to Modify Deck Templates Section: 6.6.1 Options to modify deck templates 

Beam Daps Section: 6.10.1 Modifying for Beam Daps 

https://docs.bentley.com/LiveContent/web/OpenBridge%20Modeler%20Help-v15/en/GUID-CB2FD0B5-DD2E-41CC-AEA6-CE3E94FD2A79.html
https://docs.bentley.com/LiveContent/web/OpenBridge%20Modeler%20Help-v15/en/GUID-CCE3E5F7-DAE5-44C7-AFD3-E3333990E3E9.html
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Section: 6.21.1 Modifying pad depth to account for beam daps 

Data Transfer from OBM To LEAP Section: 7.3.1 Data Transfer 

Bi-directional Data Transfer Section: 7.3.3 7.3.3Bi-directional Data Transfer 

 

2.6 REFERENCES 

The following entries provide references used in Chapter 2. 
 
Bentley Systems, Inc., 2022. OpenBridge Designer Help. [Online] 
Available at: https://docs.bentley.com/LiveContent/web/OpenBridge%20Designer%20Help-v3/en/GUID-
EAE9E80F-5D05-4E6F-9165-C8FFF4F4FABE.html 
[Accessed 22 August 2022]. 
 
Bentley Systems, Inc., 2022. OpenBridge Modeler Help. [Online] 
Available at: https://docs.bentley.com/LiveContent/web/OpenBridge%20Modeler%20Help-v16/en/GUID-
16CA7978-0B20-4517-AD50-9F46CCB5F469.html 
[Accessed 22 August 2022]. 
 
Bentley Systems, Inc., 2022. OpenBridge Designer Connect Edition Product Data Sheet. [Online] 
Available at: https://cdn2.webdamdb.com/md_IFTZphEdmq50.jpg.pdf 
[Accessed 20 January 2022]. 
 

 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter 2  Program Description 
 

2-7 

 

This page is intentionally left blank. 



 

 3-1 

 WORKFLOW METHODOLOGY 

3.1 WORKSPACE ELEMENTS AND FEATURES 

The OBM workspace has several specific components added to enhance and customize the software for 
PennDOT bridge modeling. All of these resources are included in the PennDOT Connect Edition Workspace 
download and are available when the PennDOT workspace is activated within the software. The following 
describes the workspace elements. 

3.1.1 Bridge Templates and Material Library 

Custom templates are provided for typical PennDOT bridge components and situations. These templates follow 
the PennDOT BD and BC Standard Drawings wherever possible. Below is a list of templates included in the 
workspace. The templates provided cover a wide range of typical PennDOT projects, although there will likely be 
project-specific situations that are outside of the capabilities of the provided template libraries. See Chapters 5, 6, 
and Appendix 9.1 for more details on typical variable information on how these can be modified to allow the 
templates to adapt to project-specific constraints. 
 
The PennDOT-specific Bridge Templates and Material Library files are in the PennDOT Connect Edition 
Workspace under the …Organization-Civil / Bridge Design / OpenBridge Modeler / Bridge Templates folder. The 
barrier, deck, and beam templates are included in the _PennDOT_templates.xml file; the standard piers are 
included in the _PennDOT_PierLib.xml file; the cross frames are included in the 
_PennDOT_CrossFrameLibrary.xml file; and the materials are included in the _PennDOT_MaterialLibrary.xml file. 

3.1.1.1 Barrier Templates 

Barrier templates include 45", 42", 32" F-Shape Concrete Barriers, 32" and 50" median barrier, 50" split concrete 
median barrier (the 32" split concrete median barrier is the same as the 32” F-shape), concrete mountable divisor, 
and split concrete mountable divisor per BD-601M. Also, 32" and 42" vertical barriers are included per BD-618M. 
These barriers have variables and constraints included to accommodate light pole blisters, structure mounted 
sound barriers, and sidewalk placement per BD601M, BD-610M, BD-617M, and BD-618M. Raised sidewalks per 
BD 601M have also been added as barrier templates in a "Sidewalks" folder within the "_PennDOT" category. 
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Figure 3.1-1 PennDOT Barrier Template Library 

3.1.1.2 Deck and Approach Slab Templates 

Deck templates include typical bridge deck cross sections per BD-601M with 2/4 lane with shoulders 
configurations, 2/4 lane with shoulders and sidewalks on both sides, and 2/4 lane with shoulders and sidewalks 
on right or left sides. These deck templates have variables and constraints included to accommodate varying lane 
and shoulder widths and configurations, normal crown and superelevated cross sections (and transitions), the 
PennDOT barrier templates added in the workspace, light pole blisters, and sidewalk placement per BD-601M, 
BD-610M, BD-617M, and BD-618M. Approach slab versions of these templates have also been added in an 
"Approach Slabs" folder within the "_PennDOT" category. Recent updates to the workflow include a separate tool 
for adding the approach slabs and sleeper slabs (sleeper slab templates included in the substructure template 
file). 
 

 

Figure 3.1-2  PennDOT Deck Template Library 

3.1.1.3 Prestressed Beam Templates 

Beam templates include sections per BD-652M, including Adjacent and Spread Box Beams (36" and 48" width), 
Plank Beams, PA I-Beams, AASHTO Type I-Beams, and PA Bulb-Tee Beams. There is a “PADOT” folder in the 
templates delivered in the out of the box workspace; however, these do not contain all the PennDOT sections, 
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and those that are included, are missing some required details. Therefore, it is recommended to only use the 
templates listed under the “_PennDOT” folder. 
 

 

Figure 3.1-3  PennDOT Beam Template Library 

3.1.1.4 Pier Templates 

Pier templates include typical pier sections per BD-629M. The piers consist of hammerhead, multi-column, single 
column, and wall piers. These templates use H-piles as default but can be converted to drilled shafts or spread 
footings as needed. 
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Figure 3.1-4  PennDOT Pier Template Library 

3.1.1.5 Abutment and Wingwall Templates 

Abutment templates include an integral abutment section per BD-667M. The “backwall” component is being used 
for the end diaphragm. See Section 6.16.1 for modifications of this template for final design details. 
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Figure 3.1-5  PennDOT Abutment Template Library 

 
Wingwall templates for integral abutments are provided per BD-667M. The template options include rectangular, 
tapered, and detached wingwalls. 
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Figure 3.1-6  PennDOT Wingwall Template Library (Integral Abutments) 

 
[This section is under development. Content will be completed after BD-621M abutment workflow is finalized 
through development and Digital Delivery Directive 2025 Pilot Project feedback.] 

3.1.1.6 Cross Frame Templates 

Cross frame templates include typical cross frame configurations per BD-619M. The specific types consist of 
Type X, Type K, Type K Inverted, and Solid Plate Diaphragms. The connection plates associated with these cross 
frames will likely need to be modified for project-specific conditions, so these templates can be used as the 
starting point (correct member size/orientation, plate shape, etc.). 
 
[Templates for the Steel Mid-Span Diaphragms for Prestress Concrete I-beam and Bulb-Tee beams are under 
development. Content will be completed after software update requests are provided.]  
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Figure 3.1-7  PennDOT Cross Frames Library 

3.1.1.7 Material Library 

PennDOT Bridge materials for typical Concrete and Steel designations have been provided in the OBM Materials 
database. The use of these materials is currently limited in the software and, because of this, is not used 
significantly in the workflow. This is due to the lack of reporting capabilities of the materials when bridge elements 
are modified (see Section 3.3). The included materials will be investigated further for value as updates in the 
software are available. Additional materials and supplemental data, such as unit cost information, may be added 
in the future. 
 



Chapter 3  Workflow Methodology 

 

3-8 

 

Figure 3.1-8  Material Library 

3.1.1.1 Bridge 3D Cells 

[This section is under development and will provide barrier transitions and other bridge-specific 3D cells. Content 
will be completed after testing feedback for the Digital Delivery Directive Pilot Projects is incorporated.] 

3.1.1.2 Bridge Feature Definitions 

OBM is structured similarly to ORD in that the content created is categorized by Features. This is an extension of 
the “levels” in MicroStation used in traditional CADD drawings. Features are used to define content in the OBM 
files and organize information in an intelligent structure.  
 
Defining Features requires the integration of three separate categories: Element Templates, Feature 
Symbologies, and Feature Definitions. These three elements are controlled by a hierarchy, meaning that Feature 
Definitions are created from Feature Symbologies, and Feature Symbologies are created from Element 
Templates. Below are brief descriptions of each in terms of how they are used in the OBM workspace. 
 
Element Templates define the properties of certain elements and are controlled at the “Level” classification. 
Many categories can be controlled, including Material appearances, Text Styles, and Item Types.  
 
Feature Symbologies provide settings to define model content types, such as lines and solids and applies the 
Element Templates for specific bridge sub-components, such as pier caps, columns, footings, and piles.  
 
Feature Definitions are broken down into the bridge components (deck, pier, etc.) and define the specific 
Feature Symbologies of the feature sub-components.  
 

Note: Element Templates are flexible, and the user can name/categorize them as desired. However, the 
Feature Symbology and Feature Definition categories are predetermined within OBM and cannot be 
removed, edited, or added. 

 
PennDOT-specific Element Templates, Feature Symbologies, and Feature Definitions have been added for 
typical proposed bridge elements in the PennDOT_Bridge_Features.dgnlib file which is located in the PennDOT 
Connect Edition Workspace under the …Organization-Civil / Bridge Design / OpenBridge Modeler / Dgnlib / 
Feature Definitions folder. Take note that these Feature Definitions developed for PennDOT all start with 
"_PennDOT_..." to differentiate from the Bentley-delivered features. Currently, these Feature Definitions control 
the OBM element levels and appearance settings (visually shown as concrete, steel, patterns, etc.) and do not 
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include separate features for existing or temporary conditions/elements. In the future, additional Feature 
Definitions will be added to the workspace, and Item Types for attributes, such as Pay Items, will be added to the 
Feature Definitions and attached to the elements. 
 

Tips and Tricks: The Feature Definitions for the substructure (abutments and piers) and the 

beams/girders include a “wrap” level. This level encompasses all of the element components and does not 

allow for selection of individual sub-components, such as piles, footings, columns and caps for piers, and 

beam flanges/webs and haunches for steel girders. This allows for modifications to the overall templates; 

however, it can be turned off for selection of those sub-components for individual properties and attributes. 

3.1.1.3 Customizing Feature Definitions 

Users should apply the Feature Definitions provided in the PennDOT Connect Edition Workspace whenever 
possible. However, there will likely be instances in which the provided Feature Definitions do not cover project-
specific needs. In these cases, users can create their own Feature Definition Libraries. These libraries are created 
in a separate DGNLIB file containing customized Element Templates, Feature Symbologies, and Feature 
Definition structure. New libraries can be placed in the appropriate directory for the software to recognize 
automatically. Also, new and existing level libraries can be attached, detached, imported, and exported using the 
Level Manager dialog.  

3.1.2 Bridge Seed Files 

Specific bridge seed files are available for use in OBM. Seed files are used by Bentley products as the starting 
point for settings within DGN files that can then be used for project files. The seeds control the file’s coordinate 
system, working units, etc. to be consistent with the overall PennDOT Digital Delivery standards. For OBM, the 
seed files are 3D DGN’s, which is different from the ORD workflow using 2D files.  
 
The bridge seed files included with the PennDOT workspace contain separate files for the north and south 
regions of the Pennsylvania State Planes Coordinate System: 

• North (PA-83-NF): PennDOT_Bridge_NAD83_N_SF.dgn 

• South (PA-83-SF):  PennDOT_Bridge_NAD83_S_SF.dgn 
 
The seed files are located in the Organization-Civil / Bridge Design / OpenBridge Modeler / Seed folder. More 
details on how to navigate to and use these seed files are provided in Section 4.2, as well as more information on 
how to modify the file settings in Section 4.4. 

3.2 ORGANIZATION AND SEPARATION OF FILES 

One aspect of the workflow that is important to consider when starting a project is how to organize and potentially 
divide the model into sections. Only one user can be actively working in a single DGN file at a time. Therefore, it 
is not recommended to have multiple bridges in the same OBM file. Furthermore, it may be prudent to split 
large/long bridges into multiple files so several users can work in OBM on the same structure.  
 
Also, any drawing views or sections that are developed from the bridge model should be created in a separate 
file. This allows for one user to work in the OBM file and another to work in the file on annotation or further 
detailing, which could be completed in the MicroStation Connect software without using OBM since it is only 
referencing the bridge model. Similarly, separate files should be created for modeling reinforcement and 
references utilized to access and view the OBM bridge models. With this approach, multiple users can access 
and work with individual files to allow for advancement of the bridge model and project. Early in design, this will 
likely not be critical, but as the design progresses, it is important to keep these considerations in mind as the file 
structure is developed. 
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Workaround: After the information is exported to LBC or LBS, users can work in these .obdx files 

separately. However, if the users are utilizing the full OpenBridge Designer workflow, separate OBD files 

should be created for use in the analysis software to facilitate multiple users’ ability to access the files at 

the same time. This is due to the limitation that OBD files are restricted to one user access at a time. This 

may change in the future, but currently a separate OBD file will be needed for concurrent work in OBM and 

LBC or LBS. 

3.3 BASE AND REFINED VERSIONS OF MODEL ELEMENTS 

It is important to realize that to develop a PennDOT final design level model for digital delivery, there will be 
manual efforts needed. The OBM tools for bridge elements will not be sufficient for the users to simply type 
parameters into the software and generate a bridge model that follows all the PennDOT standard details and 
requirements. However, it is beneficial for the user to leverage the OBM tools and templates whenever possible. 
 
Using the OBM tools for as much and as long as possible is advantageous for several reasons. First, these tools 
allow for parametric updates when elements are updated or changed as a result of a design or other modification. 
For example, if the bearing pad height is changed due to design requirements, the top of the abutment/bearing 
seat area will automatically adjust accordingly to this change in the model. Second, there is an inherent 
advantage to automating and enhancing aspects of this process so users can take advantage of software logic 
tied to specific bridge components. The software can add attributes to specific bridge components, which 
supplement key pieces of information, both geometric and non-geometric, to be easily and consistently viewed 
and mined. For example, a bridge abutment stem can be attributed to the NBI number, concrete material 
specifications, fixity condition, overall length, skew, and more. Though these capabilities are limited in the current 
version of the software, these tools are updated frequently with new releases of the software, creating increased 
exposure of this information and opportunities to benefit from the attributes. This manual refers to the model 
elements which maintain their OBM-developed status and properties as “Base” elements. 
 
Currently, there are some situations which require elements created by the OBM bridge tools to be modified in a 
manner that loses their recognition as a bridge element within OBM. These elements then become Smart Solids 
in the model and will retain level information and general properties, but any OBM specific properties tied to the 
element will be lost. Additionally, the element will no longer be able to be updated by the OBM tools. When a 
change is required after an element has lost its OBM bridge element status, the user must decide whether it is 
more effective to modify further with the Solids Modeling tools, or to delete the element and re-start the modeling 
process. This will depend on the size and impact of the required change. This manual refers to the model 
elements which have been modified and have lost their OBM-developed status and properties as “Refined” 
elements. The next page provides a diagram of the workflow for creating a bridge model that illustrates this 
concept and shows outputs that are extracted from the model. 
 

Note: In addition, there are situations in which elements must be developed completely outside of the 
OBM bridge tools (culverts, retaining walls, etc.). These elements will be Smart Solids or Parametric Solids 
within the program and follow the Refined model element status for the purposes of this manual. 
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Figure 3.3-1 Base and Refined Model with Outputs 
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Though this can be frustrating at times and there certainly needs to be further development with the tools, it is 
also advantageous to have the designers, both engineers and technicians, directly interacting with the model. 
This workflow requires users to inspect and modify elements and to ensure the design intent is met. Working in 
3D provides an advantage to facilitate enhanced processes, allowing better decision making earlier on in a 
design, especially using this workflow early in preliminary design.  
 
The following sections and Chapters 5 and 6 outline how the OBM tools for bridge elements can be used to their 
fullest extent and the types of situations that may require a more manual approach to reach the desired Element 
Detail Designation and Element Information Designation. 

3.3.1 Base Model Element Description 

As noted above, it is advantageous for elements to remain in the Base status for as long as possible throughout 
the design process, and the workspace provided aims to take full advantage of the current software capabilities. 
The tools are limited but, in certain situations, can be leveraged to produce model elements that can remain intact 
as Base elements through the design process. 
 
An example of this is the deck templates. The templates provided can essentially handle most variations and 
project situations in the cross section by adjusting the variable inputs for constant and varying dimensions and 
cross slopes along the length of the deck. 
 
Below is an example model showing Base model elements for a typical PennDOT prestressed beam bridge. The 
indicators in the image and the descriptions below highlight some of the limitations with the Base elements. 
 

 

Figure 3.3-2 Example Base Model 

1. Footings not combined. Bottom of footing at the correct elevation 
2. Deck ends not squared off 
3. Safety wings missing and corner blocks do not meet PennDOT standards 
4. Barrier deflection joints missing 
5. Correct deck elevations and cross slopes 
6. Correct beam sizes modeled 
7. Basic diaphragm modeled, does not meet PennDOT standards. 

1 

2 
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4 

5 

6 
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3.3.2 Refined Model Element Description  

A model component should only be made a Refined element when the Level of Detail or Level of Information 
needed for the general design process, or a specific submission exceeds that which can be provided as a Base 
element. This tipping point is different for every component and every project. The user must follow this manual, 
the PennDOT Digital Delivery standards documents, and leverage personal experience and judgement to 
determine if this should occur for each element in the model.  
 
Using the deck example from above, the OBM tools cannot currently “square-off” the end of the deck for 
significantly skewed structures. Therefore, to show this Level of Detail, the deck must be modified with Solids 
Editing tools, which will create a Refined deck model element. 
 
Below is the same example: a typical PennDOT prestressed beam bridge from the above section with all of the 
bridge components updated as Refined model elements. The indicators in the image and the descriptions below 
highlight some of the enhancements made to create the Refined elements. 
 

 

Figure 3.3-3 Example Refined Model 

1. Footings combined. Bottom of footing at correct elevation 
2. Deck ends squared off 
3. Safety wings missing and corner blocks meet PennDOT standards 
4. Barrier deflection joints added 
5. Correct deck elevations and cross slopes 
6. Correct beam sizes modeled, and beam notches added 
7. Diaphragm modified for approach slab and dimensions modified to meet PennDOT standards 

 

3.4 WORKFLOW TO UPDATE BASE MODEL ELEMENTS TO REFINED MODEL ELEMENTS 

When the Base model elements are developed to the fullest extent possible using only OBM templates and 
methods, the user can begin creating separate models in the same file or a different .dgn file for the bridge 
elements. This is completed before any elements are transitioned to Refined bridge elements. The specific 
model/file breakdown of elements can vary based on the specific project elements and size, but typically it is 
recommended to add a model for each major bridge element (deck, beams, abutments, piers, etc.). Adjacent or 
related elements can be combined such as including both the deck and barriers in one model or the entire 
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superstructure if a smaller bridge. A detailed description and example of the process is provided in the sections 
below. 
 

Tips and Tricks: As the project/bridge grows in size and complexity, the more helpful it can be to create 
the separate bridge element models in another .dgn file. When this approach is utilized, multiple users can 
work on different tasks within the project simultaneously. 

 
There are several reasons for using this approach. First, it preserves and essentially archives the Base model 
elements as OBM-recognized components that can still be modified with the OBM tools. This is especially helpful 
if major changes occur in the design after Refined model elements are created. Also, this eliminates the potential 
for extraneous copies of model elements during the transition to Refined elements. This is a common problem if 
model elements are modified with Solids Modeling tools directly without creating separate models/files. Another 
important reason is that reinforcement can be defined and applied in the individual element models, which helps 
keep the model size down for smooth functioning, and it maintains an organized file with all the components 
contained within. This approach also offers advantages on drawing view development. For example, it allows the 
ability to contain only pertinent drawing composition elements, such as section, detail, and other view callouts 
within each model. This prevents confusion later on during detailing stages when there would normally be an 
extensive number of these section callouts across the entire bridge model. It also allows more flexibility in turning 
on/off specific components in Saved Views. 
 

Note: More general views or sections that utilize multiple bridge components (i.e., general plan and 
elevation, etc.) can be added in the Default model. Alternatively, other models can be referenced within 
the component models to include several bridge elements in a section or view (i.e., referencing the deck 
model into the integral abutment model for the end diaphragm sections.  

 
The separate models of bridge elements are then be referenced together into a federated model or “container.” 
Again, this can be created as a separate model in a single .dgn file, or it can be a separate .dgn file. This 
container provides convenient viewing of all the components together for visual inspection and for coordination 
with other disciplines. 
 
[This section, 3.4, is under development. Content will be completed after workflow is finalized through 
development and Digital Delivery Directive 2025 Pilot Project feedback.] 

3.4.1 Workflow Steps 

The first step in this process is to create a separate 3D design model for each bridge element in the model 
(Abutment 1, Deck, Framing, Pier 1, Wing A, etc.). The user will need to reference the Default 3D design model 
into the new element 3D design model and merge the reference into the new design model. The user can decide 
to adjust the level display before merging in order to merge only the desired components, or the user can delete 
the unwanted solids after merging the entire model. After merging the reference into the component design 
model, the user will notice the OBM components have become Parametric Solids and will have lost their OBM 
status and specific Item Type parameters assigned when creating the component in OBM. These solids are what 
we will be modifying to create the refined components, applying custom Item Types, and referencing back into a 
Container file which will “contain” all of the referenced elements needed for the complete bridge model. Refer to 
Section 10.3 for Solids Modeling Tools and Techniques.  
 

Note: If any of the elements do not need additional adjustments (i.e., the elements can remain in Base 
element status), the same process should be followed. The only difference from the Refined model 
elements is that there is no need for the additional steps of Solids Modeling. 

 
At this stage, the user must ensure that all attributes (attached as Item Types) for each component are applied 
and accurate within the component models. Item Types can be applied at the element template level (as they are 
with most components), or they can be applied individually with the Apply Item Type tool. 
 
After the Item Types have been properly defined and confirmed, they can be referenced into a new container 
design model and maintained in the model as individual references. The user must understand that the Base 
model components should always be retained in the user’s version of the OBM model or in a separate archived 



Chapter 3  Workflow Methodology 

 

3-15 

file in case critical parameters and/or base components need adjusting in the project’s later stages. However, the 
new container file will hold the final version of all bridge elements to avoid any potential confusion between base 
and refined components. See the Digital Delivery standard documents for more information on 3D deliverables.  

3.4.2 Workflow Example – Integral Abutment 

The above workflow procedure will be discussed in detail in the integral abutment example below. 

3.4.2.1 Create a New 3D Model for Integral Abutment 

With the base OBM solids placed in the Default model in the correct position, first select the Home > Primary > 

Models dialog or flyout and select  Create a New Model. When prompted with the New Model dialog, select 
Design From Seed and ensure the project 3D seed file is indicated. Next, input the name of the component 
model and any other settings the user wishes to include and click OK. 

 

Figure 3.4-1 Create New Model dialog 

3.4.2.2 Reference Default Model into Component Model 

After navigating to the new component model, the user can open the Home > Primary > Reference Manager 
and attach the Default 3D model in the active file. To keep the component global coordinates aligned in true-
space, set the attachment orientation to Coincident - World. Do not Live Nest any attachments, as the only 
components we want to bring in are those OBM elements placed in the Default model. To avoid merging in more 
components than the user needs in this element model, all levels except those associated with the desired 
components can be shut off in the Default model. 
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Figure 3.4-2 Attach Default model Coincident – World 

3.4.2.3 Merge Default Model reference into Element Model 

In the Home > Primary > Reference Manager, right-click the Default model reference and select Merge into 
Master. The components displayed in the reference will be merged into the active element model as parametric 
solids to be modified. 
 

 

Figure 3.4-3 Merge Default Model into Component Model 

3.4.2.4 Delete Unrelated Solids and Refine Elements 

There may be some components merged into element models that are not associated and need to be removed. 
Simply select these components and delete them. There may also be some components that need to be 
modeled, such as the wingwalls, or component refinements can be made to increase the level of detail. These 
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refinements are project-specific, but in this example, refinements such as adding concrete chamfers to the 
abutment-wing intersection and the abutment-deck intersection were modeled. 
 

 

Figure 3.4-4 Merged Solids Stripped Down to Associated Components Before Refinement 

3.4.2.5 Assigning Item Types 

In order for these Parametric Solids to be identified with the correct bridge element properties, each requires an 
Item Type attached to it to define it and attribute information that is to be associated with it. As the top half of the 
abutment includes the concrete end diaphragms, wingwalls, barriers, and closure pour, all Item Types for these 
components need to be selected. The bottom half of the abutment includes the bearing seats, pile cap and piles 
and needs the appropriate Item Types associated with it. Simply check the properties you want associated with 
the components and select the component. 
 

 

Figure 3.4-5 Attaching Item Types to the Top of the Abutment 
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Figure 3.4-6 Attaching Item Types to the Bottom of the Abutment 

Item Types for Pay Items are also added through the same process. This is why it is important to develop the 
models with separation at construction joints in situations such as this integral abutment example. 
 
See Section 5.255.25 & 6.25 for more information on adding Item Types as attributes. 
 
[This section and the specific Item Type list is under development. Content will be completed after the workflow is 
finalized through development and Digital Delivery Directive 2025 Pilot Project feedback.] 

3.5 PROGRESSION OF MODEL THROUGH BRIDGE SUBMISSIONS   

The Level of Development of the physical bridge model will coincide with the required project submissions. The 
Level of Detail and Level of Information minimum requirements are provided in the PennDOT Digital Delivery 
Interim Guidelines. This manual provides the context and instructions to create bridge models to meet those 
standards. Below is a summary and overview of the general workflow and progression of the bridge model 
through the design process.  
 
In accordance with PennDOT Design Manual 4, Part A, Chapter 1.9, the anticipated sequence of bridge-related 
submissions is the following: 
  

• Hydraulics and Hydrologic Report (H&H Report) – DM-4 PP 1.1.1 
• Type, Size, and Location Report (TS&L Report) – DM-4 PP 1.1.2 
• Foundation Submission – DM-4 PP 1.1.3 
• Final Review of Plans – DM-4 PP 1.1.4 
• Final Plans – DM-4 PP 1.1.5 
• Plans, Specifications, and Estimate – DM-4 PP 1.1.6 
• Additional Project Submissions – DM-4 PP 1.1.7 

  
Developing the Level of Detail and Level of Information associated with the model in conjunction with each 
subsequent bridge-related submission is a logical approach as each submission is deeper into the overall project 
design schedule. As more pertinent details related to the structure are determined, they become relevant 
additions to the model. 
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Beginning with the Hydraulics and Hydrologic Report submission and the Type, Size and Location Report 
submission, maintaining the parametric nature of model elements as much as possible is recommended 
throughout the physical model development as updates and changes are to be expected through the design 
process. Therefore, elements should maintain their Base status regardless of the limitations and lack of 
detail/information that can be provided. 
  
Certain geometric and design parameters may require manual editing and manipulation of elements causing them 
to lose parametric properties. This approach should be avoided throughout model development when possible. As 
the structural design progresses and more detail is added to the physical model, it may be necessary to make 
these edits, and for model elements to move to a Refined status in later submissions, including the Final Structure 
Submissions. The goal is to reduce and eliminate the need for this approach as the software progresses and is 
updated, allowing more elements and customization to be modeled within the OBM tools. 

3.5.1 Hydraulics and Hydrologic Report (H&H Report) 

The H&H Report details the hydraulic performance of the proposed structure. The analysis is conducted in other 
software outside of the OpenBridge Modeler software, but the proposed structure layout, span lengths, and 
vertical clearances are needed for the analysis. Though most information is approximate at this stage in design, it 
is important to provide key pieces of information such as the hydraulic opening, both in terms of substructure 
locations and low-chord elevations for the hydraulic analysis. The initial creation of the Base Model will need to 
occur, and the following model elements are required: 
  

• Bridge  
• SupportLine Locations 
• Deck 
• Beam Layout 
• Beams 
• Abutments 
• Piers (as necessary) 
• All necessary custom attributes for modeled bridge elements required for the hydraulic analysis per 

PennDOT Digital Delivery Standards 

• Any additional and supplemental model elements required in order to address DM-4 Part A: Policies and 
Procedures, Section 1.9.2 

  
At this stage in the model development, it is advised that all the elements added to the model are created with the 
custom PennDOT templates delivered with the workspace without specific modifications, which may affect the 
parametric functionality for future model updates (keep “Base” model elements). Annotated 2D drawing models, 
saved views, and/or custom attributes may be required at this stage to convey the key information. 

3.5.2 Type, Size and Location Report (TS&L Report) 

The TS&L Report is the first bridge structure specific submission in the design process. A sufficiently thorough 
analysis of structure types is required to determine the proposed structure concept. In accordance with DM-4 
Chapter 1.9.3, preliminary cost comparisons are to be generated to further support the selected structure type. 
  
The list of required Model Elements for the TS&L submission is the same as the H&H Report (Section 3.3.1) with 
the following additions: 
   

• Superelevation (as necessary) 
• Barriers 
• Diaphragms 
• Stiffener and cross-frames (for a steel superstructure) 
• Excavation 
• Approach slabs 
• All necessary custom attributes for modeled bridge elements required for the TS&L per PennDOT Digital 
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Delivery Standards 

• Any additional and supplemental model elements required in order to address DM-4 Part A: Policies and 
Procedures, Section 1.9.3 

  
Unlike the H&H report, project-specific modifications to templates and objects that are required for superstructure 
elements should be made at this time. However, model elements should remain “Base” wherever possible for 
future changes and updates. 
  
Quantity reports are to be generated from the bridge model as part of the preliminary cost comparison. Because 
the TS&L cost comparison typically compares two or more structure concepts, all considered structure concepts 
must have a physical bridge model generated in OBM. In this way, comparable quantity reports can be generated 
and compared.  
  
Plan requirements for the TS&L submission can be found in DM-4 Chapter 1.9.3.3. Annotated 2D drawing 
models, saved views, and/or custom attributes should be generated in the bridge model file for the proposed 
structure type. 

3.5.3 Foundation Submission 

The Foundation Submission requires a more detailed Level of Design of the bridge structure, specifically of the 
substructure units (footing dimensions, pile layouts, stepped footing locations, etc.). At this stage in the model 
development, custom templates for abutments and piers should be present in the physical model, as required. 
Model Elements should be revised to reflect the final footing elevations, pile tip elevations, drilled shaft length, and 
length of socket into bedrock, as applicable per the project requirements. Select annotated 2D drawing models, 
saved views, and/or custom attributes should be generated in the bridge model file to convey the required 
information for the foundation design and documentation. 

3.5.4 Final Review of Plans 

The Final Review of Plans submission will require the complete Refined Model which has been built upon all 
previous model elements from past submissions. The following additional Model Elements are required for the 
Final Review of Plans: 
  

• Bearings 
• Reinforcement 
• All necessary custom attributes for the modeled bridge elements per PennDOT Digital Delivery Standards 
• All necessary 2D details not explicitly modeled in the physical 3D model 
• Any additional and supplemental model elements required in order to address DM-4 Part A: Policies and 

Procedures, Section 1.9.5 
  
Saved views will be required for ease in model viewing, including referenced information from other disciplines 
(roadway, drainage, etc.). In addition to the saved views for the Refined Model, 2D drawing models shall be 
generated, which includes 2D details for bridge items not explicitly modeled in the physical 3D model. The 2D 
drawing models shall also include annotated sections of the relevant portions of the bridge structure, which are 
required for contractor use during bridge construction. 

3.5.5 Final Plans 

After receiving any comments from the Final Review of Plans submission, the model shall be updated and/or 
corrected accordingly. All comments must be addressed before the Final Plans will be approved. Ownership of 
the Final Bridge Model will be assigned at this time. The exact format for Responsibility, as defined in DM-4 
Chapter 1.9.6, is currently To Be Determined. This section will be updated accordingly to correspond with DM-4. 
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3.5.6 Plans, Specifications & Estimate (PS&E) 

The PS&E submission is the final model submission during the design phase. The bridge model will be included 
with the 3D roadway model and information, and other discipline files required for the project, as deliverables for 
the project’s advertisement. 

3.5.7 Additional Project Submissions  

Throughout the life of the bridge design project, there are several other submissions that require varying levels of 
structural detail. Those submissions include, but are not limited to, Line & Grade, Erosion and Sediment Pollution 
Control, Safety Review, and Design Field View submissions. 
  
Line & Grade – Line & Grade plans are typically an early submission in a project’s life cycle, as such, the required 
detail level of the bridge model will be at a minimum. Those model elements include the following: 
  

• Bridge  
• SupportLine Locations 
• Deck 

  
Erosion & Sediment Pollution Control – E&S details typically require an accurate determination of the location of 
bridge elements, most notably, substructure units. For E&S submissions, the Base Model will provide the 
necessary amount of information for project impact limits and the number and type of BMPs required. However, a 
completed Base Model is not required, as long as the following Model Elements are provided: 
  

• Bridge  
• SupportLine Locations 
• Deck 
• Abutments 
• Piers 
• Excavation limits (temporary and permanent) 
• Approach Slabs 
• Temporary roads and causeways 

  
Safety Review – The Safety Review is a major review point during a project’s life cycle. Identifying hazards and 
potential safety issues caused by the project requires an appropriate Level of Detail and confidence in the 
structures detailing. The TS&L model should provide sufficient development for this review and allow for any 
issues or concerns to be identified by the Safety Review Committee. 
  
Design Field View – The DFV submission is typically the final project submission during the Preliminary Design 
Phase of a bridge design project (although TS&L submission may occur after DFV depending on the project 
schedule). It is important to coordinate structure issues with the rest of the project submissions to generate a 
complete design concept. A more accurate cost estimate is needed at this stage, and if Refined Model 
substructure element details are required to provide this, they should be included in the model at this time. 

3.6 INCORPORATING CIVIL AND OTHER DISCIPLINE DATA 

When developing the physical 3D bridge model, resources from other models and disciplines will be required. The 
two most important resources are the 3D roadway geometry and the Existing/Proposed Terrain Models. In the 
OpenBridge Modeler workspace, each of these resources should be provided as DGN files that can be 
referenced into the bridge model. 
 
The Existing Terrain Model can be generated from standalone traditional topographic survey and/or LIDAR survey 
data. The terrain model will be crucial for determining the proposed vertical profile during the roadway alignment 
development, and it will be required later during the structure model’s development to determine excavation 
quantities and limits. 
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Figure 3.6-1 Example Terrain Model Data  

 
The 3D roadway geometry file will need to include a horizontal alignment and a vertical profile. This is important 
since the Bridge Element will be associated with this alignment and the deck PG will coincide with the vertical 
profile. 
 

 

Figure 3.6-2  Example Horizontal Geometry Data 



Chapter 3  Workflow Methodology 

 

3-23 

 

 

Figure 3.6-3  Example Vertical Profile Data 

 
Roadway corridor models, as separate DGN files, may also be referenced into the bridge model. The corridor 
model can help determine the required deck and lane widths as well superelevation details (if a superelevation is 
present). The corridor model will also provide proposed roadway embankment limits, which are critical for 
determining wing location, length, and height. 
 

 

Figure 3.6-4 Example Corridor Model Data 

 
Future civil data that may be incorporated into the bridge model to aid in design includes, but is not limited to, 
drainage models and details, ITS, and utility models. 
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 GETTING STARTED 

4.1 SOFTWARE AND WORKSPACE INSTALLATION 

Obtain and install the Bentley software per the organization’s IT department and per the developer’s instructions. 
 
The PennDOT OBM workspace is delivered in the same installation as the ORD workspace. Users can find the 
PennDOT Connect Edition Workspace content along with instructions on the PennDOT CADD Resources 
Website:  
 
https://www.penndot.gov/ProjectAndPrograms/RoadDesignEnvironment/RoadDesign/Pages/CADD-
Resources.aspx. 
 
This includes workspace instructions for local installation and a network configuration. ProjectWise specific 
installation instructions will be available in the future. 

4.2 STARTING A NEW PROJECT   

As mentioned previously, there are several options for how to start a model-centric process. This manual will 
focus on the OBD workflow in which an .obdx file must be created before creating an OBM file for modeling. 
However, the user can create a standalone OBM file without first accessing the OBD. These files will still have all 
the functionality within OBM but will not have some of the interoperability options such as the BIM workflow with 
the LEAP products, visualization with LumenRT, and others. If the desired workflow is to use only the OBM 
software and not use the LEAP analysis products, users can skip to Step # 5 below. 
 
Below are the steps to starting a Model-centric workflow project in a ProjectWise environment. If not using 
ProjectWise, the steps are very similar, and differences are indicated in the descriptions below. 
 
1. Open OBD and select the “ProjectWise” command button. Select your desired Datasource and login. 

Typically, the Single Sign-on option is used, but the alternative User Name and Password option is included in 
the screenshots below as well. 

 

 

Figure 4.2-1  Selecting ProjectWise Command Button 

                OR            

Figure 4.2-2  Login Using the Windows Single Sign-on or User Name and Password  

https://www.penndot.gov/ProjectAndPrograms/RoadDesignEnvironment/RoadDesign/Pages/CADD-Resources.aspx
https://www.penndot.gov/ProjectAndPrograms/RoadDesignEnvironment/RoadDesign/Pages/CADD-Resources.aspx
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2. Left click on the “New File” and navigate to the desired location to save the file and add the specific file name 

and description. Then left click on “Save” to save the file. 
 

 

Figure 4.2-3  Saving New File 

 
3. Select the “Standalone” File Groups option and left click on the Add Standalone Group command. Add your 

group name and select “OK.” 
 

 

Figure 4.2-4  Creating Standalone Group 

 
4. Selecting the newly added group, left click on the OpenBridge Modeler icon to open OBM. 
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Figure 4.2-5  Selecting and Launching the OBM Application 

 
5. Sign into the ProjectWise Datasource again (if prompted) and left click on New File command on the OBM 

home screen. 
 
6. In the “New” dialog box, select the correct folder to save the OBM file in (typically the same folder as the OBD 

file), add the document information (file name, description), and Then access the “Source File” by left clicking 
on “Seed…” and navigate to the PennDOT workspace configuration setup location (either in PW, local, or on 
a network drive) under …Organization Civil / Bridge Design / OpenBridge Modeler / Seed and select the 
appropriate seed file based on whether your project is using the North or South State Plane Coordinates. 
Make sure the “Application” selected is “OpenBridge Modeler.” Then left click on “Open.” If the seed file is not 
visible within the dialog box, change the “Application” to “All Applications” and check for the correct seed file. 

 

 

Figure 4.2-6  Setting Up New Design File 
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7. The user can then select “OK” in the “New” Dialogue box to launch the new OBM file, which is ready to use. 

The user may get a prompt that the software needs to be restarted for the new configuration. If so, click “OK.” 
The OBD file now shows the name and a preview of the OBM file. It may require checking the file back in 
ProjectWise to see this preview for the first time. 

 

 

Figure 4.2-7 Preview of OBM File in OBD 

 
The following sections provide additional helpful tools and techniques for viewing and using this software. It is 
recommended the user walk through these sections before using the software for the first time. If the user is 
experienced, proceed to Chapter 5 but note these sections for future reference. 

4.3 TOOLS FOR INPUT 

Tools used to input and generate a new bridge model are located under the OpenBridge Modeler workflow. 
Select the OpenBridge Modeler workflow from the Workflow drop down menu located in the upper left-hand 
corner of the screen. Through this workflow, all the tools needed to generate a Base bridge model can be found in 
the panels within the tabs.  
 
Below are screenshots of the general ribbon terminology with markups, as well as the Workflow dropdown menu 
and the Home tab. 
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Figure 4.3-1  OBM Ribbon Toolbar Terminology 

 

 

Figure 4.3-2  Workflow Dropdown Menu 

 

 

Figure 4.3-3  OpenBridge Modeler Workflow – Home Ribbon 

4.4 FILE SETTINGS 

File Settings are set and replicated through the seed files and other workspace elements. Typically, the users will 

not need to modify these as part of the set-up process, and the default settings in the seed file will be sufficient. 

However, there are certain aspects of the Settings that the user may want to change in certain circumstances. 

Following are several sections explaining some of these situations. 

First, in order to access the File Settings, the user can navigate to the File > Settings > File > Design File 

Settings. 
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Figure 4.4-1 Design File Settings Location 

4.4.1 Working Units 

In OpenBridge Modeler, it is essential to set the Working Units at the start of the project, and the default (and 
recommended) Accuracy is set to 8 decimal places. This does not mean the user has to input 8 decimal places or 
presume that the accuracy of the input values will ever reach that level. However, it was determined that the 
software will report some erroneous values in trailing decimal places if this accuracy is not specified when placing 
the model elements.  
 

 

Figure 4.4-2 Working Units - Design File Settings Dialog 

 
Working Units Format can be adjusted from Major Units (MU) to Major Units: Sub Units (MU:SU) and back 
again, at any time, affecting only the units when using the Measure tool. Sometimes it is necessary to switch 
between feet and inches and decimal feet to assist in certain tasks while using OBM. While Dimension Styles 



Chapter 4  Getting Started 

 

4-7 

are set up for feet and inches, Working Units are a different entity and can be set up as only decimal feet without 
changing dimensions. 

4.4.2 Position Mapping 

To set up Task shortcuts similar to MicroStation v8i, the user must set up Position Mapping. Navigate to the 
Preferences Dialog box by first selecting File > Settings > User > Preferences. 
 

 

Figure 4.4-3 Settings > User > Preferences  

 
After selecting Preferences, select Position Mapping in the left Category Panel. Enable Position Mapping by 
checking the box next to Use Position Mapping. Populate the settings in the dialog box as seen below: 
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Figure 4.4-4 Working Units - Design File Settings Dialog 

 
The Task Navigation user interface needs to be activated in order for the Position Mapping to work. Enable the 
Task Navigation user interface by selecting it from the File > Settings > User > Preference menu. 
 

 

Figure 4.4-5 Settings > User > Preferences  
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Figure 4.4-6 Task Navigation Bar  

4.5 VIEW CONTROLS 

4.5.1 Optional View Windows  

The user can customize the view windows in the modeling workspace to aid in the modeling of the structure. 
Additional view windows can be especially helpful when solids modeling and allow the user to view multiple 
perspectives (3D Rotate View) of the structure at one time. Up to 8 view windows can be open at one time with 
different views and display styles. and perspective in perspectives. The current perspective of each window can 
be seen in the upper left-hand corner of the view window. Placing view windows in a separate application window 
will be covered in Section 4.5.2.1: Open Multiple OpenBridge Modeler Application Windows.  
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Figure 4.5-1 View Windows in OBM 

 

 

Figure 4.5-2  Current View Perspective 
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4.5.2 Application View Settings 

The Application View Settings consist of how tabs, panels, and the overall window configuration are displayed. 
Most of these view settings can be adjusted in the View tab.  
 

 

Figure 4.5-3 Application View Settings 

4.5.2.1 Open Multiple OpenBridge Modeler Application Windows 

The user can open multiple application windows simultaneously, if desired. This should only be done if the user 
has at least 2 monitors, as the overlapping of the active window makes the secondary window useless. Having a 
window on separate monitors in a 3D program like OBM is extremely beneficial since the default design model 
can be created and modified in one window with the illustrated 3D model open on another screen, so the user can 
see the updates in real-time. Another benefit of having 2 windows open on separate monitors is modifying text 
and dimensions in a drawing model while observing the changes being made in the sheet model. This helps avoid 
placing text or dimensions outside of the sheet border. 
 
To enable the Open Multiple Application Windows option, the user must navigate to the Preferences Dialog 
box by first selecting File > Settings > User > Preferences. 
 

 

Figure 4.5-4 Settings > User > Preferences  

 
When the dialog opens, the user will see a Category list on the left side of the menu. The Open Multiple 
Application Windows option is located under the Operation Category. The user can now check the box next to 
the option and select the number of windows to open simultaneously. After making this change, the application 
needs to be restarted for the changes to take effect. 
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Figure 4.5-5 User Preferences Dialog 

 
When multiple application windows are open, you cannot drag and drop Views to other windows. You must left 
click the top left corner of the View Window and select Change Screen. 
 

 

Figure 4.5-6 Change Screen 

Note: Generally, the number of windows should not exceed the number of monitors the user has available 
for the program.  

 

4.5.2.2 Minimize/Expand Ribbon 

The user can customize the Tabs and Panels and how they function. If the user wishes to minimize the ribbon, a 
simple double-click on the Tab name, or selecting the Minimize Ribbon tool, will collapse it. Positioning the 
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cursor over the Tab name will expand it to temporarily reveal the Tab. If the user wishes to permanently expand 
the Tab, double-clicking the Tab name, or selecting the Expand Ribbon tool, will permanently expand it until 
the previous methods are used to minimize it again. 
 

 

Figure 4.5-7 Minimize Ribbon Tool 

 

 

Figure 4.5-8 Expand Ribbon Tool 

4.5.2.3 Customize Ribbon 

The Ribbon can be customized at the user’s discretion to add or remove panels and/or tools. This can be done in 
any tab and in any workflow. Simply right click the ribbon in a blank area and select Customize Ribbon. 
 

 

Figure 4.5-9  Customize Ribbon 

 
The user can add or remove tools or make any adjustments to the current tool arrangement as desired. Simply 
select a tool and the preferred destination and click Add or Remove. 
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Figure 4.5-10 Customize Ribbon Dialog 

4.5.3 View Settings 

The available options in the View Settings change slightly when switching between 2D and 3D models, but the 
settings discussed in this section are available in both 2D and 3D model views. Any differences between 2D and 
3D tool settings are identified below. 
 

 

Figure 4.5-11 Window View Settings 

 
1. View Attributes – Toggle display settings in the current View, such as Dimensions, Grid, or Level 

Overrides. 

 

Figure 4.5-12 View Attributes Dialog 

 
2. Display Style List – Adjust display styles of the model, such as Wireframe, Illustrative, or Transparent. 

The user will have to left click inside the desired window when changing the Display Style. Display styles 
can be modified to display specific features, such as Render Mode, Overrides, and Edge Settings.  
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Figure 4.5-13 Display Styles Dialog 

 
3. 2D Rotate View (if in 2D file) – View can be oriented by using any of three methods 

 
Dynamic: Manual view rotation along X-Y plane 
2 Points: View set by selecting 2 consecutive points along the desired X plane 
Unrotated: Sets view in True North perspective 
 

 

Figure 4.5-14 2D Rotate Settings 

 
4. 3D Rotate View (if in 3D file) – Choose from preset view perspectives such as Top, Front, or Isometric, or 

Rotate the view manually. Focus origin can be dragged and dropped to a specific point, or snapped to an 
object, and the view will maintain focus on the origin while rotating. 

 

Figure 4.5-15 3D Rotate Settings 
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5. View Previous – Returns view to previous setting or perspective 
6. View Next – Returns view to next setting or perspective, if the View Previous tool was selected 
7. Copy View – Copies view settings from active view to apply to another view 

4.5.4 Displaysets 

Displaysets allow the user to isolate model elements based on active selections. A Displayset may be quickly 
modified or reset as needed and they can be created from the Tools Palette of the View Tab. 
 

 

Figure 4.5-16 Displayset Controls 

 
The User can select model elements and isolate them using the Displayset Set command. The Displayset Set 
tool can also be found by right-clicking in the model window and selecting the command from the context 
sensitive menu. 
 

 

Figure 4.5-17 Displayset Set Tool 
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Figure 4.5-18 Displayset Set Tool (right-click menu) 

Model elements may be removed from a Displayset using the Displayset Remove tool. Start by selecting the 
desired element to be removed, and then select the Displayset Remove tool from the toolbar. 
 

 

Figure 4.5-19 Displayset Remove Tool 

The Displayset Clear tool can be used to remove the active displayset and display all model elements again. 
Select the tool from the tool bar or the right-click context sensitive menu as before. 
 

 

Figure 4.5-20 Displayset Clear Tool 

 

Figure 4.5-21 Displayset Clear Tool (right-click menu) 
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4.5.4.1 View Attributes 

Displaysets can be enabled/disabled in the View Attributes dropdown menu of any active View window. 
 

 

Figure 4.5-22 Reference View Settings 

Note: Any View window that has Displaysets enabled will show [Displayset] in the window header as can 
be seen in figure above. 

4.5.5 Reference View Settings 

Reference View Settings can be controlled per individual reference and per view. If the same model is open in 
multiple view windows, the individual reference view settings in each view window can be controlled separately 
through the Reference Manager in the active view window. Settings such as Level Display are controlled 
through the Level Display tool in the active view window. 
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Figure 4.5-23 Reference View Settings 

4.5.5.1 Live Nesting 

Live Nesting controls the display of references within references. Live nesting settings are found within the 
reference manager. A nesting depth is selected per reference to control the depth of references within references, 
visible in the current view. If Live Nesting is turned off, only the elements drawn in the active view of the model 
referenced are visible. 
 

 

Figure 4.5-24  Attach Reference Dialog 

 
Example: A Professional Engineer seal is referenced into a border file for a project. The border file itself includes 
all the border linework and text for the project. If that border file is referenced into an OBM file with the Nested 
Attachments setting set to No Nesting or set to Live Nesting but Nesting Depth set to 0, only the elements created 
in the border file will display. The PE seal will not be visible with the current settings. The border reference Nested 
Attachments setting must be set to Live Nesting with a minimum Nesting Depth of 1. 



Chapter 4  Getting Started 

 

4-20 

4.5.5.2 Update Sequence 

The Update Sequence setting is a tool to organize references in a specific order in a 2D model to display on top 
of other references. Update Sequence settings are found within the reference manager. A common use of this 
tool is to adjust the order of references to display behind the text or objects in the active design file. 
 

 

Figure 4.5-25 Update Sequence Location 

 
The Update Sequence list is arranged from back to front, with the reference located behind all other references 
at the top of the list. As described above, if the text and elements in the Active Design File are to be at the front or 
on top of all other references, the model denoted Active Design File should be at the bottom of the list. 
 

 

Figure 4.5-26 Update Sequence Dialog 

4.5.5.3 Global/View Level Display 

Level Display is used to toggle on or off specific levels in the active view or globally (throughout the file). Levels 
can be controlled in the active model, or the references and nested attachments can be referenced in the active 
model. 
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Figure 4.5-27 Level Display Dialog 

 
View Display: All levels in the active model, references, and all nested attachments can be toggled on or off in 
each view. Reference display can also be achieved here by right clicking the reference or nested attachment and 
checking or unchecking Display in the menu. References that are greyed out in the list are currently not displayed 
in the view. 
 
Global Display: All levels in the active model and references can be toggled on or off globally. Nested 
attachment levels cannot be toggled on or off globally if the nested attachments are from files other than the 
active OBM file. 

4.5.5.4 Presentation 

The Reference Presentation tool is a powerful tool when individual reference display settings need to be adjusted. 
The Presentation tool is a combination of the standard View Attributes tool and the Display Styles tool, with 
options that vary depending on model type and the active reference selected in the Reference Manager. 
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Figure 4.5-28 Update Sequence Location 

 
In a 2D Drawing Model Reference, the Presentation options are very similar to the options available in the 2D 
View Attributes and Display Styles. Settings can be updated from a Saved View or pushed to a Saved View. If the 
View Attributes options are greyed out, ensure the Use View Flags box is checked. The Reference Display Style 
includes a Display Style exclusive to the Reference called From Parent. This Display style adopts whatever 
display style is active in the model being referenced, but the view attributes are still editable if the Use View Flags 
box is checked. 
 

 

Figure 4.5-29 2D Drawing Model Reference Presentation Dialog 

 
When a Plan Callout, Elevation Callout, or Section Callout creates a view that is referenced into a drawing model, 
more options become available within the Reference Presentation dialog in the drawing model to adjust the 
display settings of these views. The user will notice an additional section for the Clip Volume Settings, including 
view settings for Forward, Back, Cut, and Outside. Each of these settings has a correlating Display Style that 
can be toggled on or off and is fully adjustable. 
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Figure 4.5-30 Plan/Elevation/Section Reference Presentation Dialog 

 
Clip Volume Settings: 

• Forward: Displays any objects in the model, in front of the cut plane, up to the depth of the designated clip 
volume 

• Back: Displays any objects in the model, behind the cut plane, up to the depth of the designated clip 
volume 

• Cut: Displays any objects in the model, passing through the cut plane, directly at the cut plane with no 
depth 

• Outside: Displays all objects, Forward and Back, that are not within the Clip Volume 

4.5.6 Auxiliary Coordinate System 

OBM has a primary Geographic Coordinate System, which is on the global level for the file, but OBM also has a 
local coordinate system that can be set up for specific views and objects. This local coordinate system is called 
the Auxiliary Coordinate System (ACS), and the tools for the ACS can be found in the Drawing Aids Tab in the 
Drawing and Modeling workflows.  
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Figure 4.5-31 ACS Dialog 

 
Multiple Auxiliary Coordinate Systems can be set up in the same file, and any of them can be activated and 
applied to a view at any time. To create an ACS, the user can define an ACS Aligned with Element, by Points, by 
View, by Reference, and by Plane. The ACS origin can be moved or rotated, at any time, by using the Move ACS 
or Rotate ACS commands, respectively. An existing ACS can be applied to any view using the Apply ACS to 
Selected View. Select Toggle ACS Triad, if the ACS symbol is not visible in the current view. 
 

 

Figure 4.5-32  ACS Panel and Lock Panel 

 
If the ACS is defined by anything other than View, but the view will not rotate to align with the ACS axis after it is 
defined, be sure the ACS Plane Lock in the Locks Panel is toggled on. Once toggled on, try changing View Rotate 
to the desired preset view perspective. 
 
This ACS setup is especially useful to orient the user with the bridge before setting up any views, as most views 
need set up using the AccuDraw assistance to align view callouts parallel or perpendicular to the alignment. 
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Figure 4.5-33 ACS Setup Example 

 
Example: Instead of using the baseline to set up the ACS, as it is likely there is some type of vertical geometry 
that could throw off the vertical axis, set up the ACS with a 90-degree corner on a level plane, such as a 
Substructure Footing. Rotate the view to an isometric perspective to see the corner and the top edges. If placing 
the ACS by points, first select the rear right Footing corner point (looking ahead stations) to set the ACS origin 
then travel along the X-positive edge and click point 2 to set the X axis. Finally, travel along the top rear edge of 
the footing in the Y-positive direction and click point 3 to set the Y axis. Since the face of the footing is level, and 
the footing edges were selected for the X and Y axes, the Z axis will be truly vertical. A true vertical Z axis is 
required to obtain true Top, Front, and Side views in the rotate view presets. Toggle the ACS Plane Lock on and 
select Top from the View Rotate tool. 
 

 

Figure 4.5-34 ACS Setup Example Complete 
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4.6 RECOGNIZING COMMAND PROMPTS AND INPUT  

OBM follows a stepwise approach and uses “Command Prompts” to communicate to the user what the software 
requires next in order to execute the selected command. These prompts usually appear following the cursor in the 
active View, as well as in the bottom left corner of the OBM Window in the Status Bar. Also, many OBM tools use 
a Tool Setting dialog box that will appear after the tool is selected. 
 

 

Figure 4.6-1 Command Prompts 

 

Several of the prompts are not clear, and new users need to understand their meaning to successfully navigate 

this workflow: 

• Select: Left click on an applicable model element 

• Data Point: Left click anywhere in the active View  

• Reset: Right click anywhere in the active View 
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On the next several pages, a list of the commands in the recommended sequence of use is provided for both 

prestressed superstructure and steel superstructure model development. Chapter 5 provides detailed input 

descriptions and guidance for these commands and tools. 
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Figure 4.6-2 OBM Commands by Step: Prestress Superstructure Commands - Flowchart 
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Figure 4.6-3 OBM Commands by Step: Steel Superstructure Commands - Flowchart 
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 INPUT DESCRIPTION 

5.1 BRIDGE WIZARD 

OBM has an option to use the Bridge Wizard to generate a bridge model. This tool can be used to create a low 
Level of Detail model quickly. However, not all commands/options are available through this wizard; the user must 
go back into most, if not all, bridge model components to edit these inputs for project-specific inputs. It is also 
easier to go through each command prompt from the start rather than attempt to go back and determine what 
needs to be modified. Therefore, it is recommended that users not use the Bridge Wizard at the current time. 
Users can follow this chapter to step through the applicable OBM commands without using the Bridge Wizard.  

5.2 ORDER OF COMMANDS 

When generating a new bridge model, some bridge elements are required to be entered in a specific order. In 
general, the bridge model is created with a “top-down” approach, and the elements use the information from 
previous commands as the basis for development, continuing in a stepwise fashion to create the bridge model in 
the 3D space. For example, a user cannot create a beam without first creating a beam layout. This chapter will 
outline the tools and order in which the elements and commands are recommended to be entered to create a 
bridge model using the OBM software. 

5.3 ADDING ROADWAY GEOMETRY AND TERRAIN 

The suggested workflow for adding roadway geometry and terrain data is to reference these files as DGNs into 
OBM so the user can automatically see updates and changes to alignment and other files without having to re-
import files. The referenced information can be read and used by OBM with the same functionality as the roadway 
alignment/profile.  

5.3.1 File Referencing 

To reference the data into OBM, select the OpenBridge Modeling Workflow. 
  

 

Figure 5.3-1  Workflow Dropdown 

 
Navigate to Home > Primary > References to launch the References Dialog Box. 
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Figure 5.3-2  Open References Dialog Box 

 
In the References Dialog Box select Tools > Attach or select the Attach Reference icon from the tool bar. 
 

 

Figure 5.3-3  Attach Reference Icon 

 
Browse to the file location where the roadway geometry and/or terrain model DGN files are stored. Select the 
file(s) to be attached. 

 
Tips and Tricks: Multiple files may be referenced at the same time by using Ctrl + Left Mouse Click to 
select files. 

 
The Reference Attachment Properties dialog box will appear for each reference file being attached. In the Model 
selection drop down bar, a 3D model must be selected for the reference file to display correctly in the active 
bridge model. This is mostly an issue for roadway geometry models, as the terrain models should only contain 3D 
model data. Logical Name and Description may be filled out to help organize and catalog various references 
beyond the file names alone. Ensure the Orientation is set to Coincident – World prior to selecting OK.  
 

Workaround: In most cases, both the 2D or “Default” model and the 3D or “3D-Default” models must be 

referenced separately. The user can follow the same procedure twice for the same file and select the 

different models needed, as shown in the image below. 

 



Chapter 5  Input Description 
 

5-3 

 

Figure 5.3-4  Reference Attachment Properties Window  

 
In the active View Window, select Fit View to verify the file(s) were referenced correctly. 
 

 

Figure 5.3-5  View Navigation Toolbar 
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Note: The roadway alignment can be imported into OBM with the Home > Bridge Setup > Import Tool. 
This workflow makes the geometry an active element of the Bridge Model file instead of a separate 
reference. It should be noted that if subsequent revisions are made to the working geometry file, it will not 
be automatically updated to the imported data and must be re-imported. Therefore, this is not the 
recommended workflow. 

5.3.2 Terrain Model 

Terrain Models referenced into the bridge model will display features that are currently active in the source file. 
Typically, this may be limited to only the terrain model boundary. 

 

 

Figure 5.3-6  Terrain Model Displayed after Importing 

 

To display additional features, such as contours or triangles, select the terrain model. In the OpenBridge 
Modeler workflow, select Home > Primary > Properties to launch the Properties Dialog Box. Navigate to 
Reference > Override Symbology and select Yes from the dropdown menu. All Calculated and Source Features 
present in the model can now be displayed in the OpenBridge Model. 
 

 

Figure 5.3-7  Open Properties Dialog Box 
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Figure 5.3-8  Properties Dialog Box (Terrain Model selected) 

 

 

Figure 5.3-9  Override Reference Symbology 

 

 

Figure 5.3-10  Calculated Features Display Options 
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Figure 5.3-11  Referenced Terrain Model with overrides enabled 

 
 Additional information regarding importing and manipulating Terrain Models can be found in the 

PennDOT ORD training materials. Terrain models can be used to define initial footing elevations for 
substructure units during preliminary design. Footings can be set to a specific depth below the terrain 
model at the location of the substructure unit. This application will be discussed further in Chapter 6. 

 

 

Figure 5.3-12  Elevation Constraints Window – Footings Tab 

5.4 ADD BRIDGE 

The first step in creating the actual 3D bridge model is to use the Add Bridge tool. The tool is located on the 
home tab: Home > Bridge Setup > Add Bridge. Basic bridge information and characteristics are entered in this 
window, and the bridge superstructure type is selected at this time. Once the superstructure type is selected; it 
cannot be modified later. To change superstructure types, a new bridge model must be created with the desired 
superstructure type. 
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An additional method for adding approach slabs, approach spans, and breaking up longer structures, is to use the 
Add Unit tool. This will place an additional bridge “unit” in the active bridge. However, all units in a bridge must 
use the same alignment/profile to use this tool. This tool helps the users organize and break the structure into 
defined segments. Using this tool, a different superstructure type can be modeled along the same alignment 
under the same bridge (P/S or RC Concrete Girders, Steel Girders, etc.). 
 

 

Figure 5.4-1 Add Bridge & Add Unit Buttons 

 

 

Figure 5.4-2  Add Bridge Input Window 
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Figure 5.4-3 Bridge Superstructure Types Available in OBM 

 

 

Figure 5.4-4 Add Bridge Unit Input Window 

 
Note: It is important for users to consider the size of the bridge and how many bridges/units/files to break 
the bridge into since only one user can work in a file at a time. References can be used for larger bridge 
models to bring sections together that are completed in other files.  

 
The prompts will require the user to select the alignment to use for the new bridge. It is important to select the 
“2D” alignment on the Z=0 plane and not the 3D alignment shown at the correct elevation. This requires both the 
2D alignment or “default” model and the 3D alignment model to be separately referenced into the OBM .dgn file. 
 
After the Add Bridge or Add Bridge Unit prompts are completed, the newly created bridge will appear under the 
Explorer > OpenBridge Model window. The Explorer window can be turned on and off through the Home > 
Primary > Explorer Tool and pinned in the view window based on user preference. 

5.5 PLACE SUPPORTLINE 

SupportLines are used to lay out the spans of a bridge and the location of substructure units. In general, add 
SupportLines for each CL bearing location of the substructure (this includes continuous, continuous for live load, 
and simply supported multi-span structure). 
 
The Place SupportLine tools are located under the Home > SupportLine panel. There are three ways to place 
SupportLines; Middle Point, Parallel, and Multi.  
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Tips and Tricks: The Multi SupportLine tool offers the most flexibility and advantages when changes to 

the model occur and should be used whenever possible in model development. 

 

 

Figure 5.5-1 Place SupportLine Tools 

5.5.1 Middle Point 

 

Figure 5.5-2 Place SupportLine By Middle Point 

 

Table 2 Place SupportLine By Middle Point  

Input Description 

Skew Angle AASHTO skew angle for SupportLines normal to the alignment (no skew = 0 
degrees). 

 
Note: OBM uses the AASHTO definition of skew angle, not PennDOT’s. 

Length Length of SupportLine element generated in the model space.  
 

Note: The length must be longer than the width of the bridge to avoid 
modeling errors when placing the deck. If length is not specified, the 
distance away from the alignment where the data point is selected will be 
taken as half the SupportLine length; The additional half being generated on 
the opposite side of the alignment. 

Horizontal Offset Horizontal Offset of the SupportLine element from the alignment. Positive values 
shift the SupportLine to the right looking stations ahead, negative values to the left 
looking stations ahead. 
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Input Description 

Station Station to place SupportLine. If stations are not specified, then the point on the 
alignment where the data point was selected will be used for the station. 

Direction Mode Select input: 
Skew - AASHTO skew angle will be displayed next to the alignment to aid in 
the placement of the SupportLine. 
 

 
 
Direction - A direction angle will be displaced to aid in the placement of the 
SupportLine. 
 

 
 

Feature Definition Select the feature definition to assign to the SupportLine. 

Name Prefix Insert/create a name for the SupportLine. 

 

5.5.2 Parallel to SupportLine 

 

Figure 5.5-3 Place SupportLine Parallel to SupportLine 

Table 3 Place SupportLine Parallel to SupportLine 

Input Description 

Offset Distance between parallel supports along the alignment. 
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Input Description 

Tips and Tricks: This method places SupportLines at a distance normal to 
other SupportLines, not along the alignment. No station is associated with 
the Offset SupportLine, so editing placement can only occur by that normal 
distance input. 

Feature Definition Select the feature definition to assign to the SupportLine. 

Name Prefix Insert/create a name for the SupportLine. 

5.5.3 Multi SupportLines 

 

Figure 5.5-4 Place Multi SupportLines 

Table 4 Place Multi SupportLines 

Input Description 

Skew Angle AASHTO Skew angle for SupportLine normal to the alignment (no skew = 0 
degrees). 

 
Note: OBM uses the AASHTO definition of skew angle, not PennDOT’s. 

Length Length of SupportLine element generated in the model space.  
 
Note: The length must be longer than the width of the bridge to avoid 
modeling errors when placing the deck. If length is not specified, the 
distance away from the alignment where the data point is selected will be 
taken as half the SupportLine length; The additional half being generated on 
the opposite side of the alignment.  
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Input Description 

Horizontal Offset Horizontal Offset of the SupportLine element from the alignment. Positive values 
shift the SupportLine to the right looking stations ahead, negative values to the left 
looking stations ahead. 

Start Station Specify the station of the first SupportLine in the group. 

End Station Specify the station of the last SupportLine in the group. 

Number of SupportLines Enter the number of SupportLines to generate. 

Direction Mode Select input: 
Skew - AASHTO skew angle will be displayed next to the alignment to aid in 
the placement of the SupportLine. 
 

 
 
Direction - A direction angle will be displayed to aid in the placement of the 
SupportLine. 
 

 
 

Feature Definition Select the feature definition to assign to the SupportLine. 

Name Prefix Insert/create a name for the SupportLine. 

 
Once the commands have been completed to place the SupportLines, the SupportLines can be modified using 
either the Move or Modify commands. The Modify command can only be used on SupportLines that have been 
created originally using the Multi SupportLine command. 
 

 

Figure 5.5-5 Tools to Modify SupportLines 
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5.6 PLACE DECK 

5.6.1 Place Deck 

SupportLines are required to be modeled before a deck(s) can be defined. Decks are placed from SupportLine 
to SupportLine. Users can model the same deck template across multiple spans by selecting the Start 
SupportLine of the first span and End SupportLine of the final span to be included in the set. 
 
The Place Deck tools is located here: Home > Superstructure > Place Deck. 
 

 

Figure 5.6-1 Place Deck Command 

 

Figure 5.6-2 Place Deck Input Window 
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Table 5 Place Deck 

Input Description 

Template Name Selecting the ellipses or three dots next to the Template Name will open the 
Template Selection dialog. Select the template to place in the model. There are 
several templates available under the “PennDOT” folder included with the 
workspace. There are also the deck templates that are delivered in the standard 
workspace that can be used, especially for preliminary models. 
 

Note: Deck templates can be accessed at Utilities > Libraries > Decks, 
and more information is provided below and in Chapter 6.  

Start Station Offset Enter offset distance from the starting SupportLine along the alignment.  

End Station Offset Enter offset distance from the end SupportLine along the alignment.  

Horizontal Offset  Enter horizontal offset distance from Work Point (WP) to alignment of the deck 
template. 

Vertical Offset Enter vertical offset distance from WP to alignment of the deck template. 

Add Constraints  Assign variable constraints immediately after deck is placed. 
 

Tips and Tricks: Variable constraints can be adjusted after the deck has 
been placed by Element Section (Deck in Model) > Properties > Rule 
Property > Variable Constraint. 

Chord Tolerance To build more accurate/refined models and allows for further refinement when 
alignments have curvature present.  
 

Tips and Tricks: Small tolerance creates more accuracy but also produces 
a larger file size and will slow model regeneration. 

Max Dist Between 
Sections 

The distance along alignment between templates. OBM will then interpolate 
between these sections, so the distance between affects the accuracy of the 
modeled deck in horizontal/vertical curvature or variable conditions.  
 

Tips and Tricks: A small distance increases the accuracy of the model but 
will slow model regeneration. Use small distance (i.e., 1 ft.) for curved or 
skewed structures where more accuracy is needed and/or when having 
issues with deck breakbacks not functioning properly.  

Analytical Deck Designate the deck to have analytical properties or not. This is used only when 
data is transferred to LBC and LBS. 

Deck Breakbacks Allows for “squaring off” of deck ends at skewed supports per PennDOT BD 
standards.  
 

Note: See Section 5.6.3 and 6.6.3 for more details and information on this 
tool and its applicability and functionality. 

Left Start Breakback 
Distance 

Distance normal to the alignment (i.e. width of the barrier) for the deck “square-off” 
point for skewed decks on the left side of the deck start location (looking stations 
ahead). 

Right Start Breakback 
Distance 

Distance normal to the alignment (i.e. width of the barrier) for the deck “square-off” 
point for skewed decks on the right side of the deck start location (looking stations 
ahead). 
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Input Description 

Left End Breakback 
Distance 

Distance normal to the alignment (i.e. width of the barrier) for the deck “square-off” 
point for skewed decks on the left side of the deck end location (looking stations 
ahead). 

Right End Breakback 
Distance 

Distance normal to the alignment (i.e. width of the barrier) for the deck “square-off” 
point for skewed decks on the right side of the deck end location (looking stations 
ahead). 

Deck Material Select the deck material from the Material Library. Several PennDOT specific 
materials are included in the workspace. Users can create material libraries as 
needed. 

Build Order Define build order for the construction of elements. 

Feature Definition  Select the feature definition to assign to the deck. (see Section 3.1 for more details) 

Name Prefix Insert/create a name for the Deck. 

 

5.6.2 Variable Constraints 

Variables can be added to the deck templates to vary the deck properties along the length of the deck. Some 
examples are variable deck thickness, variable cross slopes for shoulders and lanes, variable lane widths, flared 
deck, etc. The Variable Constraints dialog box can be accessed, as noted above, when placing the deck or 
through the Properties menu. A full list of variables for each deck template supplied in the PennDOT workspace is 
included in Section 10.1: Deck Template Exhibits. 
 
Modifying the constraint variables of a standard deck template is one approach to defining the deck for project-
specific parameters. Another approach is to copy the standard deck template in the Utilities > Libraries > Deck 
library and modify it before placing it. Refer to Section 6.6.1, Options to modify deck templates, for more 
information. 
 

 

Figure 5.6-3  Deck Properties – Variable Constraint [FDOT, 2022] 
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Figure 5.6-4 Single Deck Template Window (or Variable Constraints dialog) [FDOT, 2022] 

 
Solid Red Box – Selection between viewing windows. The “Variation” Window is shown in the screenshot, 
displaying the details of the selected variable. The “Template” Window shows the cross section of the selected 
template.  
 
Dashed Red Box – This Variable table has 4 columns. The Variable column lists the variable names as defined 
by the selected template. The Active column contains check boxes for each variable, that can be checked if 
desired inputs for that variable are different than the values brought in by the template. The Default column 
shows the values given by the template and will be used if the check box is unchecked.  
 
Solid Green Box – This window shows the change in the selected variable over the length of the active bridge. 
Changes can be made only if the checkbox for the selected variable is checked. The screenshot above shows the 
details for the RT_Shldr_Width variable, which has changed the width of the right shoulder from the default value 
of 8’, to 2’ over the entire length of the deck.  
 
Dashed Green Box – This window shows a graphical representation of the information put in the Solid Green Box. 
The y-axis represents the values for that variable, and the x-axis follows the stationing of the selected deck. 
[FDOT, 2022] 
 

5.6.3 Deck Breakbacks 

The Deck Breakback inputs allows for “squaring off” of deck ends at skewed supports per PennDOT BD 
standards. The distances entered by the user specifies the width of deck being affected. Therefore, the distances 
typically entered are the barrier widths at each corner of the structure with skewed supports. Use this functionality 
in conjunction with the Barrier “End Cut Orientation” and station offsets for modeling these components for 
skewed structures.  
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Figure 5.6-5 No Deck Breakback Distance VS. Breakback Distance Equal to Barrier Width 

 
Tips and Tricks: If the model is not responding to the Deck Breakback Distance input value, try choosing 
a smaller distance for the “Max Dist Between Sections” input (i.e., 1 ft.) in the Place Deck input or the 

Deck Properties (after placement). 

5.7 PLACE BARRIERS AND SIDEWALKS 

Barriers and sidewalks (Home > Accessory > Place Barrier) are placed into a model by selecting an active 
deck. Barrier and sidewalks are placed into the model using the Work Point (WP) location designated in the 
barrier or sidewalk template. The procedure for placing barriers and sidewalks is the same, but the location at 
which they are placed may differ. 
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Figure 5.7-1 Barrier Template and Work Point 

 

 

Figure 5.7-2 Place Barrier 
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Table 6 Place Barrier 

Input Description 

Template Name Selecting the ellipses or three dots next to the Template Name will open the 
Template Selection dialog. Select the template to place in the model.  

 
Note: Deck templates are created or modified under Utilities > Libraries > 
Barriers. More information is provided in Chapter 6.  

Start Station Offset Enter offset distance from the starting SupportLine along the alignment.  

End Station Offset Enter offset distance from the end SupportLine along the alignment.  

Horizontal Offset  Enter horizontal offset distance from the WP of the template to the path that has 
been selected for the barrier. 

Vertical Offset Enter vertical offset distance from the WP of the template to the path that has been 
selected for the barrier. 

Barrier Material Select the deck material from the Material Library. There have been several 
PennDOT specific materials added to the workspace and users can create libraries 
as needed. 

Chord Tolerance Used to build more accurate/refined models and allows for further refinement when 
alignments have curvature present.  
 

Tips and Tricks: Small tolerance creates more accuracy but also a larger 
file size and will slow model regeneration. 

Max Dist Between 
Sections 

Distance between sections increase or decrease the accuracy of the modeled 
barrier.  
 

Tips and Tricks: A small distance increases the accuracy of the model but 
will slow model regeneration. 

Template Orientation Details the orientation of the solid faces of the barrier along the alignment. 

End Cut Orientation Details the end condition of the barrier. Specifically, if the barrier end condition (see 
Figure 5.7-4 Barrier Normal to Path VS. Follow Skew): 

• Follows the skew 

• Normal to the barrier path 
 
Note: This typically should be set to “Normal to the barrier path,” and, along 
with Station Offsets, can orient the barrier correctly at skewed supports. 

Build Order Defines build order for construction of elements. 

Feature Definition  Select the feature definition to assign to the deck. 

Name Prefix Insert/create a name for the Deck. 

 
Using the WP designated in the barrier template, the barrier template is placed along an alignment or placed 
along a deck template point that is selected from a guideline list. When the Select Guideline from List is chosen, 
the deck template in which the barrier is to be placed is shown, and the user must select the correct deck 
template point in which to align with the WP on the barrier template.  
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Figure 5.7-3 Path Selection and Guideline Point Names Example for Left Barrier Placement 

 

Tips and Tricks: The text size in the template view window can be adjusted with the  tools at the 
top of the window as the text is often overlapping in the default setting. 

 
Note: The Work Point for the outside barrier templates is the curb line, and it is the center for median 
barrier templates. 

 
The barrier template end condition can be specified to Follow Skew or Normal to Path, before or after the barrier 
is placed. Typically, “Normal to Path” should be specified per PennDOT standards. 
 

 

Figure 5.7-4 Barrier Normal to Path VS. Follow Skew 

 
Sidewalks are created within the barrier templates dialog (Utilities > Libraries > Barriers) and placed in the 
same manner as the barriers. More information is provided in Section 6.7.1 for template creation and modification. 
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Figure 5.7-5 Sidewalk Template and Work Point 

 
When barriers are placed on top of sidewalks, such as the alternative sidewalk detail from BD-601M Sheet 4 of 12 
shown below, the barriers use the deck or barrier guidelines/points for placement. To place a barrier, select the 
deck or barrier to place the additional barrier on top of. The user will then select the template point from a 
guideline list of the selected element. 
 

 

Figure 5.7-6 Alternate Sidewalk Detail from BD-601M Sheet 4 of 12 with Barrier Cast on Sidewalk 

5.8 ASSIGN SUPERELEVATION 

Superelevation can be assigned to the bridge deck in the active model. There are two methods to assign 
superelevation to a bridge deck: 1) Manually modifying the deck geometry variables to the desired superelevation 
values or 2) Using the Assign Superelevation tool located here: Home > Superstructure > Assign 
Superelevation. 
 
Users can also assign Superelevation using the Variable Constraints dialog box by accessing the properties of a 
modeled deck component. In this window you can select the Variables for deck slope and define the start/end 
stations and slope values for the Superelevation transition. This is the same process used for modifying any of the 
deck template variables outlined in Section 5.6.2. 
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Figure 5.8-1 Adjusting Variable Deck Constraints  

 

 

Figure 5.8-2 Assigning Superelevation Using Manual Inputs 

 
The Assign Superelevation tool utilizes a references roadway dgn file with the Superelevation information 
already included. To use this approach, the correct highway file with the superelevation information included must 
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be attached and the reference turned on. The Assign Superelevation tool uses points designated with 
Superelevation Flag within the deck template to apply the superelevation along the length of the deck. 
 

 

Figure 5.8-3 Location of Assign Superelevation Tool 

 

 

Figure 5.8-4 Location of Superelevation Flag within the Deck Templates 

 
After the prompts are followed and the Superelevation section and deck element are selected, the Superelevation 
Assignment dialog box is available.  
 

 

Figure 5.8-5 Superelevation Assignment Window 
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The current version of OBM makes the Superelevation Point selection process slightly cumbersome. The Pivot 
Point and the Template Point cannot be the same value in the same row. For example, if  the Pivot Point for the 
LT LANE row is desired to be P_8., and the Superelevation Assignment dialog box automatically brings in P_8 for 
the Template Point field, the user should:  

1. Change the Template Point to a value different than the desired Pivot Point, chosen from the 
dropdown arrow. 

2. The dropdown window for the Pivot Point should now display P_8 as an option. 
3. Go back to the Template Point dropdown window and select the desired value. 

 
Note: A positive slope in a Superelevation file from ORD, is from the alignment line moving outward. 
Slanting upward while looking down station is considered a positive slope, while slanting downward is a 
negative slope. Alternatively, OBM has positive and negative slope designations consistent with the slope 
of a line in a cartesian coordinate system. Also, in OBM, Superelevation grade and signs are referencing 
the Superelevation pivot point, not as assigned in the Superelevation definitions in ORD. Superelevation in 
OBM will not allow pivoting points outside the deck template. (FDOT, 2022) 

5.9 PLACE BEAM LAYOUT 

Before beams can be added to the model, a Beam Layout is required to create a path for the beam elements to 
follow. The Beam Layout tool serves as the guidelines that are generated in 2D line work that is visible in plan 
view (at z = 0 elevation) for the beam members that will be placed into the model. This step generates information 
that is typically found on a framing plan such as the number of beams, beams spacing, overhang spacing, 
SupportLine offset. The Beam Layout tool is located here: Home > Superstructure > Beam Layout. 
 

 

Figure 5.9-1 Beam Layout Tool 

 
Once the start and end SupportLine limits have been selected, the Beam Layout window will open allowing the 
user to specify the details of the beam group. After the user has entered all the information to define the beam 
layout, select the Validate button to verify that the beam layout has been defined properly. Then click Save if no 
validation errors are found. If the beam ends are to be skewed, the user must select the Skew Ends checkbox 
column in the dialogue box, shown in the figure above, to ensure the beam ends will be skewed when placing the 
beams, as detailed in the next step. 
 

Tips and Tricks: The user should verify that the correct placement method is selected before proceeding 
with the input. Changing this from simple to continuous after defining layout parameters will remove all the 
existing parameter input. 
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Figure 5.9-2 Beam Layout Window 

 
Note: For box beam superstructures with 2 bearing pads, the “Advanced Bearing Definition” checkbox 
must be selected, and the additional inputs entered (number of bearings, spacing, and offsets). See 
Section 6.21.3 for more details. 

5.10 PLACE BEAM – CONCRETE  

Once a Beam Layout has been defined, concrete beams can be applied to the beam layout. The Place Beam 
tool will generate a window with different options depending on which bridge type has been defined when the Add 
Bridge tool was used (P/S or RC Concrete Girders versus Steel Girders). 
 

 

Figure 5.10-1 Place Beam Tool 

 
After selecting the beam layout to add the concrete beams, a window will open that allows the user to select the 
project-specific beam template and haunch or camber values. Selecting the Apply to All Beams check box will 
allow the user to define one beam for the entire group instead of defining each beam individually. 
 
To use the PennDOT workspace Beam Templates, the user must select “Custom” for the Beam Type and then 
navigate to the proper section. 
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Figure 5.10-2 Beam Definition Window 

 
Changes can be made to the beam group after it has been created by selecting one of the beams in the group 
and then, in the property window, clicking on the ellipses (three dots) next to Beam Definition SELECT to Edit. 
The same window will appear that was used to generate the beam group. Adjustments can then be made, such 
as changing the beam size, haunch values, etc. 
 

 

Figure 5.10-3 Editing Beam Definition 
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The default setting in OBM is to place beams vertically without rotation. The user can specify beams that are 
rotated, so the top flange of the beam will be parallel to the top surface of the deck. This change will affect the 
bearing seat elevations and details. The change can be made within the properties window. 
 

 

Figure 5.10-4 Beams Placed Without Rotation 

 

 

Figure 5.10-5 Changing Beam Rotation 

 

 

Figure 5.10-6  Beams Placed With Rotation 

5.10.1 Haunch Manual Input 

Minimum haunch thicknesses for a beam group are computed automatically in OBM. However, they can also be 
manually defined in the Beam Definition dialog window. The minimum thicknesses are defined at the bearing 
lines and are referred to as the Haunch Start location and the Haunch End location. 
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Figure 5.10-7  Manual Haunch Inputs 

The user must first uncheck the Compute check box to enable the manual input fields for the Haunch Start and 
Haunch End. The actual value of the haunch should be set to the haunch thickness over the girder at its 
centerline, which may not be the minimum haunch thickness if the girders are set level. 
 
For Base Models, allowing OBM to compute the haunch thickness is acceptable, but these values should be 
verified independently and modified manually as required.  
 

Note: Camber at mid-span can be input in certain haunch option; however, the prestressed beams cannot 
currently be modeled with parabolic camber. The beams are modeled with a straight line from top of beam 
at start to top of beam at end. 

 
Note: Additional information about manually defining haunches may be found on the Bentley website at 
https://docs.bentley.com/LiveContent/web/OpenBridge%20Modeler%20Help-
v16/en/obm_Beam_Definition.html 

5.11 PLACE BEAM – STEEL 

Steel beams can be applied to the beam layout similarly to concrete beams. The Place Beam tool will generate a 
window with different steel specific beam options when the steel bridge type has been defined previously in the 
Add Bridge command. 
 

 

Figure 5.11-1 Place Beam Tool 

 
After selecting the beam layout to add the steel beams, a window will open that allows the user to select the 
project-specific beam template and haunch or camber values. Selecting the Apply to All Beams check box will 
allow the user to define one beam for the entire beam group instead of defining each beam individually. If the 
beams are not identical, each beam’s parameters can be defined individually, while beam parameters can be 
copied to identical beams to prevent defining the same properties multiple times. In cases where variable depth 
beams are required, adjust the Relative Location field to the necessary values and specify the desired transition 
type using the Variation option. 
 
Additional input locations may be required to adequately define the needed beam shape. To do so, select the 
Add button, denoted with the green plus symbol, and a new input line will be placed above the currently 
highlighted row. All of the information from the highlighted row will be copied to the new row. 
 
Dimensional properties for flanges, webs, and cover plates may all be varied by selecting the Section drop-down 
menu and adding new rows under the specific section. 
 Also 

https://docs.bentley.com/LiveContent/web/OpenBridge%20Modeler%20Help-v16/en/obm_Beam_Definition.html
https://docs.bentley.com/LiveContent/web/OpenBridge%20Modeler%20Help-v16/en/obm_Beam_Definition.html
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Figure 5.11-2 Beam Definition Window 

 
Just like the concrete beams, changes can be made to the beam group after it has been created by selecting one 
of the beams in the group and then clicking on the ellipses or three dots next to Beam Definition SELECT to 
Edit in the properties window. The same window will appear that was used to generate the beam group. 
Adjustments can then be made, such as changing the beam properties, haunch values, etc. 
 

Note: In OBM, the haunch is measured from the top of web for steel girders and the girder will be modeled 
following the profile of the deck (final position). 
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Figure 5.11-3 Editing Beam Definition 

5.12 PLACE CONCRETE DIAPHRAGMS 

OBM at the current time can only generate very basic concrete diaphragms with little detail. Also, they can 
currently only be used with prestressed concrete beams, not steel girders. Concrete diaphragms can only be 
placed after a beam group has been created. To place concrete diaphragms, select the Place Diaphragms 
button and select the beam group to apply the diaphragms. This will then launch and open the Place 
Diaphragms dialog window. 
 
 

 

Figure 5.12-1  Place Diaphragms Tool 
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Figure 5.12-2 Place Diaphragms Window 

 
The Place Diaphragms dialog window has a variety of inputs that the user can use to create project-specific 
diaphragm details. For example, the skew input may need to be updated to match the bridge. The diaphragm 
thickness will be centered on the location entered by the user. For example:  
 

• A diaphragm placed from SupportLine 1  

• Relative Location = 0.00000’ 

• Thickness = 1.75000’ 
 

Will result in the diaphragm being placed 0.875’ before and after the SupportLine 1. 
 

 

Figure 5.12-3 Plan View - Diaphragm Thickness Centered on SupportLines 
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Changes can be made to the concrete diaphragms after they have been created by selecting one of the 
diaphragms then clicking on the ellipses or three dots next to Concrete Diaphragm SELECT to Edit in the 
properties window. The same window will appear that was used to generate the diaphragms.  
 

 

Figure 5.12-4 Accessing Diaphragms for Editing through Properties 

 
Note: The Concrete Diaphragm tool currently has limitations, including not accounting for beam solid 
volumes when modeling (i.e., will not conform to Bulb-Tee beam shape) and not allowing for sloping or 
other modifications needed in typical projects. See Section 6.11 for more detailed description and 
modifying these elements for a Refined model element. 

 

5.13 PLACE STEEL DIAPHRAGMS/CROSS FRAMES AND STIFFENERS 

5.13.1 Place Cross Frames 

Cross frames and their associated stiffeners/connection plates can be selected and placed with the cross frames 
using the Place Cross Frames tool. Structural angles cannot be used as stiffeners; only stiffener plates from the 
stiffener template library, Utilities > Libraries > Connection, may be defined.  
 

 

Figure 5.13-1 Place Cross Frames Tool 

 
Note: Recent updates of the software now allow for additional option for orienting the connector plates 
along the diagonals of the members and also using the member center of gravity for alignment of member 
placement. 

 
Cross frames can be placed individually or by using the included Wizard. The wizard places cross frames by 
number of locations at equal spaces or by the desired spacing. If placed by desired spacing, OBM will fit as many 
cross frames within the given limits as possible. When using the wizard to place cross frames, it is also possible 
to add cross frames individually. Therefore, the recommended workflow is to use the Wizard as a starting 
point and adjust/add manually from the results. 
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Figure 5.13-2 Beam Definition Window 

 
 

 

Figure 5.13-3 View of Stiffeners and Cross Frames 



Chapter 5  Input Description 
 

5-34 

5.13.2 Place Stiffeners 

The stiffeners and connection plates associated with the cross frames and diaphragms should be placed with the 
Place Steel Diaphragm/Cross Frame tool and associated Wizard. Additional stiffeners, whether bearing, jacking, 
or other transverse stiffeners, can be placed along the beams using the Place Stiffeners tool in the 
Superstructure ribbon. Structural angles cannot be used as stiffeners for steel superstructure bridges; only 
stiffener plates can be defined.  
 

 

Figure 5.13-4 Place Stiffeners Tool 

 
Note: Longitudinal stiffeners cannot currently be placed with this tool. Users will need to manually place 
longitudinal stiffeners with Solids Modeling tools and techniques, if they are required to be modeled. 

 
The stiffener dimensions can be modified, and new stiffener options are created in the Utilities > Libraries > 
Stiffeners. 
 
Stiffeners can be placed along the beams independently or by using the included Wizard. Stiffener spacing is 
specified from end of beam or from a previous stiffener and can be placed individually or with a specified number 
of stiffeners at equal spacing.  
 
 

 

Figure 5.13-5 Place Stiffener and Wizard Dialog 
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5.14 PLACE FIELD SPLICES 

Field Splices can be defined and placed by using the Place Field Splice tool in the Superstructure ribbon. 
 

 

Figure 5.14-1 Place Field Splice Tool 

 
After defining the field splice parameters in the Splices template library found here: Utilities > Libraries > 
Splices, the template can be selected in the Field Splice Pattern drop down in the dialog and placed on the 
framing in the desired location(s). Placement is based on a desired length from a SupportLine, or a ratio of span 
length between multiple SupportLines. Field Splice parameters can be copied to multiple beams after being 
defined to prevent needing to repeat definitions. 

 

 

Figure 5.14-2 Place Field Splice 
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Figure 5.14-3 View of Stiffeners and Cross Frames and Field Splices 

5.15 PLACE SHEAR STUDS 

Shear studs can be defined and placed by using the Place Shear Studs tool. 
 

 

Figure 5.15-1 Place Shear Studs Tool 

 
Shear studs are placed by first selecting the beam group then clicking Add. Multiple groups of shear studs can be 
placed along the beam by defining start and end locations or span ratios and defining shear stud spacing. Shear 
studs can be selected from a predefined library of shear studs within the program or after parameters are defined 
in the shear stud template library, and number of studs per row can be set in the dialog with the desired 
transverse spacing. The template library can be found here: Utilities > Libraries > Shear Studs. 
 

 

Figure 5.15-2 Shear Stud Dialog 
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Figure 5.15-3 Shear Stud View 

 

5.16 PLACE ABUTMENT 

Abutments are placed on a SupportLine location within the OBM model. The Place Abutment tool places 
abutments from the Utilities > Libraries > Abutments template library. 
 

 

Figure 5.16-1 Place Abutment 

 
Note: Currently, this tool is only recommended for use with stub or pile cap type abutments such as 
integral or MSE abutments. The BD-621M, BD-622M, and BD-624M standard abutments will need to 
follow Section 5.17 and Section 6.17. 

 
After selecting the Place Abutment button, the user will be promoted to define basic abutment properties and 
select the SupportLine(s) to place the abutment. When defining the abutment properties, it is recommended that 
the user leaves the “Integral” box unchecked as this can have unintended effects on the placement and is not 
used for analysis or other purposes. 
 



Chapter 5  Input Description 
 

5-38 

 

Figure 5.16-2 Defining Abutment Properties and Selecting Abutment Template 

 

 

Figure 5.16-3 Selecting SupportLine for Abutment Placement 

 
After the abutment has been placed, the user can click on the abutment to activate the properties and click on the 
ellipses or three dots of SELECT to Edit to the right of the Substructure Template to adjust the abutment 
dimensions. In this window the user can adjust the cap, cheek walls, footings, and piles. 
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Workaround: For integral abutments, it is recommended that the user add the end diaphragm as an 

oversized backwall per the provided workspace template. This provides the most visually correct and 

functional component until solids modeling is needed to create a diaphragm Refined element. 

 

 

Figure 5.16-4 Editing Abutment Properties 
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Figure 5.16-5 Adjusting Abutment Properties 

 

 

Figure 5.16-6 Abutment After Properties Modification 

 



Chapter 5  Input Description 
 

5-41 

A stepped abutment cap or pedestals are modeled with bearing elements. See section 5.21 (Place Bearing) for 
more information.  
 
Also, additional information for customizing and reaching the necessary final design development and detail is 
included in Section 6.16. 

5.17 PLACE CUSTOM ABUTMENT 

Abutment designs that do not conform to the standard abutment templates provided in the Place Abutment tool, 
will have to be placed using the Place Custom Abutment tool. These components are currently being developed 
for PennDOT standard BD-621M, BD-622M, and BD-624M abutments, and more information will be included in 
subsequent releases of this manual.  
 

 

Figure 5.17-1 Place Custom Abutment Tool 

 
After selecting the Place Custom Abutment button, the user will be prompted to define basic abutment 
properties. Select the SupportLine(s) to place the abutment.   
 

 

Figure 5.17-2  Selecting SupportLine for Custom Abutment 
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Figure 5.17-3 Abutment After Placement 

 

 

Figure 5.17-4  Changing or Updating Abutment Cell 

5.18 PLACE WINGWALL 

Wingwalls can only be placed after an abutment has been modeled in OBM. Wingwalls can only be added to an 
abutment that was created using the Place Abutment tools and cannot be added to an abutment that was placed 
using the Place Custom Abutment tools. The Place Wingwall tool places abutments from the Utilities > 
Libraries > Wingwall. 
 
 

 

Figure 5.18-1 Place Wingwall 
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After selecting the Place Wingwall button, the user will be prompted to define basic wingwall properties and 
select the Abutment to place the wingwalls. When defining the wingwall properties, the user can define the left 
wingwall, right wingwall, or both wingwalls at the same time. Different properties and templates can be defined for 
each individual wingwall. 
 

 

Figure 5.18-2 Defining Wingwall Properties and Selecting Wingwall Template 
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Figure 5.18-3 Selecting Abutment for Wingwall Placement 

When placing wingwalls, the user may select the orientation of the wingwall relative to the abutment, and then 
apply in necessary skew angle. Two Orientation options are available. The first orientation is the Normal/Skew 
option. This option places the longitudinal reference axis of the wingwall normal to the back face of the abutment. 
The reference axis is located through the longitudinal center of the wingwall and as such the wing may need to be 
adjusted to line up correctly with the left or right face of the abutment respectively. A skew angle may then be 
provided to rotate the wingwall relative to the reference axis. 
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Figure 5.18-4 Wingwall orientation options 

Similarly, the second orientation option is the Inline/Skew option. This option places the wingwall inline with the 
abutment it is being attached to. The reference axis, and thus the longitudinal length of the wingwall, is place 
along the same line as the abutment centerline. Adjustments to the wingwall’s location/alignment may also be 
required at this time, and the wingwall itself may be skewed about the reference axis as well. 
 

 
 

Figure 5.18-5 Inline wingwall with a -10° 00’ 00” skew 

After the wingwall has been placed, the user can click on the wingwall to activate the properties and click on the 
ellipses of SELECT to Edit to the right of the Wingwall Template to adjust the wingwall dimensions. A pair of 
wingwalls can be placed together, but the properties must be edited individually after they have been placed. In 
this window the user can adjust the cap, footings, and piles. 
 
The OBM supplied substructure tools can be difficult to work with to obtain a cohesive design, especially when 
trying to incorporate PennDOT specific design details for substructure units and combined footings with 
abutments. OBM provides a wide variety of properties that allow the user to adjust and fine tune the wingwall 
design, but the user may encounter situations such as combined abutment and wingwall footings not lining up, 
wingwall front face not aligning with abutment front face, and the wingwall top not following the roadway or curb 
profile such as for U-wing abutments. When these situations are encountered, it may be helpful for the user to use 
a custom abutment, as described in Sections 5.17 and 6.17.   
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Figure 5.18-6 Editing Wingwall Properties 

 
 

 

Figure 5.18-7 Adjusting Wingwall Properties 
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Figure 5.18-8 Wingwall After Properties Modification 

5.19 PLACE PIER 

Piers are placed in OBM models similarly to abutments. Piers must be placed on a SupportLine location within 
the model. The Place Pier tool places abutments from the Utilities > Libraries > Piers. 
 

 

Figure 5.19-1 Place Pier 

After selecting the Place Pier button, the user will be prompted to define basic pier properties and select the 
SupportLine(s) to place the pier.   
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Figure 5.19-2 Defining Pier Properties and Selecting Pier Template 

 

 

Figure 5.19-3 Selecting SupportLine for Pier Placement 

 
After the pier has been placed, the user can click on the pier to activate the properties and click on the ellipses 
(the three dots) of SELECT to Edit to the right of the Substructure Template to adjust the pier dimensions. In 
this window the user can adjust the cap, cheek walls, columns (size and number), struts, footings, and piles. 
 

Note: The stem of a wall type pier is adjusted in the column tab of the Place Pier dialogue box. 
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Figure 5.19-4 Editing Pier Properties 

 

 

Figure 5.19-5 Adjusting Pier Properties 
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Figure 5.19-6 Pier After Properties Modification 

 
A stepped pier cap or pedestals are modeled with bearing elements. See Section 5.21, Place Bearing, for more 
information.  

5.20 PLACE CUSTOM PIER 

Pier designs that do not conform to the standard templates provided in the PennDOT workspace and cannot be 
created as a template using the OBM tools, must be created outside of OBM (MicroStation) and imported using 
the Place Custom Pier tool. An example is a signature pier design with architectural details of aesthetic 
purposes. 
 

 

Figure 5.20-1 Place Custom Pier Tool 

 
After selecting the Place Custom Pier button, the user will be prompted to define basic pier properties and select 
the SupportLine(s) to place the pier.   
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Figure 5.20-2  Selecting SupportLine for Custom Pier 

 

  

Figure 5.20-3 Pier After Placement 

After the pier has been placed, the user can click on the pier to activate the properties and click on the ellipses 
(the three dots) of SELECT to Edit to the right of the Cell to change the pier or import an updated pier cell.  
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Figure 5.20-4  Changing or Updating Pier Cell 

5.21 PLACE BEARING 

Bearings are placed in the OBM model along SupportLines. Bearings can be placed as a single set along a 
SupportLine (abutment locations, continuous pier), or placed in groups ahead and back stations (pier locations 
with non-continuous spans). Bearings, like piers, can be placed along multiple SupportLines at one time. 
 

 

Figure 5.21-1 Place Bearing Tool 

 
After selecting the Place Bearing tool found in the Home > Substructure > Place Bearings, the user will be 
prompted to define basic bearing properties by selecting the SupportLine(s) to place the bearings.   
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Figure 5.21-2 Selecting SupportLine for Pier  

 

 

Figure 5.21-3 Bearings After Placement 

 
The user can create a stepped pier cap or pedestals at the bearing seat locations. These changes can be made 
or adjusted under the bearing properties window.  
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Figure 5.21-4 Stepped Pier Cap 

 

 

Figure 5.21-5 Bearing Pedestals 
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Currently, the basic OBM bearing modeling tools can only model cube, cylinders, and cells created outside of 
OBM template tools. Bearings requiring a higher Level of Detail should be modeled outside of OBM (MicroStation) 
and imported as a cell, such as pot bearings, disk bearings, rollers, etc.  
 

 

Figure 5.21-6 Cylinder Bearing Type 

5.22 PLACE EXCAVATION 

There is a Place Excavation tool within in OBM that can be used with basic rectangular footings with constant 
slopes; however, the recommended workflow is to use OpenRoads Designer tools as outlined in the PennDOT 
OpenRoads Class III Excavation Modeling Training and Class Guide. 

5.23 PLACE APPROACH SLABS 

Approach slabs are placed in the OBM model using the Approach Slab tools. The Approach Slab tools consist 
of Place Approach Ref Line, Place Approach Slab, and Place Sleeper Slab.  
 

 

Figure 5.23-1 Place Approach Slab Tools 
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5.23.1 Approach Ref Line  

 

Figure 5.23-2 Place Approach Ref Line Tool 

 
After selecting the Place Approach Ref Line tool found in the Home > Approach Slab > Place Approach Ref 
Line, the user will be prompted to define basic properties to define the location of the reference line. Toggle 
between Start and End location and enter an Offset From SupportLine distance to position the Approach Ref. 
Line in the correct location and orientation. 
 

 

Figure 5.23-3 Placing Approach Ref Line 

 
After placing the Approach Slab Ref Line, a new unit will be added for the approach slab in the bridge explorer. 
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Figure 5.23-4 New Unit for Approach Slab 

5.23.2 Place Approach Slab 

 

Figure 5.23-5 Place Approach Slab Tool 

 
After selecting the Place Approach Slab tool, found in the Home > Approach Slab > Place Approach Slab, the 
user will be prompted to define basic parameters to define the approach slab. The user can choose to sync the 
approach slab with the deck or choose to define a separate template for the approach slab. Templates for the 
approach slab are defined in the deck library (Utilities > Libraries > Decks). The approach slab is similar to the 
deck and variable constraints can be edited to meet design requirements to adjust slope, lane widths, shoulder 
width, thicknesses, etc.  
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Figure 5.23-6 Placing Approach Slab 

 
Note: The Approach Slab Breakbacks are to be used for skewed supports. See Section 5.6.3 for more 
information. 

 

5.23.3 Place Sleeper Slab 

 

Figure 5.23-7 Place Sleeper Slab Tool 

 
After selecting the Place Sleeper Slab tool, found in the Home > Approach Slab > Place Sleeper Slab, the user 
will be prompted to select the template and the approach slab reference line to place the sleeper slab. Templates 
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for the sleeper slab are defined in the sleeper slab library (Utilities > Libraries > Sleeper Slab). The user can 
define the sleeper slab to conform backwall with approach top, conform with approach bottom, and adjust the 
length of the sleeper slab to the width of the approach slab. 
 

 

Figure 5.23-8  Placing Sleeper Slab 

 

 

Figure 5.23-9 Sleeper Slab 
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5.24 ADDING REINFORCEMENT 

Reinforcement can be added in OBM to concrete elements within the bridge model. The reinforcement tools can 
be accessed in the ProConcrete workflow.  
 
Rebar can be detailed using OBM, but rebar schedules cannot be generated using OBM alone. A ProStructures’ 
license is required to generate rebar schedules. After the rebar has been detailed in OBM, the files can be 
opened with ProStructures to generate a rebar schedule. 
 

 

Figure 5.24-1 ProConcrete Workflow 

 
The ProConcrete workflow has a variety of tools that can be used to place rebar within a concrete element. There 
are specific tools for beams, columns, footings, walls, and slab reinforcement. For detailing that might be 
outside these elements, the user can use the additional rebar tools, such as Single Rebarset, Single Rebar, 
Single Rebar Distribution, Irregular Dispatch. The user should examine the tools and their capabilities to 
determine which tool is right for the element they wish to detail. As is common with many other modeling tools in 
OBM, there is more than one tool to achieve the intended goal. These basic tools are similar in their function.  
Below is an example of reinforcing a concrete footing.  
 
Under the ProConcrete workflow, select Continuous Footing Reinforcement and the window will open on the 

screen. The first step is to Select Active Concrete using the   icon. Select the icon then select the concrete 
footing.  
 

 

Figure 5.24-2 Continuous Footing Reinforcing Tool 
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After the concrete is selected, the user will see the rebar in the model view. The user should then use the input 
dialogs to define the footing reinforcement. The user can define the number of bars or define the space and allow 
OBM to generate the bars based on the spacing. 
 

 

Figure 5.24-3 Footing with Reinforcement Defined  

 
There are also tools that allow the user to add Laps to the reinforcement bars. These commands are all user 
controlled and can be manipulated for project-specific needs and to follow design requirements. 
 

 

Figure 5.24-4 Footing Reinforcement Detailed with Laps 

 
Another option available to users is the add End Conditions to the reinforcement bars. For example, if hooked 
bars are required for design, the user can define hooks and the bend angle to meet design requirements. 
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Figure 5.24-5  Footing Reinforcement Detailed with 180 Degree Hooks 

 
After the rebar is placed, the user can edit the rebar adjusting rebar size, spacing, clearances, end conditions etc., 
by double clicking one of the rebar members in the set. The window used to place the rebar members will open 
and adjustments can be made.  
 

 

Figure 5.24-6  Footing Reinforcement Modification 

 
There are some basic tools provided in OBM that apply to most concrete elements generated in the OBM model. 
Footings with nonorthogonal angles or footings with piles that require the rebar to be spaced around them are 
likely outside of the capability of these tools, and advanced rebar detailing is required.  
 

Note: Once the rebar is placed and accepted with the green check mark you can always double click a 
single or set of rebar to reopen the placement dialog window to make further changes.  
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For additional and more advanced reinforcement tools for use in other bridge elements, see Section 6.24. 
 

5.25 ADDING ATTRIBUTES 

[This section is under development. Content will be added after PennDOT Item Type list development is complete 
and Digital Delivery Directive 2025 Pilot Project feedback is incorporated.] 
 

5.26 REFERENCES 

State of Florida Department of Transportation, 2022. FDOTConnect for OpenBridge Modeler: Bridge Design and 
Modeling Course Guide. [Online] 
Available at: https://www.fdot.gov/cadd/downloads/documentation/fdotconnecttraining/fdotobm/fdotconnect-
bridge-design-modeling 
[Accessed 26 August 2022]. 
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 ADVANCED INPUT DESCRIPTION 

6.6 PLACE DECK 

6.6.1 Options to modify deck templates 

The primary method for using and updating deck templates is to use the PennDOT-specific deck templates 
provided in the workspace and modify the Variable Constraints as described in Chapter 5, Section 5.6.2. Doing 
so will result in a consistent deck model cross section that is fully parametric, follows BD-601M, and follows the 
Digital Delivery Guidelines for final design detail and information requirements. These templates will also allow for 
linking superelevation when using roadway templates.  
 
However, there will likely still be situations where the supplied templates cannot be modified sufficiently to match 
the model and project needs. In these cases, there is an alternative method for modifying the deck templates or 
creating your own.  
 
If the user accesses the deck templates through Utilities > Libraries > Decks, the user can right-click and select 
Copy to duplicate the selected template within that same folder.  
 

 

Figure 6.6-1 Location of Deck Template Library 

 

 

Figure 6.6-2 Copying Deck Templates for Modification 
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The copied template can then be renamed if desired by right-clicking again and selecting Rename. Then the 
copied template can be modified by selecting “Edit Geometry” in the drop-down menu.  
 

 

Figure 6.6-3  Edit the Copied Templates 

 
After Edit Geometry is selected, the Template Creation window will minimize, and the user must left click in an 
open OBM window to open the template for editing and modification. The template geometry will open in the 
selected window as shown in the image below.  
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Figure 6.6-4  Modifying the Template 

 
After the template geometry opens, the common Drawing workflow tools, similar to MicroStation, including Place 
Line, Move, Modify Element, etc., are accessible to update the sketch of the deck template for the project-
specific conditions. Previously drawn cross sections can also be copied and imported into this workflow. 
 
After modifications are made, the new geometry can be imported back as the new template geometry. It is 
important to realize that the completed deck template must be a single closed loop, meaning that there can be no 
gaps or openings in the linework and there cannot be two separate closed loops (i.e., cannot have a single deck 
template for separate EB and WB structures). If the loop is not closed, OBM will warn the user of the error and the 
user will have to modify the template or risk losing changes. 
 

 

Figure 6.6-5  Icon to Import Revised Geometry 
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Workaround: If the original template geometry was modified and not fully deleted, the new template 

geometry may overwrite some of the previous variables and constraints and cause issues with the 

template. If that is the case, the constraints/variables can be deleted/updated or the user can “Edit 

Geometry” to delete and re-draw any problem linework. 

6.6.2 Adding an overlay 

An overlay is a typical detail for rehabilitations and new decks. To model an overlay, the user should add the main 
deck with appropriate template at the proper thickness and add a Vertical Offset to the thickness of the overlay. 
The overlay can then be added by using one of the provided templates and modifying the thickness, or by 
creating a new template for this purpose. The overlay template can then be added as a new deck over the 
previously added main deck. 
 
The user should be aware that the barrier templates may also have to be modified and raised to account for the 
overlay thickness. See Section 6.7.1 for more details on modifying the barrier templates. 

6.6.3 Modifying for final design 

Even though the provided templates will cover the vast majority of typical PennDOT bridge projects, several 
common situations require the user to further refine the model to provide a model consistent with the Digital 
Delivery standards for the Final Plans submission For example, the recent addition of the “Deck Breakback” 
functionality allows for the “squaring off” the deck at the barrier locations in skewed bridges. However, the 
situation shown below in Figure 6.6-6 Refined Deck Element for a Skewed End cannot be replicated with this 
breakback functionality due to the extension of the breakback area. This requires additional editing the deck 
solids which can result in the element losing its status as an OBM deck element and instead being viewed by the 
program as a “Smart Solid.” These new solids retain their level settings and any attached Item Types but lose any 
OBM deck attributes and the ability to parametrically modify the deck through the template variable constraints. 
 

 

Figure 6.6-6 Refined Deck Element for a Skewed End 

 
See Appendix 10.3 for more instructions and details on using the Solids Modeling tools for modifying the deck 
solids for a Refined model element including: 
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• Extract Faces/Edges 

• Extrude Along 

• Difference/Subtract (Boolean Feature) 

• Union/Unite (Boolean Feature) 

6.7 BARRIER/SIDEWALKS 

6.7.1 Options to modify barrier templates 

Similar to the deck templates, the PennDOT specific barrier and sidewalk templates have variables that are the 
primary method for modifying these templates. There should be limited cases in which these barrier and sidewalk 
templates are required to be modified. Typically, the user should be able to place them with the default values. 
Some instances in which the barrier variables may need to be modified are: 

• Light pole blister width change 

• Change in height due to overlay thickness 

• Nonstandard barrier guide rail transitions (currently only possible for vertical wall barriers and curbs) 

• Sidewalk width and height change 
 
The appendix provides typical variable adjustments for reference in the situations noted above. 

6.7.1.1 Model Barriers, Sidewalks, and Decks Separately 

It is recommended for users to model barriers and sidewalks separately from each other and from the deck using 
the supplied PennDOT workspace templates. This follows BD-601M details as a construction joint is shown 
between the elements and allows for specific properties to be maintained between the elements (concrete mix, 
etc.). This is also helpful when exporting the geometry data to LBS and LBC for analysis. The elements can be 
combined during final design, if required, using Solids Modeling tools. 

6.7.2 Modifying for Final Design 

Similar to the deck design, the barriers will also need to be modified for “squared off” interactions at the 
beginning/end of the structures for skewed bridges. Starting in the 2021 R2 release, OBM now has a “End Cut 
Orientation” option in the Place Barrier tool. This allows the user to select if the barrier should be cut with the 
skew or normal to the path or alignment. See Section 5.7 for more information on this functionality.  
 
This option, along with the start and end station offsets, should accommodate most end cut situations for the 
barrier. However, there may still be instances where a process similar to that which is outlined in Section 6.6.3 
must be used. 
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Figure 6.7-1 Barrier End Cut Orientation Option 

 
Barriers also have additional common details that cannot be modeled with the OBM Workflow tools alone. These 
are detailed in the following sections. 
 
See Appendix 10.3 for more instructions and details on using the Solids Modeling tools for modifying the barrier 
solids for a Refined model element including: 

• Extract Faces/Edges 

• Extrude Along 

• Difference/Subtract (Boolean Feature) 

• Union/Unite (Boolean Feature) 

6.7.2.1 Modified Deflection Joints 

Modified Deflection Joints can be added by creating lines at the joint location in plain view and splitting the 
barriers at those joints. This will create separate Smart Solids objects that no longer hold the properties of an 
OBM Barrier object, so users need to check each solid created and make sure any Item Types or other attached 
properties are still present in all solids. After the deflection joints are created, the edges can be chamfered to 
create the V-notch per BC-752M. 

6.7.2.2 Guide Rail Transitions 

Guide rail transitions for F-shaped barriers cannot be modeled with OBM Workflow tools alone. A number of 
standard and typical transitions are provided in the workspace for placement. See Section 3.1.1.1 for list of 
available cells. 
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[This section is under development and will provide a workflow for placing barrier transitions as 3D cells. Content 
will be completed after testing feedback for the Digital Delivery Directive Pilot Projects is incorporated.] 
 
Below is an image of both the Modified Deflection Joints in the span and the F-Shape Barrier Transition at an 
abutment. 
 

 

Figure 6.7-2 Modified Deflection Joint and F-Shape Barrier Transition Example 

6.7.2.3 Railings and Connections 

There may be cases that metal barrier railing and connections of railings, posts, etc. are not efficient to model and 
are more easily conveyed in a 2D detail. However, there are situations for visualization, clash detection, and 
others in which the metal railing and associated components should be modeled. A number of standard and 
typical railing and post elements are provided in the workspace for placement. See Section 3.1.1.1 for list of 
available cells. 
 
Users can create additional cells under the OpenBridge Modeler > Home > Accessory > Place Path tool to 
model the railing shapes. Plates, bolts, and other connection details can be added with the Modeling Workflow 
tools using copy whenever feasible. 
 
An alternative method is to use custom 3D linestyles, but they are difficult to control when post spacings and 
details are not constant along the entire path.  
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6.10 PLACE BEAM – CONCRETE 

6.10.1 Modifying for Beam Daps  

OBM does not have a straightforward approach to modeling beam daps. At this time, beam daps are not typically 
required in the 3D model. If beam daps are required for a project, two approaches can be taken. 1) Complex 3D 
solids modeling to beam ends outside of the OBM workflow. 2) Adjust the height of the bearings to account for the 
dap depth at the center line of the girder, at the center line of bearings.  
 
The recommended approach is to adjust the bearing height to account for the dap, and to add notes and/or 
details in the contract documents to properly convey the beam dap and bearing details to the contractor and 
fabricator. This is critical for all parties to be aware of since the bearing height in the model is not the actual 
bearing height required for design. 
 

  

Figure 6.10-1 Example of Changing Bearing Height to Account for 1/8” Beam DAP  

6.10.2 Modifying for Beam Notches 

A typical detail of prestressed beams in Pennsylvania is the addition of a beam notch or paving notch as shown in 
the Standards for Bridge Design (BDs). A regular 90° notch that might be shown on a bulb tee will be easier to 
model than a notch at a 45° angle that would be detailed on a spread or adjacent box beam. 

6.11 PLACE CONCRETE DIAPHRAGMS 

As previously stated in Section 5.12 Place Concrete Diaphragms, OBM can only generate very basic concrete 
diaphragms with little detail. Advanced diaphragm detailing will require solids modeling. It is recommended that 
the user utilize the OBM workflow tools to their fullest extent before using solids modeling tools. Use the OBM 
workflow tools to place diaphragms with the correct size and location in the framing plan before advancing to 
solids modeling tools.  
 
The OBM workflow can model the common diaphragms that cover many situations. For example, in the image 
below, OBM workflow tools were used to create a diaphragm in the size and location required for design. The 
user needs to be aware that it is recommended to generate all the diaphragms individually and not create one 
diaphragm across the entire bridge width. If a higher Level of Detail is required than what can be obtained from 
using the OBM workflow, the user should use solids modeling tools. 
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Figure 6.11-1 Input For Diaphragms Modeled Across the Entire Width (Beam-L to Beam-R) 

 
 

 

Figure 6.11-2 Diaphragm Modeled Across the Entire Width 
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Figure 6.11-3 Input For Diaphragms Modeled Individually 

 

 

Figure 6.11-4 Diaphragm Modeled Individually 

6.16 PLACE ABUTMENT 

6.16.1 Integral Abutment Modifications 

The Place Abutment Tool provides a template for integral abutments that can be used for most of the required 
detail as shown in BD-667M. The pile placement tool can add a single row of piles, the Pile Cap template type 
works for the simple geometry of the cap beam, the backwall feature can be used to generate an end diaphragm, 
and the wingwall geometry can also mostly be accommodated.  
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However, several additional modifications are needed for Final Design Element Detail Designation that will require 
solids modeling to create a Refined element. Below are the typical steps for creating a Refined integral abutment 
element. 

6.16.1.1 Chamfers at Attached Wing Connections 

The BD-667M details require a chamfer in the end diaphragm and cap beam in plan view for attached rectangular 
and attached tapered wingwalls. 
 

 

Figure 6.16-1 Plan View of Integral Abutment with Chamfers at Attached Wings from BD-667M 

 
Then the user can create the necessary linework for the chamfer and create an extrusion to the desired height 
(see Section 10.3.3 for more details and guidance).  
 

 

Figure 6.16-2 Integral Abutment Chamfer Extruded for an Attached Wingwall  
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After the chamfers are created, the items can be combined with the Union tool (see Section 10.3.8 for more 
details and guidance).  
 
The “lug” at the detached wing configuration can be created using a similar process. 
 

 

Figure 6.16-3 Plan View of Integral Abutment Detached Wing “Lug” from BD-667M 

 

6.16.1.2 Construction Joints Between Beam Cap and End Diaphragm 

The construction joint is required in between the beam cap and the end diaphragm to separate these elements 
and apply the different concrete materials needed. The user can essentially draw or imprint directly on the solids 
in order to split the solids as required to create the Refined elements. This process should be continued through 
the attached wings as well per BD-667M. More details and guidance for using these tools are in Sections 10.3.2, 
10.3.9, and 10.3.11.  
 

 

Figure 6.16-4 Adding the Construction Joint Linework Between the Beam Cap and Diaphragm  
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Figure 6.16-5 Example of Completed Construction Joint of Integral Abutment (with Cap Extension) 

6.17 PLACE CUSTOM ABUTMENT 

[This section is under development. Content will be completed after BD-621M abutment workflow is finalized 
through development and Digital Delivery Directive 2025 Pilot Project feedback.] 
 

6.18 PLACE CUSTOM WINGWALL 

6.18.1 Wingwall Construction Joints 

Wingwalls with construction joints can be detailed in OBM using the 3D modeling tools. To begin, the wingwall, 
with or without the abutment, should be referenced into a new model and merged into master as detailed in 
Section 3.4.2. Using 3D modeling techniques as outlined in Chapter 10, a cutting element should be created at 
the location of the construction joint.  
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Figure 6.18-1 Cut Solids tool – Cutting profile selected 

 
Finally, the Cut Tool should be used as shown in Section 10.3.11 to split the wingwall into separate pieces. 
 

 

Figure 6.18-2 Wingwall after splitting operation 

 

6.20 PLACE CUSTOM PIER 

[This section is under development. Content will be completed after the custom substructure workflow is finalized 
through development and Digital Delivery Directive 2025 Pilot Project feedback.] 

6.21 PLACE BEARING 

6.21.1 Modifying pad depth to account for beam daps 

In lieu of modifying the bottom of beam ends for a DAP, the user can adjust the bearing pad height to model the 
correct bearing seat elevations in the model. Refer to Section 6.10.1 for more details and information. 
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Figure 6.21-1 Modifying Bearing Pad Height 

6.21.2 Adding anchor bolts and other bearing features as a cell 

Bearings that are not elastomeric bearing pads, such as Multirotational, Pot, Sliding, and Disc, can be placed in 
OBM. These bearings are created in MicroStation and placed in OBM as a cell. There are a few bearing cells 
included with OBM by default. 
 

 

Figure 6.21-2 Selecting Bearing Type 
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Figure 6.21-3 Selecting Bearing Cell 

 
 

 

Figure 6.21-4 Multirotational Bearing Underneath Beam 

6.21.3 Placing Multiple Bearing Pads 

OBM can be used to define more than one bearing at a beam end. To define more than one bearing (which is 
default) navigate to the Beam Layout window and check the Advanced Bearing Definition box. Bearings are 
placed in the same fashion as a single bearing. OBM will place two of the defined bearings under each beam end. 
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Figure 6.21-5 Advanced Bearing Definition 

 
 

 

Figure 6.21-6 Placing Bearings 
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Figure 6.21-7 Two Neoprene Bearing Pads Under Spread Box Beam (not showing end block) 
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6.24 ADDING REINFORCEMENT 

Basic tools are provided in OBM that apply to most concrete elements generated in the OBM model. However, 
there may be some elements of the model that are outside of the capability of these tools and require advanced 
rebar detailing.  
 
Below is an example of one way to model barrier reinforcement using some of the advanced OBM tools. As 
previously stated, there is more than one way to come to the same conclusion, and this is an example of one user 
approach. 

6.24.1 Barrier Rebar Modeling Using the Associative Extraction Tools 

 

Figure 6.24-1 42” Vertical Wall Concrete Barrier  

 
The user can start by using the Associative Extraction tool to create planes that represent the clearances 
required for rebar detailing. This gives the user framework to start creating the rebar modeling. 
 

 

Figure 6.24-2  Associative Extraction Tool 
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Figure 6.24-3 Barrier Faces Extracted 2” To Create Clearance 

 
After the faces have been extracted, the Associative Intersection tool can be used to create an intersecting 
edge between two associative faces. 
 

 

Figure 6.24-4 Associative Intersection Tool 

 
 

 

Figure 6.24-5 Associative Intersection Tool Creating Edge for Rebar Detailing 
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Figure 6.24-6 Intersection of Clearances – Intersecting Point Is 2” Clear From All Faces  

 
One tool that can be used to place rebar is the Single Rebar Distribution tool. This tool uses two elements 
created by the user in 2D linework to generate the rebar set. The first element created by the user is the Bar 
Properties. For our example, this will be the complex chain that defines the shape of the barrier rebar. The 
second element is the Distribution Line which defines the path that the rebar will follow. First, the user must 
Select Concrete member that contains the rebar members then define the Bar Properties and Distribution 
Line and any additional design and project-specific constraints. 
 

 

Figure 6.24-7  Single Rebar Distribution Tool 
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Figure 6.24-8 Single Rebar Distribution Inputs 

 

 

Figure 6.24-9 42” Vertical Wall Barrier Reinforcement 

 
This process can be repeated for additional reinforcement until all reinforcement is detailed.  
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Figure 6.24-10 Fully Detailed 42” Vertical Wall Barrier Reinforcement 

 
The Slab Reinforcing tool does not currently have the ability to deal with the cross slope of the deck. Therefore, 
most decks need to be modeled using some of the advanced ProStructures reinforcement tools. As previously 
stated, there is more than one way to come to the same conclusion, and this is an example of one user approach. 
 
The rebar should be modeled in its own .dgn. This allows for easier level display management later when the 
entire model is fully populated with rebar.It also allows for advantages when adding bar marks and scheduling. 
See Section 6.24.8 for more information. 

6.24.2 Deck Rebar Modeling Using the Single Rebar Distribution Tool Using Guidelines 

As a starting point, copy the bridge model .dgn. Delete everything in the model except the geometry for the deck. 
This is done to ensure when modeling rebar no changes are accidently made to the geometry of the original deck 
element. If changes are needed to the geometry of the deck element, the user will have to adjust the geometry in 
the file the deck was created. Keeping the deck and rebar in separate files also helps with level control. Next 
create a large box that runs orthogonal to the alignment and envelopes the entire cross section of the deck 
geometry. Then use the Difference Feature tool in the Booleans Tools drop down to subtract the larger cut box 
from the deck geometry. After this step the rest of the bridge model can be deleted from the Explorer window. 
Then reference in the original bridge model that was previously copied. It will be used when populating rebar later 
in the process. The reference can be turned off until needed later. 
 

 

Figure 6.24-11 Boolean Tools > Difference Feature Tool 
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Figure 6.24-12 Before and After Boolean Operation 

What’s left is an accurate cross section of the deck normal to the alignment. This will be used as a template to 
draw the control lines that place the deck rebar. The reinforcement in the deck is aligned according to the bridge 
skew angle per BD-660M. This this case the transverse rebar runs parallel to the top of the deck and 
perpendicular to the alignment, so the first step is to trace the top of the deck with the Shape Guideline using the 
Smart Line tool.  
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Figure 6.24-13 Shape Guideline Created with Smart Line Tool 

 
The next step considers the clear cover on the sides of the deck. This is taken into account by extending/trimming 
the ends of the Shape Guideline closest to the edge of deck. In plan view Trim Lines are drawn. Trim Lines are 
sacrificial lines that will be deleted after using them to trim Guidelines. The lines are placed along the outside 
edge of each side of the deck. 
 
These Trim Lines are then moved with the Move/Copy Parallel tool from the top view to place them at the correct 
clear cover distance away from the edge of the deck. These lines are then used to trim/extend the top deck 
transverse rebar Shape Guideline to the appropriate stopping point using the Trim Multiple tool while in the top 
view. Once this is done, the Shape Guideline accurately represents a single transverse rebar at the correct 
vertical and horizontal location with respect to the cross section. 
 

 

Figure 6.24-14 Move Parallel Tool Used from the Top View for Side Cover 
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Figure 6.24-15 Before/After Extending the Shape Guideline to Side Cover Trim Line 

 
Next step is drawing the Distribution Guideline that sets the path for the spacing and overall length of the rebar 
set. First a line can be drawn along the crown of the deck and extended beyond the limits of the referenced full 
deck geometry using the Extend Line tool. Then this line needs to be moved to connect with the end of the 
Shape Guideline that was previously created. Next the Distribution Guideline needs to be trimmed to represent 
the portion of the deck it will cover. In this example the deck is skewed. The full width transverse rebar will run a 
portion of the deck before reaching the skewed end of the bridge. This length also needs to consider the 
begin/end of deck clear cover. This is determined by drawing a line perpendicular to the alignment of the bridge at 
the point where the side clear cover cut line and the begin/end of bridge clear cover cut line intersect. Each corner 
needs a perpendicular line that extends beyond the opposite side of the deck. 
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Figure 6.24-16 Side & Begin/End Cover Line with Alignment Cut Line 

Then two perpendicular cut lines are used to trim the Distribution Guideline that is attached to the end of the 
Shape Guideline. 
 

 

Figure 6.24-17 Trim Multiple Tool from Top View with Red Cut Lines & Green –Guidelines 
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Next the Shape Guideline is moved to the end of the distribution control line. Mainly this is done to keep the file 
organized in case changes need to be made further along in the rebar modeling process. 
 
Finally, the rebar is modeled using the Single Rebar Distribution tool. Once the tool dialog is open there are 
three steps to creating the rebar: 

1. The deck from the referenced OBM bridge model is input into Select Concrete button.  
2. The Shape Guideline is input into the Create bar by object button in the Properties dialog 
3. The Distribution Guideline is input into Select path by object button in the Distribution dialog. The 

inputs into the rebar can be modified by double clicking the rebar, making changes, and clicking 
the green checkmark to accept the changes. 

 

 

Figure 6.24-18 White – Referenced Deck Geometry, Green - Shape & Distribution Guidelines 

The End conditions tab allows the setting of the end condition of the rebar. This example will be using Hook as 
the end condition, but other end conditions such as 90° and 135° bends are also available. A rotation and 
extension of the hook can be implemented here if required. The assignment tab allows for the selection of the 
level the rebar will be placed. Click the green check mark to accept the rebar placement. Note that the lines 
themselves control the shape of the rebar even after placement. Care needs to be taken to not move, delete or 
alter the lines as the rebar will follow the Guidelines. 
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Figure 6.24-19 Hook End Condition in the Single Rebar Distribution tool 

 

 

Figure 6.24-20 Transverse Rebar Modeled 
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6.24.3 Vertex Method of the Irregular Dispatch Reinforcing Tool 

The next steps will be using the same tools for longitudinal reinforcement and then modeling the bottom 
transverse and longitudinal rebar in a similar fashion.  For skewed bridges the next step will be adding rebar with 
variable lengths to the skewed end of the bridge. This will be done using the vertex method of the Irregular 
Dispatch Reinforcing tool. 
 

 

Figure 6.24-21  Irregular Dispatch Reinforcing Tool 

 
First the Shape Guideline and Distribution Guideline from the first set of rebar (created in 6.24.2 Deck Rebar 
Modeling Using the Single Rebar Distribution Tool Using Guidelines) needs to be copied to the skewed portion. 
Then both lines need to be moved one rebar spacing further towards the start of the bridge along the Distribution 
Control line (which runs parallel to the alignment). In this example the rebar spacing is 5 1/2”. 
 
Next the Shape Guideline needs to be copied multiple times along the Distribution Guideline at the required 
design spacing until the end of the deck. Then a cut line is drawn along the end of the deck. Next use the 
Move/Copy Parallel tool from the top view to account for the clear cover on the end of the bridge. Then use the 
Trim Multiple tool from the top view to shorten the Shape Guidelines along the end/start of the deck. 
 

 

Figure 6.24-22 Various Guidelines Needed When Adding Skewed End Bars 
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Figure 6.24-23 Before/After Skewed Shape Guidelines Trimmed using the Trim Multiple Tool 

 
There will be two types of Shape Guidelines after this cut is made. One type will include a vertex at the crown for 
a total of 3 points and the other will be passed the point of the crown and only have 2.  
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Figure 6.24-24 Green – Placed Rebar, Magenta – Three Vertex Lines, Yellow – Two Vertex Lines 

 
The vertex method of the Irregular Dispatch Reinforcing tool requires that all Vertex Guidelines have the same 
number of points. Therefore, two different sets of rebar will need to be created for this portion of the deck. 
 
The process for creating the Vertex Control lines is by drawing a smart line along each vertex of the Shape 
Control Line rebar running parallel to the alignment. The result will be three Smart Lines with the same number of 
vertexes. 
 
 



Chapter 6  Advanced Input Description 
 

6-33 

 

Figure 6.24-25 Blue – 3 Selected Smart Lines with Same Number of Points 

 
Next the Irregular Dispatch Reinforcing tool is used to create the rebar. Choose the designed bar size, strength 
and select Vertex for the Dispatch Method in the Irregular Dispatch Reinforcing window. Next select the 
referenced deck geometry for the Select Concrete button and then select the three Vertex Guidelines for the 
Select Guidelines button. An end condition can also be added in the End conditions tab. 
 

 

Figure 6.24-26 Irregular Dispatch Reinforcing Tool Dialog Box 
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The result will be a set of rebar that are controlled by the vertexes of the lines. This process can be repeated for 
the last section of top transverse rebar but only using two Vertex Guidelines instead of three. 
 

 

Figure 6.24-27 Skewed End of Bridge Reinforcement 

This same vertex method can be utilized for the longitudinal reinforcement. The Shape Guideline will run along 
the alignment. The Vertex Guideline will run along the skewed top of deck. Then the lines will need to be moved 
down vertically to avoid the top clear cover and the transverse reinforcement. Subsequently the lines will need to 
be trimmed/extended with the clear cover cut lines at the start/end of the bridge and each side. Then the Vertex 
Guideline will be copied to the end of the Shape Guideline at the other end of the bridge. 
 

 

Figure 6.24-28 Blue – Selected Vertex Guidelines 

 



Chapter 6  Advanced Input Description 
 

6-35 

Then these Vertex Guidelines with 3 points on them will be used for the vertex method of the Irregular Dispatch 
Tool. 
 

Note: Since the spacing of the rebar is based a skewed line, the spacing for the longitudinal reinforcement 
will need to be adjusted in accordance with the skew of the project. In most situations the spacing of the 

deck rebar is measured perpendicular to the alignment and not along the skew.  
 

 

Figure 6.24-29 Corner of Deck Showing Modeled Top Rebar 

6.24.4 Substructure Reinforcement Modeling 

The built-in footing reinforcement tool does not currently have the ability to deal with non-orthogonal footings. It 
also does not have the ability to deal with the variable spacing needed to deal with modeling footing rebar around 
embedded piles of any shape.  
 
Similar to the deck reinforcement the substructure can be reinforced with the Single Rebar Distribution tool and 
the Irregular Dispatch Reinforcing tool. The process works the same way. Make a Boolean difference cut in the 
geometry that is normal to the cross section of the concrete to be reinforced. Draw out Shape Guidelines 
considering clear cover to the edges of the concrete and the thickness of the rebar. Then draw out Distribution 
Guidelines to control the spacing of the rebar into and out of the cross section. Then these Guidelines are used in 
the Irregular Dispatch Reinforcing tool to create the rebar.  
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Figure 6.24-30 Substructure Boolean Difference 

 

Figure 6.24-31 Substructure Cross Section, Red – Clear Cover Lines, Yellow – Shape Guidelines  
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Figure 6.24-32 Substructure Cross Section with Placed Reinforcement Inside Cover Lines 

 

Figure 6.24-33 Reinforced Substructure Concrete 

6.24.5 Modeling Splices and Phase Lines 

If a structural element is wider or longer than the acceptable rebar length, then splices will need to be added to 
the reinforcement. 
 
One method for splice creation is modeling another set of reinforcement. Follow the steps for the creation of the 
Guidelines in the Single Rebar Distribution section. Then a copy of the Shape Guideline would be made and then 
moved one rebar thickness along the Distribution Control Line (which is parallel to the alignment). This is so the 
Shape Guidelines for the modeled rebar will not overlap. Then a line would be drawn parallel to the alignment at 
the point where the splice would be centered. Then this line would be offset using the Move/Copy Parallel tool 
(with the copy toggle turned on) a distance half of the required spliced in each direction. 
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Figure 6.24-34 Splice Guideline Along Alignment with Move/Copy Parallel Tool Used in Top View 

 
Then each of the Shape Guidelines would be trimmed using the Trim Multiple tool leaving a shortened Guideline 
for each side of the spliced rebar. The next step would be creating rebar from the trimmed lines using the Single 
Rebar Distribution tool. 
 

 

Figure 6.24-35 Trim Multiple Tool to Shorten Shape Guidelines 
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Figure 6.24-36 Transverse Deck Reinforcement Spliced in the Center 

If there are phases on the bridge, then the Shape Guidelines will need to be further divided along the phase lines 
and more sets of rebar will need to be modeled. There is also an end condition that allows for the end of the rebar 
to be modeled as a mechanical coupler along the phase line if required by the project. The process for this will be 
similar to the splicing. 

6.24.6 Tapered Deck Reinforcement Modeling 

Tapered decks require a further level of refinement from decks with a constant width. In a tapered deck situation, 
the transverse reinforcement will need to modeled using the Irregular Dispatch tool. 

6.24.7 Curved Deck Reinforcement Modeling 

Curvature in either the horizontal or vertical direction will need some more specialized tools and methods for rebar 
modeling.  
 
Modeling the transverse reinforcement in a curved deck will start by making a SmartSolid copy of the deck 
geometry into the rebar OBM file.. The next step will be using the Extract Faces/Edges tool to make copies of 
the surfaces that represent the outside edge of deck and the top of deck underneath the barrier. This tool is 
located in the Modeling > Solids > Solid Utilities.  
 

 

Figure 6.24-37 Extract Faces/Edges Tool 
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Figure 6.24-38 Using the Extract Faces/Edges Tool on Deck Geometry SmartSolid 

 
Next the Offset Surface tool is used to move the faces inward to properly account for the clear cover and half the 
thickness of the bar for each surface as the Guideline runs down the center of the rebar. Modeling > Surfaces > 
Offset Surface 
 

 

Figure 6.24-39 Offset Surface Tool 

 

 

Figure 6.24-40 Offset Surface Tool on Extracted Deck Faces for Cover and Rebar Thickness 
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Next the Compute Intersections tool is used to create a Spline that represent the intersection of these two 
planes. This spline will be used as one of the Irregular Dispatch Distribution Guidelines for the transverse 
rebar. Modeling > Surfaces > Compute Surface > Intersections 
 

 

Figure 6.24-41 Compute Intersections Tool 

 

Figure 6.24-42 Compute Intersections Tool to Create Spline for Distribution Guideline 

 
This process will be replicated on the other side curved deck underneath the opposite barrier. The next step will 
be creating the Distribution Guidelines at the gutter lines and at the crown. This will be done using the Extract 
Faces/Edges tool at the each of the gutter lines and at the crown. Then these lines will need to be moved 
vertically to account for the clear cover on the top of the deck and the thickness of the rebar. 
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Figure 6.24-43 Extract Faces/Edges Tool to Create Spline for Distribution Guideline 

The example curved bridge has a standard cross slope in each direction from the crown. If there are more cross 
slope transitions in a bridge deck, more Distribution Guidelines will need to be extracted. 
 

 

Figure 6.24-44 White – Bridge Deck Geometry, Green – 5 Distribution Guidelines 

Next the Irregular Dispatch Reinforcing tool will be used to create the transverse reinforcement. This time the 
Dispatch Method will be Spacing. The referenced concrete deck geometry from the OBM model will be selected 
for the Select Concrete button. The 5 Distribution Control Lines will be selected for the Select Guideline(s) 
button. The Distribution Guidelines need to be selected from one end of the deck to the other for the tool to work 
correctly. Bends at the end of the bar can be set in the End Condition tab. The level can be set in the Assignment 
tab. 

 
Note: In this example instead of trimming the start and end of the Distribution Guidelines to account for 
the start/end of deck clear cover the Start/End Offset was used to accomplish this offset. This is an effort 

to illustrate that there are many ways to accomplish the same thing in OpenBridge Modeler. 
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Figure 6.24-45 Irregular Dispatch Reinforcing Tool Using Dispatch Method of Spacing 

Next the longitudinal reinforcement will be modeled. A copied SmartSolid will be used as a starting point to pull 
reference information from. First the Extract Faces/Edges tool will be used to create a spline element along the 
crown of the roadway. Next this spline will be used to subdivide the deck geometry SmartSolid using the 
Associative Slice tool. This tool is located in the ProStructures workflow and the Home tab. The deck geometry 
will be selected as the Select solid to be sliced prompt and the ProConcrete > Home > Face Based Rebar > 
Associative Slice is then selected. 
 

 

Figure 6.24-46 Associative Slice Tool 
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Figure 6.24-47 Deck Subdivision with Associative Slice Tool 
 

 
Note: In this example the deck was divided into 10 parts. This number will need to vary depending on the 
complexity of the vertical/horizontal curvature and/or an increased length of the bridge deck being 

reinforced. 
 
Next smart lines will be drawn along the top of each of these subdivisions. There will be vertices at the edge of 
the top of deck before the chamfer, the gutter line, and along the crown for a total of 5 in this example. These 
SmartLines will be the Distribution Guidelines for the Irregular Dispatch tool. Then these Distribution Guidelines 
will be moved vertically to avoid conflicts with the top of deck clear cover and the transverse reinforcement.  
 
Now these Distribution Guidelines will be used in the Irregular Dispatch tool. The referenced bridge deck 
geometry will be selected for the Select Concrete button. The Distribution Guidelines will be selected for the 
Select Guideline(s) button. The Distribution Guidelines need to be selected from one end of the deck to the other 
to work properly. Next each of the lines except the start and end Distribution Guidelines needs to be right clicked 
and set to Make Arc Intermediate Point. This modification changes the rebar from being straight sections of 
rebar along the Guidelines to being curved rebar that more accurately follow the curvatures of the deck. Again this 
example utilizes the start and end offset to account for the side clear cover instead of trimming the Guidelines. 
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Figure 6.24-48 10 Selected Vertex Guidelines Each with 5 Vertices 
 

 
 

Figure 6.24-49 Changing 3D Line Strings in Irregular Dispatch Reinforcing Tool 
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Figure 6.24-50 Transverse and Longitudinal Reinforcement in a Curved Deck 
 

6.24.8 Adding Bar Marks and Scheduling Rebar  

[This section is under development. Content will be added after necessary updates in the software and Digital 
Delivery Directive 2025 Pilot Project feedback is incorporated.] 
 

6.25 ADDING ATTRIBUTES 

[This section is under development. Content will be added after PennDOT Item Type list development is complete 
and Digital Delivery Directive 2025 Pilot Project feedback is incorporated.] 
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 OUTPUT DESCRIPTION 

7.1 REPORTS 

There are several built-in reporting options in OBM. The more common and useful are listed below. In addition to 
the reports highlighted, there may be uses for the additional reports, especially for QA/QC processes, and the 
user should investigate the tools and the Bentley Help Content for more information. 
 
The reports can be exported to many common formats including xlsx, csv, txt, and pdf. and can be integrated and 
combined with other design information as part of additions to drawings, calculation packages, and digital 
deliverables. 
 

Note: These reporting tools are based only from OBM recognized elements (OBM decks, OBM 
abutments, etc.). As soon as these elements are modified and no longer retain their OBM-element status, 
the results from these reports may not be available or they may report erroneous information. All 
information and data generated from these tools are to be verified by the user. 

7.1.1 Updating Design File Settings for Reports 

The reporting tools will automatically use the Design File Settings which are typically consistent with the seed file 
settings. However, the user can change the Design File Settings to generate the desired formats for certain 
reports. For example, the accuracy can be changed to two decimal places for elevation reports.  
 
The Design File Settings are accessed from File > Settings > File > Design File Settings. 
 

 

Figure 7.1-1  Changing Design File Settings for Reports 
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7.1.2 Deck Elevations 

Several elevation reports can be generated with OBM. The first is the Deck Elevations Report located in the 
Reports and Drawings > Bridge Reporting. This is a helpful report that will generate the top of deck elevations 
based on parameters input by the user. The first prompt after selecting this report is to select the start and end 
SupportLines for the deck elevations. The reporting tool can only use the active bridge unit, so if there are multiple 
units or bridges in the same file, separate reports will be needed. After the SupportLines are selected, the Deck 
Elevation Report dialog box becomes visible.  
 

 

Figure 7.1-2  Deck Elevation Report Tool Location 

 
Below are the inputs and parameters the user can modify and a detailed description of each. 
 

 

Figure 7.1-3 Deck Elevation Report Dialog Box 

 
Solid Red Box – This section includes inputs for the Report Name and Start & End SupportLines and Offsets. 
This can be used to modify the SupportLines selections and to choose a starting point different from the 
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SupportLines. SupportLines are typically at the centerline of bearings and start and end of approach slabs, and 
the “Offsets” input can be used to start before or after these points (positive or negative inputs). 
 
Dashed Red Box – These inputs provide additional reporting variables 
and formatting. The Transversal Lines input allows for points reported 
normal to the alignment or along the SupportLine skew. The number of 
elevations generated can be entered as points per span or an equal 
spacing between the start and end points. Additionally, the Report 
Type offers several formats and reporting options including the typical station, offset, and elevations; x,y,z 
coordinates; and a consolidated report option. The Individual Paths checkbox is only to be used for flared decks 
or splayed beam framing plans. For PennDOT projects, both the points per span and the spacing (10 ft intervals) 
are utilized per DM-4 PP 1.6.4.11(e), and the Report Type is set to Consolidated. 
 
Solid Green Box – This selection input for Common References allows the user to select specific template points 
to report the deck elevations. The inputs include the alignments, deck edges, barriers (curb), and beam 
centerlines. Offsets can be added to any of these points to capture additional points such as beam flange edges 
as commonly done for PennDOT projects. Select the checkboxes for the desired points to include them in the 
report. For PennDOT projects, at least two reports are required to capture all desired points for the 10’ intervals 
and the 10th points of girders. If additional offsets are needed (i.e., left and right beam flange tips), additional 
reports are required. 
 

Tips and Tricks: To have elevations reported at exact round stations, at 10ft intervals, offsets from the 
start and end SupportLines are likely required. 

 
Dashed Green Box – The Accessories input allows the user to select additional elements in the model to include 
in the deck elevation report. This input is not commonly used for typical bridges. (FDOT, 2022) 
 
The resulting report is generated in the Print Preview window. The window used to select the SupportLines will 
also show the preview of the elevation points with orange circles.  
 

 

Figure 7.1-4  Preview of deck elevations along girder 10th points; locations indicated with orange circles. 
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The Print Preview window contains several formatting options including scaling the report document size, margin 
size and the page orientation. 
 

 

Figure 7.1-5  Report Preview Window 

The reports can then be exported to a PDF, Excel, text, or another file format for further consolidation and 
modifications for adding to the bridge plans or for digital delivery per the Modeling Standard documents. 
 

 

Figure 7.1-6  Export Report File Format options 

Note: Initially, when a report is exported from the Preview Window, it must be saved on to a local drive. 
Afterwards, the file may be uploaded to ProjectWise or another document management system as 
required. As of the writing of this manual, exported files cannot be directly saved to a ProjectWise 
directory. 
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7.1.3 Bearing Seat Elevations 

Another useful reporting tool is the Bearing Seat Elevation Report.  
 

 

Figure 7.1-7 Bearing Seat Report Tool Location 

 
The bearing seat elevation for each beam at each bearing line, as well as information for beveled plates, can be 
obtained via the ‘Bearing Seats and Grout Pads or Bevel Plates Report’.  
 
For a project where prestressed concrete beams will utilize a beam end dap to accommodate differential slope 
between the bottom of the beam and the bearing seat, the user needs to check and confirm the reported bearing 
seat elevations. As discussed previously in Section 6.10.1, OBM does not currently have the functionality to 
directly model beam end daps. The user must manually manipulate the bearing height to account for the dap 
thickness. See Section 6.21.1 for more details. 
 

 

Figure 7.1-8 Example of Bearing Seat Report Output 

 
This report is beneficial but only provides the elevation at the intersection of the centerline of beam and the 
centerline of bearing. If the bearing seat is level, then this elevation will apply to the entire bearing seat surface. 
However, the software currently does not have the capability of reporting out the corner elevations of a sloped 
bearing seat. The Bearing Seat Report output could be exported into a separate software package, such as 
Microsoft Excel, to use as a starting point for computing corner elevations of a sloped bearing seat. 

7.1.4 Quantities 

The Quantities Report tool divides the quantities for superstructure, substructure, and miscellaneous categories. 
Unit costs can also be input into the Material Library to provide preliminary cost estimates for the bridge 
elements. 
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Figure 7.1-9 Editing Material Unit Prices 

 

 

Figure 7.1-10  Quantities Report Tool Location 
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Figure 7.1-11  Example of Quantities Report for a Prestressed Superstructure (no unit costs provided) 

 
After the “Submit” button is clicked, the results are visible. Values from this report only reflect the OBM recognized 
solids. Any changes to elements that have been made outside of the OBM specific tools (i.e., beyond the Base 
model), will not be reflected in these reports. Therefore, the reports will likely have the most use in preliminary 
design, and the user should verify all output.  

7.1.4.1.1 Quantities by Element Property 

An alternate method for obtaining quantities from the model is selecting specific element properties. This is a 
more robust and flexible method as any solid or surface element can be selected, and the volume and surface 
area will be visible as a property. When selecting an OBM element, ensure that the individual components are 
selected (footings, walls, etc.), and the volume will be reported under the Solid category. 
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Figure 7.1-12  Example of Volume Quantities from Element Properties 

 
This method will provide volumes and surface areas for any solid or surface, including elements that have been 
modified in the Refined model condition. 

7.2 DRAWINGS 

When setting up views, annotating, and creating drawings, the user should switch to the Drawing Workflow, 
unless noted otherwise. There are multiple ways to create views for drawings. In all cases, a 2D drawing is 
created from the model where an annotation scale is selected, and annotations are applied. The 2D model can 
then be referenced into a 2D sheet model where the titleblock and border can be attached. The user can decide 
which method of creating views is appropriate for their specific situation and can adjust annotation scale 
dynamically. 
 

 

Figure 7.2-1 Selecting Drawing Workflow 
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7.2.1 Plan Views 

Plan views can be created using several methods. The recommended method is to utilize the Place Named 
Boundary tool. The other method for setting up plan views is the Place Plan Callout. 

7.2.1.1 Place Named Boundary 

The Place Named Boundary tool can be found in the Named Boundaries Panel of the View Tab (View Named 
Boundaries > Place Named Boundary). 
 

 

Figure 7.2-2 Place Named Boundary Tool 

 
After selecting Place Named Boundary, the user may create the named boundary by several methods including 
Civil Plan, Civil Plan by Element, By Element, 2-points, Polygon or Length. 
 

 

Figure 7.2-3 Place Named Boundary Dialog 

 
Any of the included options within the Place Named Boundary tool can be used to create named boundaries, 
each offering different levels of control over the view extents and how they are modified. The most controlled 
named boundary for a standard plan view is the Civil Plan. This method allows the named boundary to be 
controlled by a Start Locations and a Stop Location and/or a Length after an alignment is selected. If the Start 
and Stop Locations are defined for the view, but the length is too long to see clearly on a single sheet or a 
different scale is desired, the user can define a Length and an Overlap value to place multiple named boundaries 
along the alignment to split the plan views up onto separate sheets. 

7.2.1.2 Place Plan View Callout 

The Place Plan Callout tool can be found in the Detailing panel under the Annotate tab (Drawing Workflow > 
Annotate > Detailing > Place Plan Callout). This tool is similar to the Place Section Callout tool, except can 
only be placed in a front, back, or side view with the section pointing down (towards Z=0) to create a plan view.  
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Figure 7.2-4 Place Plan Callout Tool 

 
When the Place Plan Callout is activated, the user must be in a front, back, or side view and pick Point 1 at the 
beginning of the plan view limits, pick Point 2 at the end of the plan view limits, and move the cursor down to the 
desired depth of the clip volume then click Point 3.  
 

Note: if the ACS is not set up with the X plane parallel to the alignment, the Y plane perpendicular to the 
alignment and the Z plane truly vertical, as discussed in Section 4, the plan view will be skewed and will 
not display correctly. 

 

 

Figure 7.2-5 Placing Plan Callout  

 
After placing the Plan Callout, a dialog appears to set up the drawing and the sheet. First, the user will name the 
plan view drawing and select the Drawing Seed file. Then the user will ensure the Create Drawing Model box is 
checked and set a desired annotation scale. This annotation scale can be modified in the drawing model after it is 
created using the Annotation Scale dropdown in the Utilities Tab (Utilities > Drawing Scale > Annotation 
Scale). The user can select whether the visible edges are dynamic or cached, which determines if the references 
are updated automatically (dynamic) or updated manually (cached). It is at the user’s discretion to set up a sheet 
at this time or a sheet can be created later, and the drawings/views referenced into it. 
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Figure 7.2-6  Place Plan Callout Dialog 

 

 

Figure 7.2-7 Plan Drawing displaying ACS Misalignment 

7.2.2 Elevation Views 

Elevation views can be developed with ease using OBM’s Elevation Callout tool.  
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Figure 7.2-8 Elevation Callout Tool Location 

 
When the Elevation Callout tool is activated, an elevation parameter dialog box will prompt the user to select the 
Drawing Seed and the Height. The user must be in a top view and will pick Point 1 to place where the elevation 
view is located. The user will notice the elevation callout is placed and rotating freely with the position of the 
cursor. The user will then pick Point 2 to set the direction of the elevation view. 
 

 

Figure 7.2-9 Placing Elevation Callout  

 
Just like the Plan Callout tool, after placing the Elevation Callout, a dialog appears to set up the drawing and 
the sheet. First, the user will name the plan view drawing and select the Drawing Seed file. Then the user will 
ensure the Create Drawing Model box is checked and set a desired annotation scale. This annotation scale can 
be modified in the drawing model after it is created. The user can select whether the visible edges are dynamic or 
cached. It is at the user’s discretion to set up a sheet at this time or a sheet can be created later, and the 
drawings/views referenced into it. 
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Figure 7.2-10 Place Elevation Callout Dialog 

 

 

Figure 7.2-11 Elevation Drawing Model 

7.2.3 Section Views 

Section Views can be created in a couple of ways, depending on what the user wishes to achieve from the 
section. If the user is interested in developing a typical section of the bridge superstructure, the user can navigate 
to Analysis and Reporting > Drawings > Create Superstructure Cross-section Drawing tool in the 
OpenBridge Modeler Workflow. If the goal is to show a section at a specific location for a detail, such as a barrier 
section, wingwall section, cross frame view, etc., the Place Section Callout tool is recommended. 
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7.2.3.1 Create Superstructure Cross-section Drawing 

 

Figure 7.2-12 Create Superstructure Cross-section Drawing Tool 

 
 
When executed, the user selects the alignment, sets a station, and moves the cursor to define the width of the 
section. When the cursor is moved to the left of the alignment, looking stations ahead, the direction of the section 
is looking stations back. When the cursor is moved to the right of the alignment, looking stations ahead, the 
section is cut looking stations ahead, as indicated by the blue arrow. 
 

 

Figure 7.2-13 Creating Superstructure Cross-section Drawing  

 
Just like the Plan and Elevation Callout tools, after placing the Superstructure Cross-section, a dialog appears to 
set up the drawing and the sheet. First, the user will name the cross section drawing and select the Drawing 
Seed file. Then the user will ensure the Create Drawing Model box is checked and set a desired annotation 
scale. This annotation scale can be modified in the drawing model after it is created. The user can then select 
whether the visible edges are dynamic or cached. It is at the user’s discretion to set up a sheet at this time or a 
sheet can be created later, and the drawings/views referenced into it.  
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Figure 7.2-14 Create Superstructure Cross-section Dialog 

7.2.3.2 Place Section Callout 

The Place Section Callout is in the Drawing Workflow > Annotate > Detailing Panel. Sections can be created 
from any view perspective and the limits of the section adjusted at any time.  
 

 

Figure 7.2-15 Place Section Callout Tool 

 
After selecting the Place Section Callout tool, the user is prompted with a dialog box to select the Drawing Seed 
and the section Height. When Section parameters are set, the user can click the first point where the section is to 
be cut, the second point to create the cutting plane, and lastly move the cursor in the direction in which the 
section is to be facing and click at the desired depth of the section.  
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Figure 7.2-16 Place Section Callout  

 

 

Figure 7.2-17 Section View 
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7.2.4 3D/Isometric Views 

The user can save a specific view of the 3D model from any perspective using the Rotate View tool, or the user 
can select one of the preset views available in the View Rotation tool in OpenBridge Modeler. For more 
information regarding view setup, refer to Chapter 4. 
 

 

Figure 7.2-18 Isometric View 

 
To create a view of the model that retains the settings and perspective in which it was created, the user will find 
the Create Saved View tool in the Saved Views pane in the View ribbon. 
 

 

Figure 7.2-19 Create Saved View Tool 

A Saved View is essentially a screenshot of a region in a model view and includes the level display for both the 
active model and references, the clip volume, and other view attributes like display styles. Saved Views can be 
created in 2D or 3D views and view settings can be modified after the saved view is created. A saved view can be 
created by the method of 2 Points (placing rectangle by clicking opposite corners) or by view (the extents of the 
view window). After selecting the method, view type, name and description, you can choose whether a drawing is 
to be created where it can be annotated, and if the limits of the saved view are associative. 
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Figure 7.2-20 Create Saved View Dialog 

7.3 EXPORTING TO LEAP STRUCTURAL ANALYSIS SOFTWARE 

The process for exporting to LBC and LBS Models generated in OBM can be transferred to LBC or LBS 
software’s for analysis. Navigate to Utilities > LEAP Bridge Concrete or LEAP Bridge Steel > Send To to send 
for analysis. Though this process is limited at this time, it is still the recommended workflow if LBC or LBS will be 
used for the superstructure analysis of the bridge.  
 

 

Figure 7.3-1 Send To LBC Tool (LBS Similar) 

7.3.1 Data Transfer 

After sending data from OBM to the LEAP software programs (LBC and LBS) for analysis, a data transfer 
message will be displayed informing the user of the successful transfer and outlining the limitations of the data 
transfer. The user can select the “Model Transfer Report” box to see the full report. Once OK is selected in this 
menu, the selected LEAP analysis software will be automatically opened, and another data transfer message will 
appear in LEAP. From this point the analysis procedure can continue entirely in LEAP. For help with the analysis 
procedure, refer to the PennDOT User’s Guide for LEAP Bridge Concrete and LEAP Bridge Steel. The user is 
responsible for checking all the transferred data for accuracy and each step of the analysis process will still need 
to be completed to verify the bridge geometry. 
 

 

Figure 7.3-2 Data Transfer Information in OBM  
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Figure 7.3-3 Data Transfer Message Window in LBC (LBS Similar) 

 
If using LBC, after transferring data from OBM a message may prompt the user to define a custom beam section 
and the user should select the appropriate beam type and section properties before proceeding. The 
recommended workflow in LBC at this point would be to select the equivalent beam section from the LBC 
standard beam library. This is done from Superstructure > Precast/Prestressed Girder and then once in that 
window, the user can update the Beam ID in the Geometry tab. If this step is not taken, the user will need to 
manually define available strand locations for analysis. 
 

 

 

Figure 7.3-4 Custom Beam Type 

 

Figure 7.3-5 Custom Beam Section Properties 
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Figure 7.3-6 Selecting an Equivalent Standard PA Beam Section  

 
Also, if a bridge is modeled with a beam notch detail (defining more than one template along the length of the 
member) or similar details, these details are not supported by the LEAP software. The user will be prompted to 
select one template to be defined along the entire length of the member. 
 

 

Figure 7.3-7 LBC Assumption and Limitation Message 

 
Much of the information generated in an OBM model can be transferred to LEAP. For example, OBM elements 
that can be transferred to LEAP are decks, beams, and girders with one defined template along the entire span 
length, abutments, diaphragms, and cross frames. 
 
Examples of items that cannot be transferred into LEAP include wingwalls, beams and girders with multiple 
defined templates along the length of the member, and barriers depending on the template.  
 
The user should carefully review the limitations in Section 2.5.2, as well as the entire structure after transferring to 
LEAP. It is common for items to be slightly different (stations slightly off, diaphragms not in the correct location, 
etc.) than what was generated in OBM. Some modifications to the structure after transfer to LEAP may be 
required. 
 
Likely not all the geometric features of the bridge will appear the same in LEAP as they were modeled in OBM. 
The user should ensure that an acceptable Level of Development is present in LEAP such that the correct 
engineering intent is being utilized for analysis, but it is not critical for the details of the visual model in OBM and 
LEAP to align perfectly. Common errors in the display of elements in LEAP include misplaced or missing barriers, 
removed skew from the ends of beams, and incorrect details.  
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Figure 7.3-8 Skewed Beam Ends in OBM 

 
 

 

Figure 7.3-9 Removed Skew from Beams Ends after Export to LBC 
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Figure 7.3-10 Pier Cap in OBM 

 

 

Figure 7.3-11 Pier Cap after Export to LBC 

 
The user should be aware that certain elements in OBM will create errors when attempting to transfer to LEAP. In 
the example below, the user created barrier templates that could not be transferred to the LEAP software. After 
the barriers were deleted, the structure was able to be transferred to LEAP software. Also, note that the barriers 
are transferred as rectangular and will not retain the F-shape solid. 
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Figure 7.3-12 Barriers Not Attached to the Deck or Missing after Export to LEAP 

 
Below is another example of an error encountered during the transfer from OBM to LEAP. The issue was isolated 
to the barriers and was reported as a bug fix request to Bentley. The current workaround offered by Bentley if this 
issue is encountered, is to delete the barriers and re-model them before transferring to LEAP. 
 

 

Figure 7.3-13 Error Message Attempting to Transfer Data to LEAP 

 
The user is responsible for reading and understanding LEAPs Assumption and Limitation Messages when 
attempting to transfer data.  

7.3.2 Best Practices for Timing of Transfer 

It is recommended that the user transfer data to LEAP when the model is in a lower Level of Development state, 
and all are still in Base element status and fully editable as OBM objects. The material type, beam spacing, and 
general beam sizing (estimate) should be set, but the less complexity or detail of the model, the higher the chance 
of the model transferring to LEAP without issue. If the model is transferred after Refined elements have been 
created, there may be issues with transferring older versions of those elements and should be avoided whenever 
possible. 
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In typical bridge replacement projects, the recommended time to transfer data from OBM to LBC or LBS is during 
the TS&L development. OBM can be used to develop several superstructure alternates to assist in preparing 
quantities and cost estimates, then either the preferred alternative or several alternate options can be transferred 
for analysis to prepare more refined cost estimates and other considerations for alternate selection. 

7.3.3 Bi-directional Data Transfer 

OBM currently has some limited functionality to import design modifications from LEAP to update the model in 
OBM. The update does not happen automatically and requires the user to go through a process to update the 
model. When updating the model, the user can select which changes made in LEAP to import back into OBM. 
This currently is not a recommended workflow as there are many limitations in the current process. Simple 
changes, such as a change in beam section may transfer properly, but more complicated changes such as 
additional beams or changes to cross sectional geometry will need to be updated manually in OBM, if necessary. 
Any minimal value gained from this process is outweighed by potential issues and lack of automation currently 
provided. If there are additional functionality and usability improvements in future releases, this option will be 
reevaluated for viability. However, the current recommendation is for a one-time transfer from OBM to LEAP to 
translate geometry and material properties for analysis, and the user is then to maintain the OBM model and 
LEAP analysis files separately. 
 

 

Figure 7.3-14 Update OBM File from LEAP 

 

 

Figure 7.3-15 Error Message When Attempting to Import LEAP Analysis to OBM 
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  EXAMPLE PROBLEMS 
 
[This section is under development. Content will be added after training course material is released and feedback 
from initial course offerings and Digital Delivery Directive 2025 Pilot Project feedback is incorporated.] 
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 TECHNICAL QUESTIONS AND 
REVISION REQUEST 

This chapter contains several forms to make it easier for users to convey their questions, problems or comments 

to the proper unit within the Department. General procedures for using this form are given. Users should keep the 

form in the manual as a master copy, which can be reproduced as needed.   

Technical questions related to the guidance provided in the manual or the PennDOT workspace elements Feature 

definitions, bridge element templates, etc.), why certain recommendations are made, applicability and limitations 

of this guidance document, and other questions not related to the operation of the Bentley software program can 

be directed to the appropriate person in PennDOT using the form or the information provided on the form.  

Suggestions might include typographical error correction, clarification of confusing sections, expansion of certain 

sections, changes in format, and the inclusion of additional information, diagrams, or examples. Please review the 

information provided in this User's Guide and the references given in Chapter 1 before submitting the Model-

centric User Guide Technical Questions / Revision Request form for processing or calling for assistance.  

Alternatively, any Bentley software suspected program malfunctions or bug fix requests, enhancement requests, 

or other questions regarding the internal functioning of the actual software programs should be logged in the 

Bentley Software Technical Questions / Revision Request form. Unexpected or incorrect output, rejection of input 

data, endless program cycling, and program abortion are examples of program malfunctions. Users are requested 

to review their input data and the User’s Guide before submitting the form for processing. 

The completed forms should be sent to the Engineering Software Section via fax or e-mail. 
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MODEL-CENTRIC USER GUIDE 

TECHNICAL QUESTION / REVISION REQUEST 
This form is to be used to request revisions to this user manual documentation. Users are requested to review 
their input data and the Bentley documentation before submitting this form. 

CONTACT PERSON: _______________________________________ DATE: ____________________ 
ORGANIZATION: ______________________________________ PHONE: ____________________ 
E-MAIL ADDRESS: ______________________________________ FAX: ____________________ 

   PROGRAM VERSION: _________ 

Define your problem and attach samples and/or documentation you feel would help correct the problem. If the 
input data is more than 4 or 5 lines, please provide the input data file as an e-mail attachment. If you require 
more space, use additional 8½ x 11 sheets of plain paper. 
 

FORWARD COMPLETED FORM TO: Pennsylvania Office of Administration 
      Infrastructure and Economic Development 
      Bureau of Solutions Management 
      Highway Applications Division 

E-MAIL:  PenndotBisEngineer@pa.gov 
PHONE: (717) 783-8822 FAX: (717) 705-5529 

FOR DEPARTMENT USE ONLY 
RECEIVED BY: ________________  ASSIGNED TO: ___________________ DATE:  __________ 
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 APPENDICES 

10.1 DECK TEMPLATE EXHIBITS 

Below are sketches of the variables included in the deck templates supplied in the PennDOT OBM workspace. 
These templates can be located under the …Organization-Civil / Bridge Design / OpenBridge Modeler / Bridge 
Templates folder. Also included is a description, default value and orientation of the variables. 
 

Note: All PennDOT deck templates can be modified for normal crown or superelevated cross sections by 
entering positive or negative slope values. 
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10.2 EXAMPLE TEMPLATE VALUES AND VARIABLE CONSTRAINTS  

10.2.1 Deck Templates 

10.2.1.1 2 Lane Template – Typical 
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10.2.1.2 2 Lane Template – No Shoulders 
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10.2.1.3 2 Lane Template – Offset Baseline 
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10.2.1.4 2 Lane_Sidewalk_R Template – Typical Sidewalk Detail 
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10.2.1.5 2 Lane_Sidewalk_L Template – Typical Sidewalk Detail 
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10.2.1.6 2 Lane_Sidewalk_R Template – Turn Lane as “Shoulder” and Typical Sidewalk Detail 
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10.2.1.7 4 Lane – Center Lane Split 
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10.2.1.8 4 Lane_Sidewalk_R – Alternate Sidewalk Detail and Center Lane Split 
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10.2.1.9 4 Lane_Sidewalk_Both – Alternate Sidewalk Details and Offset Baseline 
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10.2.2 Barrier/Sidewalk Templates 

10.2.2.1 PennDOT_Sidewalk R – Typical 
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10.2.2.2 F-Shape_45” PennDOT R – Barrier with Sidewalk 
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10.2.3 Wall Pier Template 

10.2.3.1 Cap Tab 

 
 

 
 

 
 
 

Note: A stepped pier cap or pedestals are modeled with bearing elements. See Section 5.21 Place 
Bearing for more information.  
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10.2.3.2 Columns Tab 
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10.2.3.3 Footings Tab 
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10.2.4 Multicolumn Pier Template 

10.2.4.1 Cap Tab 
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Note: A stepped pier cap or pedestals are modeled with bearing elements. See Section 5.21 Place 
Bearing for more information.  

10.2.4.2 Columns Tab 
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10.2.4.3 Footings Tab 
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10.2.4.4 Piles Tab 
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10.2.5 Hammerhead Pier Template 

10.2.5.1 Cap Tab 
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10.2.5.2 Columns Tab 
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10.2.5.3 Footings Tab 
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10.2.5.4 Piles Tab 
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Tips and Tricks: Correct number of rows and columns can be generated automatically then individual 
piles can be deleted to get the above pattern layout. 
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10.2.6 Integral Abutment and Wingwalls Templates 

10.2.6.1 Abutment – Cap Tab 
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Note: A stepped abutment cap or pedestals are modeled with bearing elements. See Section 5.21 Place 
Bearing for more information.  

10.2.6.1 Abutment – Piles Tab 
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10.2.6.1 Rectangular Wingwall – Cap Tab 
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10.2.6.2 Tapered Wingwall – Cap Tab 

 
 

 
 
 



Chapter 10 Appendices 
 

 10-32 

 
 

10.2.7 MSE Abutment Template 

10.2.7.1 Cap Tab 
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10.2.7.2 Cheek Walls Tab 
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10.2.7.3 Piles Tab 
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10.2.8 Cross Frame/Steel Diaphragms Templates 

10.2.8.1 PennDOT Type K Cross Frame 
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10.2.8.2 PennDOT Type X Cross Frame 

 

10.2.8.3 PennDOT Steel Diaphragm 
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10.2.9 Light Pole Blister Variable Constraints 

10.2.9.1 Deck Constraints 
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10.2.9.2 Barrier Constraints 
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10.2.9.3 Sidewalk Constraints 
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10.2.10 Haunch Steel Girder Variable Constraints 
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10.2.11 Flared Deck Variable Constraints 
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10.3 SOLIDS MODELING TOOLS AND TECHNIQUES 

The following sections guide several commonly used solids modeling tools that the user may find helpful. In 
addition, Section 10.4 lists the videos that are included to supplement this manual content. Solids modeling is 
primarily used in the workflow when the user is moving from a Base model element to a Refined model element 
condition and increasing the Element Detail and Information Designations. There are additional solids modeling 
tools available in OBM that are not covered in this section that the user may also find helpful. The notes on the 
tools provided below will cover a wide array of modeling strategies and uses. Each tool will include a list of 
Possible Areas of Use where the user may find the tools helpful. 
 
Before using these tools on a Base element, the user needs to understand that applying solids modeling tools on 
these elements will likely cause them to lose their recognition as OBM components (deck, beam, etc.). For 
example, using solids modeling tools to “square off” the ends of the deck will cause the OBM recognized element 
(user able to change templates, extend the deck, adjust variables, etc.) to a Smart Solid or Refined element. 
Once this occurs, the user cannot go back to a Base OBM component (other than using the Undo command). 
This process is described in further detail in Section 3.3 Base and Refined versions of model elements. 
 
To use the Solids Modeling tools, the user will need to switch to the Modeling workflow. Below is an image of the 
tools available in the Modeling > Solids tab of OBM. These tools are not a “one and done” methodology like the 
OBM workflow. Using these modeling tools will more than likely require a combination of tools to reach the 
desired outcome. 
 

Note: Certain solid modifications limit functional capabilities and variable functions. Therefore, any 
modifications made to the solid should reflect the Refined element model and not depend on the variables 
being retained. 

 

 

Figure 10.3-1 Modeling Workflow – Solids Tab 

 
Basic understanding of what a solid is and defining the difference between a Primitive Solid and a Smart Solid: 
 

• Primitive Solid – Basic 3D solid shape with no smart characteristics/features applied to the solid. 

• Smart Solid – Primitive solid with smart characteristics/features applied to the solid. Features such as 
chamfers, fillets, tapered faces, etc. are discussed below. Features added to solids can be modified, 
disabled or deleted entirely after being applied to a solid. To modify the feature, simply select the solid, 
left click the feature you wish to modify in the properties palette (hover over the feature in the model to 
view the specific feature name), and change the settings in the properties palette. If you wish to disable or 
delete the feature, select the solid, right click the feature you wish to modify in the properties palette, and 
choose the option you wish to accomplish. 
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10.3.1 Primitive Solids 

Primitive Solids modeling tools can be used to define basic solids shapes that can be used as a building block 
for Smart Solids. All primitive solids are defined using basic input parameters. After a Primitive Solid has been 
created, it can be edited using the Feature tools (Modeling > Solids > Features or Modify Features). 
 

 

Figure 10.3-2 Primitive Solids Modeling Tools 
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Figure 10.3-3 Primitive Solids – Slab Solid 

 

 

Figure 10.3-4  Primitive Solids – Slab Solid 

 

10.3.2 Extract Faces/Edges 

Possible Areas of Use: 

• Anywhere on the structure 
 

 

Figure 10.3-5  Extract Faces/Edges in Ribbon 
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Figure 10.3-6  Close-up of Extract Faces/Edges Tool Icon 

 
The Extract Faces/Edges tool can be used to create a copy of a face or edge of an existing element. The tool is 
useful in reproducing a part of an existing member. The Extract Faces/Edges tool is used as a building block in 
using Solids Modeling techniques and is often the first step in using many of the other tools listed in this 
Appendix. 
 
Using a barrier element as an example, below are a few images of how the user can extract faces and edges of 
OBM created solids. 
 

 

Figure 10.3-7 Extracting Barrier Face 
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Figure 10.3-8 Extracting Barrier Face 

 
The “Extract Faces/Edges Tool” video provides more details and instructions on successfully using this tool. 

10.3.3 Extrude  

Possible Areas of Uses: 

• Barriers 

• Diaphragms 

• Safety Wings 

• Bearing Seats 
 

 

Figure 10.3-9  Extrude 

 
The Extrude tool is used to take an existing closed shape and extend it normal to the face of the shape. The user 
can define a specific distance or snap and click to a defined location. The AccuDraw tool is available to the user 
when using this tool. In the example below, the barrier face was extracted using the Extract Faces tool, then the 
barrier shape is Extruded normal to the face of the barrier.  
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Figure 10.3-10 Extruding Barrier 

10.3.4 Extrude Along  

Possible Areas of Uses: 

• Barriers 

• Diaphragms 

• Wingwalls 
 

 

Figure 10.3-11 Extrude Along 

 
Unlike Extrude, the Extrude Along tool extends a closed shape along a user-defined path. This tool requires a 
closed 2D shape and a path element (line) for the shape to be extruded along. The path element does not need to 
be in contact with the profile element. For example, you can select the wingwall profile shape its true location 
(offset from the BL 20’, 30’ etc.) and use the baseline as the path. This is important because the offset in a 
horizontal curve adjusts the radius of the profile being extruded. The default setting (not selecting Start and End 
Distances) extrudes the profile element from the current position to the end of the path element, depending on 
which direction the extrude along arrow is pointing on the path element. Setting the Start and End distances 
constrains the extrusion to a certain distance. 
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Figure 10.3-12 Extrude Along – Required Elements 

 

 

Figure 10.3-13 Barrier Extruded Along Path 

 

Path Element 

Closed 2D Shape 
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Figure 10.3-14 Finished Barrier Extrusion 

10.3.5 Modify Solid 

Possible Areas of Uses: 

• Anywhere on the structure 
 

 

Figure 10.3-15 Modify Solid 

The Modify Solid tool has three options for the user to select from: Modify Face, Modify Edge, or Modify 
Vertex. This versatile tool is useful to make quick and detailed modifications to a solid by displacing the selected 
face, edge, or vertex at a specified distance or to a snap point. 

10.3.6 Taper Face 

Possible Areas of Uses: 

• Abutment Stem Rear Face 

• Wingwall Stem Rear Face 
 

 

Figure 10.3-16 Taper Face 
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The Taper Face tool gives the user an ability to add a taper to the face of a solid element. This tool is helpful to 
add a batter to the rear face of abutment or wingwall stems. 
 

 

Figure 10.3-17 Abutment Before Taper 
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Figure 10.3-18  Abutment with Taper  

10.3.7 Difference/Subtract (Boolean Feature) 

Possible Areas of Uses: 

• Deck  

• Diaphragms 

• Barrier Modified Deflection Joint 
 

 

Figure 10.3-19 Subtract 

 

 

Figure 10.3-20 Difference Feature 

 
The Difference Feature and Subtract tools have different names but perform the same function in OBM. These 
tools subtract the overlapping regions of two elements. To use this tool, create a solid element that will function as 
the sacrificial subtraction solid. The sacrificial solid will then be moved into place and subtracted from the 
structural element that is to remain. 
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Figure 10.3-21  Barrier Before Subtracting Deflection Joint 

 

 

Figure 10.3-22  Barrier After Subtracting Deflection Joint 

Barrier Element 

Subtraction Element for 
Cutting Deflection Joint 



Chapter 10 Appendices 
 

 10-58 

10.3.8 Union/Unite (Boolean Feature) 

Possible Areas of Uses: 

• Deck  

• Diaphragms 

• Integral abutments 
 

 

Figure 10.3-23 Unite 

 

 

Figure 10.3-24 Union Feature 

 
The Union Feature and Unite tools have different names but perform the same function in OBM. These tools 
combine the overlapping regions of two elements or elements that border one another. After the combination, the 
elements are viewed as a single object. It is important to note the order in which these separate components are 
selected because the second component will take on the level/material properties of the first component selected. 
 

 

Figure 10.3-25 Barrier Elements Before Union 

 

Deck Barrier 

Barrier Transition 
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Figure 10.3-26 Combined Barrier and Barrier Transition 

10.3.9 Imprint 

Possible Areas of Uses: 

• Anywhere on the structure 
 
One of the difficulties in 3D modeling is verifying you are drawing in the correct plane. The Imprint tool allows the 
user to draw directly on the face of a 3D object and adjusts the AccuDraw to the face for the extent of the 
drawing on the face. This tool has different options (line/line string, circle, rectangle, and offset) to draw on the 
face of a 3D object. 
 
After using the Imprint, additional tools can be used in combination (Imprint > Extract Faces/Edges > Extrude) 
to model the desired elements. 
 

 

Figure 10.3-27 Imprint 
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Figure 10.3-28 Imprinting Drawing Element on Abutment Backwall 

 
Using a combination of additional modeling tools, (Imprint > Extract Faces > Cut or Imprint > Extract Faces > 
Extract Edges > Extrude Along > Subtract) the user can create an opening for the abutment backwall for 
utilities as shown below. 
 

 

Figure 10.3-29 Utilities Passing Through Backwall 

10.3.10 Delete Piece/Face 

The Delete Piece/Face tool can be used to delete an Imprinted face on an element. The regular Delete tool 
cannot be used since it would delete the entire element. This is because the imprint that is created by the user is 
viewed as part of the element it is imprinted on.  
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Figure 10.3-30 Delete Piece/Face 

 

 

Figure 10.3-31 Deleting Imprinted Face 

10.3.11 Cut 

Possible Areas of Uses: 

• Coping steel beams/girders 

• Barrier deflection joints 

• Adding weepholes or utility cavities in substructure units 

• Splitting deck or substructure for phase construction 
 

 

Figure 10.3-32 Cut Feature 

 
The Cut Feature tool gives the user the ability to remove or split a portion of a solid using an established profile. 
The cut is created normal to the profile, so the profile needs to be oriented correctly before using the tool. The 
user can choose to use the inside/outside profile to remove the portion of the solid or split the solid so the 
“removal” portion of the solid is left in position and can be modified separately. The user may also choose the 
depth of the cut, with the length of the cut beginning at the start of the profile, or simply set the cut depth to 
“Through” to cut completely through the solid without needing to define a depth. 
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Figure 10.3-33 Weephole being cut into substructure unit  

Since a weephole needs to cut through a substructure unit, but is also fitted with a PVC sleeve, the user chose 
Split Solid as the Cut Method to retain the portion of the wall within the weephole as this remaining cylinder will 
be used to create the PVC sleeve. 
 
 

 

Figure 10.3-34 Transforming remaining cylinder into hollow sleeve 

 
A second cut by the user using the Inside Profile as the Cut Method, will create a hollow sleeve. This will remove 
the profile representing the inner portion of the cylinder, thus creating a hollow sleeve for water to drain. 
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Figure 10.3-35 Weep hole with PVC sleeve 

10.3.12 Chamfer/Fillet 

Possible Areas of Uses: 

• Concrete or Steel Edges 

• Barrier Deflection Joints 
 

 

Figure 10.3-36 Chamfer and Fillet 

 

 

Figure 10.3-37 Chamfer edge of solid 

 
The Chamfer tool gives the user the ability to place a chamfer on the corners of solids. While chamfers are 
typically a 45-degree angle where both legs are the same length, there is an option to specify the lengths of 
individual legs if the situation requires it. Using the tool is as easy as setting the chamfer values and selecting the 
edge you want to chamfer. 
 



Chapter 10 Appendices 
 

 10-64 

 

Figure 10.3-38 Using the fillet tool to round the corners of steel shapes 

The Fillet tool is used to add a fillet or a rounded corner to the edge of a solid. Like the Chamfer tool, the fillet tool 
is as simple to use as setting the radius of the fillet and selecting the edge you want to apply it to. 

10.3.13 Trim Solid 

 

Figure 10.3-39 Trim Solid  

 
The Trim Solid tool uses another solid to remove the overlapping volume from the original solid while maintaining 
the full volume of the solid used to do the trimming. This is a useful tool in situations where an element is 
conforming around the limits of another element, as both cannot physically occupy the same volume. 
 

 

Figure 10.3-40 Abutment Backwall and Approach Slab Occupying the Same Volume 

 
In the example below, an approach slab is being modeled and is to be supported by a paving notch on the rear 
face of the abutment backwall. While the approach slab needs to be retained in its entirety, the backwall must be 
trimmed to accommodate the approach slab. 
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Figure 10.3-41 Selecting the Abutment and the Approach Slab 

 
After selecting the trim tool, the user can set what happens to the solids after the trimming function occurs. In this 
case, we want the original untrimmed version of the abutment to be hidden, so we select Hide for the Original 
Target, and we want the approach slab to remain, so we select Copy and Hide for the Original Tool. First select 
the Target, or the abutment to be trimmed then select the trimming element, or the approach slab, and finally data 
point to confirm. 
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10.4 LIST OF SUPPLEMENTAL VIDEO TUTORIALS 

Below are the videos available as supplemental material to this guidance manual. They are organized into series 

based on specific workflow topics or common tasks. 

File name Description 
Duration 

(mm:ss) 

Deck Variable Constraints.mp4 

Demonstrating the use of the Variable Constraint 

functionality with a deck template and how both constant 

and varying or tapered situations can be accommodated 

02:15 

Solids Modeling Videos: Squaring of Deck Ends Series 

01_Imprint – Squaring Off Deck 

Ends.mp4 

Using the Imprint tool to “draw” on the deck elements for 

modifications 
01:33 

02_Extract Face – Squaring Off 

Deck Ends.mp4 

Using the Extract Face tool to generate linework for the 

deck elements for modifications 
01:05 

03_Extrude – Squaring Off Deck 

Ends.mp4 

Utilizing the Extrude tool to generate solids to modify the 

deck elements 
01:13 

04_Modify Solid – Squaring Off 

Deck Ends.mp4 

Using the Modify Solids tool for multiple updates to the 

deck elements 
02:20 

05_Subtract – Squaring Off Deck 

Ends.mp4 

Utilizing the Subtract tool to cut away elements to modify 

the deck 
00:48 

06_Taper Face – Squaring Off 

Deck Ends.mp4 

Using the Taper Face to modify and finalize the deck 

ends 
01:50 

07_Modify Solid – Squaring Off 

Deck Ends.mp4 

Using the Modify Solids tool for additional deck element 

modifications 
02:03 

Solids Modeling Videos: Beam Notch Series 

01_Imprint – Beam Notch.mp4 
Using the Imprint tool to “draw” on the beam elements for 

modifications 
01:30 

02_Extract Edge – Beam 

Notch.mp4 

Using the Extract Edge tool to generate linework for the 

beam modifications 
00:42 

03_Extract Face – Beam 

Notch.mp4 

Using the Extract Face tool to generate linework for the 

beam modifications 
00:56 

04_Extrude Along – Beam 

Notch.mp4 

Utilizing the Extrude tool to generate solids to modify the 

beam elements 
00:35 

05_Subtract – Beam Notch.mp4 
Using the Subtract tool to cut away elements to modify 

the beam for the notch 
00:45 

06_Chamfer – Beam Notch.mp4 Utilizing the Chamfer tool to modify the beam edges 00:41 

 
Note: Updated OBM versions (starting with 2022 R1) include tools that provide the user the option to 
square off deck ends. The videos listed above were generated prior to the implementation of that feature. 

They have been left in this Users Guide as simply another example of 3D modeling techniques, and what can be 
achieved through their use. 
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10.5 OPTIONS FOR CONSTRUCTION PHASING IN MODELS 

[This section is under development. Content will be added after Digital Delivery Directive 2025 Pilot Project 
feedback is incorporated.] 
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